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System Maintenance

This guide tells administrators how to manage hosts and services in the network, maintain and monitor
the network, run jobs, and tune performance after initial network setup.

The following diagram shows the different system maintenance tasks available to you.

Monitor . Maintain .
Manage NW Review queries used Configure Change Host EENT

Troubleshoot

Review best health of NW Platform SsT 2 NW Platform

practices Platform host ) for FIPS Support |IP Addresses
updates service logs . .
system investigation

DISA STIG
Hardening

system issues

The following topics describe these tasks:

« Review Best Practices

o Monitor Health and Wellness using NetWitness Platform Ul

o Manage NetWitness Platform Updates

o Display System and Service Logs

o Maintain Queries Using URL Integration

o Configure FIPS Support

o Change Host Network Configuration

¢ Reissue Certificates
« DISA STIG
o Troubleshoot NetWitness Platform
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Review Best Practices

Review the following best practices to maintain your NetWitness Platform deployment.

Safeguarding Assets with RSA Supplied Policies

The purpose of the RSA core policies delivered with NetWitness Platform are for safeguarding your
NetWitness Platform domain assets immediately (before you configure rules specific to your
environment and your security policy).

RSA recommends that you set up email notifications to the appropriate asset owners for these policies
as soon as possible. This will notify them when performance and capacity thresholds are crossed so they
can take action immediately.

RSA also recommends that you evaluate the core policies and disable a policy or change its service and
group assignments according to your specific monitoring requirements.

Safeguarding Assets with Policies Based on Your

Environment
RSA core policies are generic and may not provide sufficient monitoring coverage for your environment.

RSA recommends that you gather issues over a period of time, that are not identified by the RSA core
policies, and configure rules to help you prevent these issues.

Creating Rules and Notifications Judiciously
RSA recommends that you make sure that each rule and policy is necessary before you implement it, if

possible. RSA also recommends that you review implemented policies on a regular basis for their
validity. Invalid alarms and email notifications can adversely affect the focus of the asset owners.

Troubleshooting Issues

RSA recommends that you review Troubleshooting Health & Wellness and Troubleshoot NetWitness
Platform when you receive error messages in the user interface and log files from hosts and services.
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Monitor NetWitness Platform Health

You can monitor the Health & Wellness of the NetWitness Platform using any of the following:
o Monitor Health and Wellness using NetWitness Platform Ul
o Monitor New Health and Wellness

15 Monitor NetWitness Platform Health



Monitor Health and Wellness using NetWitness Platform Ul

The Health & Wellness module of NetWitness Platform enables you to:

« View the current health of all the hosts, all services running on the hosts, and various aspects of the
health of your hosts.

« Monitor the hosts and services in your network environment.
o View details of various event sources configured with NetWitness Platform.

« View system stats for the selected hosts by filtering the views as required.

You can also configure Archiver and Warehouse Connector monitoring, monitor host statistics, and work
with system logs to monitor NetWitness Platform.

Note: All users have permission to view the entire Health and Wellness interface by default. The
Administrator and the Operator roles are the only roles that can manage the Policies view by default.
Refer to the "Role Permissions" topic in the Security User Management Guide for a complete list of
the default permissions for the NetWitness Platform Interface.

The following figure displays the Health & Wellness module of the NetWitness Platform user interface.

Hosts Files D d e 3 admin w
Event Sources Endpoint Sources  Health & Wellness e Security
Alarms Monitoring Policies System Stats Browser  Event Source Monitoring Settings
Ol m Severity | RuleName Service Hostname 1P Address Stat E
O @ Critical and Server in Critical Stace rver 11154 10.25.66.54 Processinfo/Overall Pro. dice= | 3
] @ Critical der Log Capture Pool 113EP1 10.25.66.46 Poal/Packet E
O 20180201 01:34 Active @ Critical  Log Decoder Caprure Rate Zero Log Decoder 113EP1 10.25.66.45 Capture/Capture Packet Rate (current) %
[ 2018-02-01 01:34 Active @ Criical  Log Decoder Caprure Not Started Log Decoder 113ER1 10.25.66.46 Capture/Capture Ststus
] Active @ Criical  Concentrator Meta Rate Zero Concentrater 113EP1 10.25.66. Concentraro = (current)
O Active @ Criical  Concentrator Aggregation Stopped Concentrator 113ER1 10.25.66. Cancentrat
] Active @ Criical  Concentrator Aggregation Concentrater 111Cenc 10.25.66.34 Concentraro
] Active @ Criical  Decoder Caprure R o Decoder 111Decoder 10.25.66.32 & Packet Rate (current)
] Active @ Critical  Decoder Caprure Not Started Decoder 111Decoder 10.25.66.32
] Active @ Critical Decoder 111Decoder 10.25.66.32 Poal/Packet Capture Queue \
m} Aetive @ Critical Broker 11154 10.25,66.54 Broker/Status
] Active @ Critical  Concentrator Meta Rate Zero Concentrator 111CoreHybr 10.25.66.44 Concentrator/Meta Rate (current)
m} Aetive @ Criticsl  Concentrator Aggregation Stoppad Concentrator 111CoreHybr 10.25.66.44 Concentraro
] Active @ Criical  Concentrator Meta Rate Zera Concentrater 1€ 10.25.66.34 Cancentrato Rate (current)
] Active @ Critical  Log Decoder Capture Rate Zero 111CoreHybr 10.25.66.44
] Active @ Criical  Le der Caprure Not Started 10.25.66.44
] Active @ Critical  Log Decoder Log Capture Poo 10.25.66.44 Pool/Packet
] Active @ Hig Communication Failure Between Master NetWitn... 10.25.66.54 MessageBus/Communication Link Status wit
< T »
| Page 1 of2 | 3 M| C  #AutoRefresh tems 1-50 of 55
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Manage Policies

Policies are either user-defined or supplied by RSA. A policy defines:
« Services and hosts to which the policy applies.

« Rules that specify statistical thresholds that govern alarms.

« When to suppress the policy.

« Who to notify when an alarm triggers and when to notify them.

For related reference topics, see NetWitness Platform Out-of-the-Box Policies

expiration status.

Note: You can now configure a policy to notify Public Key Infrastructure (PKI) certificate

Add a Policy

Q
1. Goto (Admin) > Health & Wellness.
2. Click the Policies tab.

The Policies view is displayed.
RS/  investigate  Respond  Users  Hosts  Files  Das

Hosts Services Event Sources Endpoint Sources Healtl Vellness  System  Security

Marms  Monitoring IS System Stats Browser  Event Source Monitoring  Settings

» [ Entiry Beha:

Adm inUnh..  High Processinfo
» [ Event Scream Analysis Stopped  Critical Processinfo
» [JHost
Policy Suppression
» [ Integration server ¥ supp

Define the time periods o suppress policies.
¥ CJInvestigate Server

» Do

Days
» [ Log Decoder

[RS/\ NETWITNESS' PLATFORM

3. Click T in the Policies panel.

admin v

Save

Last Modified: 2017-02-20 12:00:00 AM

Policies Admin Server: Admin Server Monitoring Policy
+ Z1® 3 Rules and suppression schedules of Out-of-the-box policies cannot be directly modified. Duplicate the policy if you wish to so modify them
4 £ Admin Server
Admin Server Monitoring Policy Services
¥ [ Archiver Choose the hosts, services, and groups that your health policy appiies to.
» [ Broker +
e ety e
» [ Concentrer All i) Groy;
» [ Config Server
£ Rules
¥ (] Content Server Define the cenditions under which you want to trigger an alarm for the NetWitness Platform health preblems (definition includes severity, Statistic the alarm applies to, threshold, and threshold
‘After you define the alarm rule, enable or disable the alarm.
» [ Contexthub Server
Ensble Name ~ Severity category Statistic Threshold
Adm! rver in Criti. Critical Processinfo Alarm = ERROR for 2 N TES

Alarm = PARTIALLY_WORKING for 2 MINUTES

Alarm I= started for 0 MINUTES

Time Range

% winich tne alarm clears).

11,500

Monitor NetWitness Platform Health
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4.

A list of your hosts and services displays for which you can create health policies.

Select a host or service (for example, Concentrator).
For a PKI policy, you must select a host (for example, Host).
The host or service is displayed in the Policies panel with a blank Policy Detail panel.

Polic

+o -3 | B X
b A

¥ [ Broker

4 & Concentrat

Polic

+o -2 B X
b A

¥ (] Broker

4 & Concentrat

The name (for example, Concentrator Policy Status) is now displayed as the policy name in
Policy Detail panel.

Create a Policy in the Policy Detail panel:
a. Select the Enable checkbox.

b. Add relevant services (in this example, any relevant Concentrator services) that you want to
monitor for health statistics.
For a PKI policy, you must select the LOCALHOST to monitor for health statistics.

c. Add rule conditions to configure the policy.
d. Suppress enforcement of the policy for the time periods you want.

e. Add any email notifications you want for the policy.
f. Click Save in the Policy Detail panel.
The Policy is added.
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Add Policy Example

Below is a high-level example of configuring a PKI policy:
1. Add a new PKI policy.

RSA v te  Respond  Users Hosts Files  Dashboard  Reports admin v

Hosts  Services EventSources Endpoint Sources Health & Wellness ystem  Security

Alarms  Monitoring [JEEGIISEONE  System Stats Browser  Event Source Monitoring  Settings

Policies Host: SA PKI

» [ Warehouse Cannector

Click on + to add sup nto policy

» O3 Workbench

+to-EFIBXR M Enable Last Modified: 2016-05-04 03:51:14 PM
» [ Archiver © | | Hoste
» [ Broker © | Choose the hosts, services, and groups that your health policy applies to
» [ Cancentrator o +-
» [ Context Hub ©® O name~ Group Type
» (D Decoder () O LOcALHOST Host
» [ Event Str E{D An: o
4G Host 2]
arm for the Net stform health problems (definition includes severity, statistic the alarm applies to, threshold. and threshold at which the alarm clears). After you define
E jcy
SAPKI
» [71PD8 Extractor © & Enavie| Name Severity Category Statistic Threshold
» [T Incident Manageman: 0 ¥ Alert When a CRL Expi... Critical PKI SA Server PKI CRL Expiration Alarm <= 0 for 0 MINUTES
» [ Log Collector ()
Policy Suppression
» [ Log Decoder () v Supp
Define the time periods to suppress policies.
° + TimeZone: | UTC(GMT+00:00) v
o
O oays Time Range
o
o

Notification

2. Add a Rule with Statistics:
« For CA Expiration

Enable ™

Name Trusted CA Certificate Expiry Time

High v
PKI ~ | | SA Server PKI Certificate Expiration ~ | TRUSTED_CA ~
== w2400 For |0 £ Minutes
> ~ | | 2400 For Minutes
+ Time Zone: UTC {GMT+00:00)

O

Click on + to add suppression to rule

Cancel Save

o For CRL Expiration
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Add Rule

4
CRL Expiration Based On Time

Description

Severity High v

PKI ~ | | 5A Server PKI CRL Expiration v
<= w2400 For |0 £ Minutes
= w0 For |1 < Minutes L\\:

Time Zone: UTC {GMT+00:00)

Time Range

Click on + to add suppression to rule

Cancel Save

o For CRL Status

Add Rule

™~
CRL Status
Description
Severity High v
PKI ~ | | 5A Server PKI CRL Status b
= ~  Walid For |0 £ Minutes
= ~  Walid For |1 & Minutes

Time Zone: UTC {GMT+00:00)

Click on + to add suppression to rule

Cancel Save

o For Server Certificate Expiration
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Add Rule

~

|Sewer|Cer‘ti"cate Expiry Time |

Description

Severity High e
PKI ~ | SA Server PKI Certificate Expiration ~ | SERVER_CERT ~
<= w2400 For [0 £ Minutes
= w2400 For |1 < Minutes

Time Zone: UTC (GMT+00:00)

Click on + to add suppression to rule

Cancel Save

Edit a Policy

1. Goto (Admin) > Health & Wellness.
2. Click the Policies tab.
The Policies view is displayed.
3. Select a policy (for example, Concentrator Policy Status) under a host or service.

The Policy Detail is displayed.

4. Click Iil‘

The policy name (for example, Admin Server Monitoring Policy) and policy detail
panel become editable.
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RSA

Hosts S vent Sources  Endpoint Sources fe Security

admin v

Marms  Monitoring [CIUEECNN System Stats Browser  Event Source Monitoring  Settings

Policies Admin Server: Admin Server Monitoring Policy Save
+ Z18 3 Rules and suppression schedules of Qut-of-the-box pelicies cannot be directly medified. Duplicate the policy if you wish te so madify them
[ Enable Last Modified: 2017-02-20 12:00:00 AM
4 55 Agmin Server -
Admin Server Monitoring Policy Services
» [ Archiver (Choose the hosts, services, and groups that your health policy applies to.
¥ [ Broker +
* [] Cloud Gateway Server Name ~ Group Type
All 10 Group
Rules

Define the conditions und
After you define the ala

n slarm for the NetWitness Plstform heslth problems (definition includes severity, statistic the alsrm applies to, threshold, and threshold st which the slsrm clears]
slarm

» [ Contextnu Server
» [ Decoder

Enable  Name ~ seventy category statistic Threshold
» ] ESA Correlation

rverinCriti.  Critical Alarm = ERROR for

» CJ Entity Beha

inUnh..  High Alarm = PARTIALL ING far 2 MINUTES

Stopped  Critical Alarm 1= started for 0 MINUTES -
Policy Suppression
Define the time periods to suppress
» [ Log Collector
» [ Log Decoder ooy Time Range
- Policy suppression is no ] ..
[RS/\ NETWITNESS PLATFORM 11.5.0.0

5. Make the required changes and click Save in the Policy Detail panel. You can:
« Edit the policy name.
o Enable or disable the policy.
o Add or delete hosts and services in the policy.
o Add, delete or modify rules in the policy.
o Add, edit, or delete suppressions in the policy.

e Add, edit, or delete notifications in the policy.

Note: Save applies the policy rules based on the selection of enable or disable. It also resets the
rule condition timers for changed rules, and the entire policy.

Duplicate a Policy

Q
1. Goto (Admin) > Health & Wellness.
2. Click the Policies tab.

3. Select a policy (for example, Concentrator Monitoring Policy) under a host or service.

4. Click B .NetWitness Platform copies the policy and lists it with (1) appended to the original
policy name.
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RSA

Hosts S vent Sources  Endpoint Sources

admin

Security

Aarms  Monitoring [EIIIEES

System Stats Browser  Event Source Monitoring  Settings

Policies Concentrator: Concentrator Monitoring Policy(1) save
+o-F B3 [SlEnanie Last Modified: 2019-03-06 10:24:10 PM
» [] Admin Server
B Services
¥ [ Archiver Choose the hasts, services, and groups that your health policy appiies to.
» [ Broker +
> [ Cloud Gatewsy Server =t £y Tyee.
45 0o or Clic!
Rules
e Define the conditions unds ger 20 slarm for the NetWitness Flatiorm hesfth problems {defintion includes severity statstic the slarm spplies t, threshold, and threshold st which the slarm clears)

» D Confiz Server After you define the slarm r slarm.
» [ Conten Server +
» [ Contartnub Server Enble  Name ~ Severlty category Statistic Threshold
» [ Becoser Medium Concentrator Queries Pending Alarm >

Medium Devices Sessior Alarm >:
» [ EsA Correlation

High Devices Sessians Behind Alarmm
¥ [ Entity Beha:

Critical Devices Alarm >:
» [ Evene seream Analysis Critical Conces tor Alarm 1=

Critical Alarm =

High Concentrator Alarm >

. Critical ‘Concentrator Alarm =
High Devices st Alarm l= S
- ncentrator Service . Critical Processinfe Service Stan Alarm |= 'starced’ ready for O M 3 -
R'S/\ NETWITNESS PLATFORM 11.5.00

5. Click Iilﬁ and rename the Policy [for example, rename Concentrator Monitoring Policy(1)] to
New Concentrator Policy.

Note: A duplicated policy is disabled by default and the host and service assignments are
not duplicated. Assign any relevant hosts and services to the duplicated policy before you
use it to monitor health and wellness of the NetWitness Platform infrastructure.

Assign Services or Groups

To assign hosts or services to a policy:

1. Goto (Admin) > Health & Wellness.
2. Click the Policies tab.
The Policies view is displayed.
3. Select a policy (for example, First Policy) under a host or service.

The Policy Detail view is displayed.

4. Click + in the Services and Groups list toolbar.
5. Choose one of the following actions:
o For hosts, select Groups or Hosts from the selection menu.
« For services, select Groups or Services from the selection menu.

6. Depending on whether you are assigning services or groups, perform one of the following
actions:
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o Groups, the Groups dialog is displayed from which you can select predefined groups of hosts
or services.

Add Groups
Groups Services
Name
L = Mame

Concentrator

Filter X

Host Type

NWAPPLIAMNCEZZ2655 Concentrator

-

Cancel Select

o Services, the Services dialog is displayed from which you can select individual services.

Add Service
Groups Services
MNarme
E? MNarme

[l Concentrater

Filter X

Host Type

MNWAPPLIANCEZ2655 Caoncentrator

-

Cancel Select

24
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7.

Select the checkbox next to the groups or services you want to assign to the policy, click Select
in the dialog, and click Save in the Policy Detail panel.

Note: Services are filtered for selection based on the type of policies. For example, you can only
select Concentrator services for a Concentrator type of policy.

Remove Services or Groups

To remove a host or service from a policy:

1.
2.

Go to (Admin) > Health & Wellness.
Click the Policies tab.

The Policies view is displayed.

Select a policy under a service.

The Policy Detail view is displayed.

Select a host or service.

Click ~— .

The host or service is removed from the policy.

Add or Edit a Rule

To add a rule to a policy:

1.
2.

Go to (Admin) > Health & Wellness.

Click the Policies tab.

The Policies view is displayed.

Select a policy (for example, Checkpoint) under a host or service.
The Policy Detail view is displayed.

Depending on whether you are adding or editing rule, do the following:

o To add a rule, click + in the Rules list toolbar.

—

o To edit a rule, select a rule from the Rules list and click .

Complete the dialog to define or update the rule.

Add a description as shown in the following example.
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Add Rule

Enable “ R
Name Check Point
Description Trigger alarm when Check Point Log Collection stops

Medium v

Checkpoint Collection ~ | | Collection State v

= v | stopped For |1 $| Minutes
= v started For |1 < Minutes

Time Zone: UTC {GMT+00:00)

M Days Time Range
™ sun Maon Tue Wed Thur Fri Sat 00:00 To 00:15
7. Click OK.

The rule is added (or updated) to the policy.

Hide or Show Rule Conditions Columns

To hide or show rule conditions columns in the Rules panel:

1. Goto (Admin) > Health & Wellness.
2. Click Policies tab.
The Policies view is displayed.
3. Select a policy under a service.
The Policy Detail view is displayed.
4. Go to the Rules panel.
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Rules

Define the conditions under which you want to trigger an alarm for the NetWitness Platform health problems (definition includes
severity, statistic the alarm applies to, threshold, and threshold at which the alarm clears). After you define the alarm rule, enable or
disable the alarm.

[l Enable  Name ~ Severity Category Statistic Threshold

O Concentrator...  Medium Concentrator Queries Pending Alarm >=5 for 10 MINUTES

O Concentrator.,  Medium Devices Sessions Behind Alarm == 100000 for 30 MINUTES
O Concentrator...  High Deavices Sessions Behind Alarm == 1000000 for 30 MINUTES
O Concentrator...  Critica Devices Sessions Behind Alarm == 50000000 for 30 MINUTES
O Cancentrator... Critica Status Alarm = "started' for 0 MINUTES

O Concentrator...  Critica Status '="opened' for 0 MINUTES

O Concentrator..  High Concentrator Rule Error Count Alarm =0 for 0 MINUTES

(| Conc Caisi Conc Bdceo D - - Al =N foe T RAIBIITCC

5. Click v to the right of Category , set Columns, and clear the Static and Threshold rule
conditions.

You can set or clear any Rules column to show or hide it.
The Rules panel displays without the rule conditions.

Delete a Rule

To remove a host or service from a policy:

Q
1. Goto (Admin) > Health & Wellness.

2. Click the Policies tab.
The Policies view is displayed.

3. Select a policy under a service.
The Policy Detail view is displayed.

4. Select a rule from the Rules list (for example, Checkpoint).

5. Click -.
The rule is removed from the policy.

Suppress a Rule
1. Click the Policies tab.
The Policies view is displayed.

2. Select a policy under a service.
The Policy Detail view is displayed. You can specify rule suppressions time ranges when you
initially add it or you can edit the rule and specify suppression time ranges.

3. Add or edit a rule.
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4. In the Rules Suppression panel of the Add or Edit Rule dialog, specify the days and time
ranges during which you want the rule suppressed.

Suppress a Policy

1. Add or edit a policy.
The Policies view is displayed.

2. In the Policy Suppression panel:
a. Select a time zone from the Time Zone drop-down list.
This time zone applies to the entire policy (both policy suppression and rule suppression).

b. Click + in the toolbar.

c. Specify the days and time ranges during which you want the policy suppressed.

Add an Email Notification

To add an email notification to a policy:

1. Add or edit a policy.
The Policies view is displayed.

2. In the Notification panel:

a. Click + in the toolbar.
A blank EMAIL notification row is displayed.

b. Select the email:

« Notification types in the Recipient column (see "Configure Notification Outputs" in the
NetWitness Platform System Configuration Guide for the source of the values in this drop-
down list).

« Notification server in the Notification Server column (see 'Configure Notification
Servers" in the NetWitness Platform System Configuration Guide for the source of the
values in this drop-down list).

« Template server in the Template column (see "Configure Notification Templates" in
the NetWitness Platform System Configuration Guidefor the source of the values in this
drop-down list).

Note: Refer to Include the Default Email Subject Line if you want to include the
default Email subject line from the Health & Wellness template in your Health &
Wellness Email notifications for specified recipients.

Delete an Email Notification

To add an email notification to a policy:
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Add or edit a policy.
The Policies view is displayed.

In the Notification panel:
a. Select an email notification.

b. Click =.
The notification is removed.
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Include the Default Email Subject Line

The emails generated by the notifications you set up for policies do not include the subject line from
the Health & Wellness Default Email Notification templates. You need to specify the subject line in
the do not include subject lines. This procedure shows you how to insert a subject line into the
templates.

For related reference topics, see Policies View and NetWitness Platform Out-of-the-Box Policies.

To include the subject line from a Health & Wellness email template in your email notification:

Q
1. Goto (Admin) > System.

2. In the options panel, select Global Notifications.

3. Select a Health & Wellness Email Template (for example, Health & Wellness Default SMTP
Template).

Respond Users Hosts Files Dashboard Reports o
System
L0 Global Notification
Updat
Qutput Servers
Licensi
X
Emai + #
Name ~ Template Type Description Actions
soacy Notifications Audit Logging Default Audit CEF Template Eed
System adable Form - P
Global Auditing
? &
Jobs
) &
Live Services
URL Int plate for d %
Context Menu Actions &
nvestigation o
ESA
b
ESA Analytics
%
Whois
HTTP Proxy Settings Health ATP T 80~
'
NTP Settings
C PagesSie 25 v Displaying 1- 12 of 12 templates
RS /\ NETWITNESS® PLATFORM 11.5.0.0

The Define Template dialog is displayed.

4. Click J, then in the Template field, copy the Subject Line (Highlight the subject line and press
Ctrl-C) into the buffer.
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Define Template

Mame * Health & Wellness Default SMTP Template

Template Type  Health Alarms
Description Health & Wellness Default SMTP Template

Template *

/f RECOMMEND: Use this line from the template as the Email Subject line
when defining Motification Type

MW Health <#if state == "ACTIVE"=%{severity?lower_case?cap_first}
Severity<#elsex${state?lower_case?cap_first}</#if> Alarm:
${ruleName!"Unknown Rule Name"} on ${hostName!"Unknown Host Name™}
I
<head=

<meta http-equiv="Content-Type" content="text/html; charset=UTF-8">

</head>
<body bgcolor="#eeeeee" leftmargin="0" topmargin="0" marginwidth="0"
marginheight="0">
<table border="0" cellpadding="0" cellspacing="0" height="100%"
width="100%" id="bodyTable">

Cancel

Click Cancel to close the Template.
6. Click the Output tab and select a notification (for example Health & Wellness).

7. Click z

The Define Email Notification dialog is displayed.

8. Replace the value in Subject ficld text box with the subject line that you have in the buffer
(highlight the existing text and press Ctl-V).

Monitor NetWitness Platform Health
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Define Email Notification

Enable [l
Ha&W Email notification

To Email Addresses *

Subject Template Type  Health & Wellness default email subject

MW Health <#if state == "ACTIVE">${severity?lower_case?
cap_first} Severity<#else=%{state?lower_case?cap_first}</#if>
Alarm: ${ruleName!"Unknown Rule Name"} on
${hostName!"Unknown Host Name"}

9. Click Save.
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Monitor System Statistics

The System Stats Browser filters statistics by the selected host, component running on the host,
statistical category, individual statistic, or any combination of host, component, category, and
statistic. You can also choose the order in which to display this information.

To access the System Stats browser:

Q
1. Goto (Admin) > Health & Wellness.
The Health & Wellness view is displayed with the Alarms tab open.
2. Click the System Stats Browser tab.

The System Stats Browser tab is displayed.

ond Users Hosts Files Da: re 1 admin v

ices Event Sources Endpoint Sources Health & Wellness stem  Security

Monitoring Policies System Stats Browser VNI VIL TGS Settings

Host Component Category Statistic Order By

Any v Any v Any v S Clear w
[Cregex [Cregex ®#scending ODescending ;

Host Component Category statistic Subitem Value Last Update Historical Graph E

11Esap Host DiskRaid Adzprer Model o PERC H730P Mini 20194 7:24:15 P, =

T11ESAP Host DiskRaid Logic: State 0.0 Optimal

T11ESAP Host DiskRaid Logic: State 0.1 Optimal

TT1ESAP Host DiskRaid Overall Logical Drives Error Status o o

111EsAP Host DiskRaid Overall Physical 0 d

111E54P Host DiskRaid Physical Drive 0325 0 a

111E54P Host DiskRaid Physical Drive 0322 0 i

11E58P Host DiskRaid Physical Drive Pre 0320 o i

11Esap Host DiskRaid Physica Driv 032.1 o i

11Esap Host DiskRaid Physica Driv 0324 o i

T11ESAP Host DiskRaid Physical Drive Pre 0323 o Pl

T11ESAP Host DiskRaid Physi 0321 Online, Spun Up

111EsAP Host DiskRaid Physi 0320 Online, Spun Up

111EsAP Host DiskRaid Physi 0323 Online, Spun Up

111E54P Host DiskRaid Physi 0325 Hotspare, Spun Up

111E54P Host DiskRaid Physi 0322 Online. Spun Up

11E58P Host DiskRaid Physi 0324 Online, Spun Up

tiacean e EonCmenmn Eromr Comen n . 4

| Page 1 |ofas | } N1 C tems 1-50 of 2385

RS /\ NETWITNESS' PLATFORM 11500
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Filter System Statistics

You can filter system statistics to monitor:

Statistics collected for a particular host

L]
« Statistics collected for a particular component
« Statistics collected of a particular type or that belong to a certain category

Statistics listed in an ordered way as per the selection chosen

To filter the list of system statistics:

Q
1. Goto (Admin) > Health & Wellness.
The Health & Wellness view is displayed with the Alarms tab open.

2. Click System Stats Browser.
The System Stats Browser tab is displayed.

Users Hosts Files Dashboard Reports

admin v
Event Sources Endpoint Sources Health & Wellness  System  Security

Monitoring Policies BECUREINGNEIE  Event Source Monitoring Settings

Host Component Category Statistic Order By

Any ~ Any v Any v DY Clear w
[CRegex [Cregex ®Ascending ODescending ;

Host Component Category statistic Subitem Value Last Update Historical Graph E

11ESAR Host DiskRaid Adapter Model 0 BERC H7308 Mini 2019-02-01 07:24:15 P =

T111ES8P Host DiskRaid Drive State 0.0 Optimal

111ES8P Host DiskRaid Drive State 01 Optimal

111ES8P Host DiskRaid Overall Logical Drives Error Status 0 A

111ES8P Host DiskRaid Overall Physical Drives Error Status 0 i

111E8P Host DiskRaid Physical Drive Predi 0325 0 i

111ES8P Host DiskRaid Physical Drive 0322 0 i

111ES8P Host DiskRaid Physical Drive 0320 0 iy

111ESAP Host DiskRaid Physical Drive 0.32.41 0 A

11ESAR Host DiskRaid Physical Drive 0.32.4 0 i

T111ES8P Host DiskRaid Physical Drive 0323 0 i

111ES8P Host DiskRaid Physical Dr 0321 Online, Spun Up

111ES8P Host DiskRaid Physical Dr 0320 Online, Spun Up

111ES8P Host DiskRaid Physical Dr 0323 Online, Spun Up

111E8P Host DiskRaid Physical Dr 0325 Hotspare, Spun Up

111ES8P Host DiskRaid Physical Dr 0322 Online, Spun Up

111ES8P Host DiskRaid Physical Drive State 0.32.4 Online, Spun Up

tiazean - R S - 2 i hs

| Page 1 |ofas | » DI C tems 1 - 50 of 2385
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Filter the list of system statistics in one of the following ways:

o To view system statistics for a particular host, select the host in the Host drop-down list.
The system statistics for the selected host is displayed.

« To view system statistics for a particular component, select the component in the Component
drop-down list.
The system statistics for the selected component are displayed.

« To view system statistics for a particular category, type the category name in the Category
field.
Select Regex to enable the Regex filter. It performs a regular expression search against text
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and lists the specified category. If Regex is not selected, it supports globbing pattern
matching.
The System Stats for the selected category is displayed.

o To list statistics in a preferred order, you can set the order in the OrderBy column.

o To view a particular statistic across hosts, type the statistic name in the Statistic field.
Select Regex to enable the Regex filter. It performs a regular expression search against text

and lists the specified category. If Regex is not selected it supports globbing pattern matching.

The information for the selected statistics is displayed.

The following figure shows the System Stats Browser filtered by the 111Conc host listed in
descending statistical category order.

Hosts Event Sources Endpoint Sources Health & Wellness em  Security
Alarms ~ Monitoring  Policies  [ESCIIISEISI WSS  Event Source Monitoring  Settings
Host Component Category Statistic Order By
11Conc v Any v Any ~ QG Clear
ClRegex [lRegex Dascending ®Descending
Host Component Category statistic Subitem Value Last Update Historical Graph
Collectd MessageBusWriteModule message published 420690

rabbiz@b619194b-6b...

5012 GE
50.26 GE
False

489

Node Erlang Proc rabbit@b6191

ofs | Y N1 C

| Page [1

RS/\ NETWITNESS PLATFORM 11.5.0.0

3. To view the details for an individual statistic:

a. Select a row to select a statistic.

b. Click ~'.
The Stat Details pane is displayed.

tems 1 - 50 of 208

admin v

-

S|IEIaq 18
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Stat Detalls 1
Hostname 111 Conc -
Component |D messagebus
Component MessageBus
Mame Mode Sockets Used
Subitem rabbit@bE191594b-60a2-4508-95c4-42b53df02 eed
Path
PIUEIN messagebus_localhost
Plugin Instance
Type E3Uge
Type Instance rabbit@b&191594b-6ba2-4508-95c4-
deh53dfi2eed _sockets_used
Description Mumber sockets used by this message broker.
Category MessageBus
Last Updated Time 2018-02-01 07:31:55 PM
Value 4]
Raw Value 6.0
Graph Data Key bG19194b-6ba2-4308-95c4d-

4aph53df02ead/messagebus_localhost/zauge-
rabbit@b&1915%4b-6ba2-4508-55c4-
4ep53df0Zeed_sockets_used

t Key b619194b-6ba2-4508-35c4-
deh33df0Zeed/meszagebus_localhost/gauge-
rabhit@b&19154b-6ba2-4508-95c4-
4ekh53df02eed_sockets_used

stat_collector_wversion 11.3.0.0

pMulti Valu false -

[j¢]

Q
For details on various parameters in the (Admin) > Health & Wellness > System
Stats Browser view, see System Stats Browser View
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View Historical Graphs of System Statistics

The historical graph of the collected system stats gives you information about the variation of the
stats over a selected time frame.

To view a historical graph:

1. Goto (Admin) > Health & Wellness.
The Health & Wellness view is displayed with the Alarms tab open.
2. Click the System Stats Browser tab.
3. Inthe System Stats Browser tab, specify the filter criteria to display the statistics you want.
4. In the Historical Graph column, select i,
The Historical graph for the selected statistic is displayed.

The figure below gives an example of the historical graph for the Memory Utilization statistic for
a host.

Historical Graph

Concentrator: Memory Utilization Time Frame | Current Day v
Zoom 1h 6h 12h 1d Al From | Feb1,2019 | To | Feb 1, 2019
45M
oM §
£
&
35M
30M
08:00 09:00 10:00 11:00 12:00 13:00 14:00 15:00 16:00 17:00 18:00 19:00
—
|
- — T Feb — 2 18:00
m
average
Click and drag in the plot area to zoom in

The graphical view is customized to display the statistics collected for the current day and the
values are zoomed in for an interval of an hour (10.15 - 11.15 hrs). Hover over the graph to view

the details at a particular instant. For example, in the figure it displays the memory utilization at
12.00 hrs.

Monitor NetWitness Platform Health 37



System Maintenance Guide

Note: You can customize the graph view by selecting the Time Frame and Date range. You can
zoom in using the zoom in value, time window, or by just clicking and dragging in the plot area.
For details on the parameters to customize and zoom in functions, see Historical Graph for System
Stats. Any break or gap in the chart line indicates that the service or host was down during that

time.
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Monitor Service Statistics

NetWitness Platform provides a way to monitor the status and operations of a service. The Service
Stats view displays key statistics, service system information, and host system information for a
device. More than 80 statistics are available for viewing as gauges and in timeline charts. Only
statistics for session size, sessions, and packets are viewable in historical timeline charts.

Although different statistics are available for different types of services, certain elements are
common for any Core device.

To monitor service statistics in NetWitness Platform:

QA
1. Goto (Admin) > Services.
The Services view is displayed.

2. Select a service, and select View > Stats in the Actions column.

RS/  investigste  Respond  Users  Hosts  Files  Dashboard  Reports admin

Hosts  Services Event Sources Endpoint Sources Health & Wellness  System  Security

4 Change Service | Kl decoder - Decoder |  Stats ©

decoder - Decoder &
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3. To customize the view, collapse or expand charts. For example, expand the Chart Stats Tray to
see available charts, and then drag a section up or down to change the sequence. Or, drag the
Gauges section to the top so that it is above the Summary Stats section.

Add Statistics to a Gauge or Chart

In the Services Stats view, you can customize the monitored statistics for individual services. The
Chart Stats Tray lists all available statistics for the service. The number of statistics varies
according to the type of service being monitored. Any statistic in the Chart Stats Tray can be
displayed in a gauge or a timeline chart. Only statistics for session size, sessions, and packets are
viewable in historical timeline charts.
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Create a Gauge for a Statistic

To create a gauge for a statistic in the Services Stats view:

QA
1. Goto (Admin) > Services.
The Admin Services View is displayed.
2. Select a service and select View > Stats in the Actions column.

The Chart Stats Tray is displayed on the right side.

If the tray is collapsed, click to view the list of available statistics.
4. From the Chart Stats Tray, click on any statistic and drag it into the Gauges section.

A gauge is created for the statistic. If there is no space for the gauge, a new page is created in
the Gauges section and the gauge is added to the new page. In the example, the Active
CPU Time chart was added to the Gauges section by dragging it from the Chart Stats Tray.

Gauges - Page 1 of 1

H CPU Memoeory Process Max Active CPU Time
Name 4 Value .
Dis...  Memory Process Max

Path  /sys/stats/memory.process.max

Sta... MEMOory.process. max

Active CPU
Process Time

Create a Timeline Chart for a Statistic

To create a timeline for a statistic:

From the Chart Stats Tray, click on a statistic and drag it into the Timeline Charts or the
Historical Timeline Charts section.

A timeline chart is created for the statistic. If there is no space for the chart, a new page is created
in the Timeline Chart section and the chart is added to the new page. In the example, the Assembler
Packet Pages chart was added to the Timeline Charts section by dragging it from the Chart Stats
Tray.
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Timeline Charts - Page 1 of 1
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Search for a Statistic in the Chart Stats Tray

To search for a statistic, type a search term; for example, session, in the Search field
and press Enter. Statistics that match are displayed with the matching word highlighted.

Chart Stats Tray

Search |session| X

Stats

Assembler Sessions
Stat Name:azsembler.sessions
Path:/decoder/stars/assembler.zessions

Session Bytes
Stat Name:session.bytes
Path:'databaselstats/session. bytes

Session Bytes Last Hour
Stat Name:session.bytes.last.hour
Path:'database/stats/session. bytes.last.hour

Session Completion Queue
Stat Name:pool.session.complets
Pathy'decoder/parsers/stats/pocl.session.complete

5ession Correlation Queue
Stat Name:pool.session.correlate
Path:'decoder/stars/pool.session.correlate

Session Decrement Queue
Stat Name:pool.session.decrement
Path:'decoder/stats/pool.session.decrement

Session Export Cache Files
Stat Name:=xport.session.cache.files
Path:/decoder/stats/export.session.cache.files

| Page 1 of2 | ¥ » | C Stats 1-12 of 24
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Edit Properties of Statistics Gauges

The Gauges section of the Service Stats view presents statistics in the form of an analog gauge. The
properties of each individual gauge are editable; all gauges have an editable title and some have
additional editable properties.

Edit Properties of a Gauge

Q
1. Goto (Admin) > Services
The Admin Services view is displayed.

2. Select a service and select View > Stats in the Actions column.
The Service Stats view includes the Gauges section.

3. Go to the gauge for which you want to edit properties (for example, Memory Process).

Memory Process Max

4GB

12.0GB 44.0GE

12.6GB 50.3GB

(&1}

3G8 31 4GB h8.6GB

0.0 Memory Process §2.8GB
Max

4. Click the Properties icon () to display the parameter names and values.

5. To highlight the value of the Display Name field, double-click on the value; for
example, Memory Process.

Note: Clicking the other two values does nothing because the properties are not editable in
the gauge.

6. Type a new value for the Display Name and click the Properties icon ().
The new title replaces Memory Process.

Add Stats to the Gauges Section

You can add more gauges by dragging a statistic from the Chart Stats Tray into the Gauges
section.

1. To expand the Chart Stats Tray, click

2. Scroll down and select a statistic, for example, Session Rate (maximum).
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3. Drag the statistic to the Gauges section.
The new gauge is displayed in the Gauges section.

Edit Properties of Timeline Charts

Timeline charts display statistics in a running timeline. The Service Stats view includes two types of
timelines; current time and historical. You can drag any statistic available in the Chart Stats Tray to
the Timeline Charts section. Only statistics for session size, sessions, and packets are viewable in
historical timeline charts. The properties of an individual timeline chart are editable; all timeline
charts have an editable title and some have additional editable properties.

To access the charts:

A
1. Goto (Admin) > Services.
2. Select a service and click Stats.

The Services Stats view is displayed. The charts are in this view.

Edit Properties of a Timeline

To edit properties of a timeline chart:
1. Go to the timeline chart for which you want to edit properties (for example, Memory Process).

1>

Timeline Charts - Page 1 of 1
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2. Click the Properties icon (=) to display the parameter names and values.

3. Double-click on a value (for example, the Display Name field) to make the value editable.

Note: Clicking the other two values does nothing because the properties are not editable in the
chart.

4. Type a new value and click the Properties icon.

The timeline chart is displayed with new values.

Edit Properties of a Historical Timeline

To edit properties of a historical timeline chart:
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1. Go to Historical Timeline Charts.

2. Click the Properties icon (= ) to display the parameter names and values.

3. Click on a value (for example, 01/27/2019 for the Begin Date field) to make the value editable.

>

Type a new value.

hdl

Edit the End Date and Display Name if required.

6. Click the Properties icon ().
The historical timeline is displayed with new values.

Note: To return the properties of the historical timeline chart back to the default so that the values
dynamically update, remove the Begin Date and the End Date, place your cursor in the Begin
Date field, and refresh your browser.

Add Stats to Timeline Charts

You can add timeline charts by dragging a statistic from the Chart Stats Tray into the Timelines
section.

1. To expand the Chart Stats Tray, click
2. Scroll down and select a statistic; for example, Session Rate (maximum).

3. Drag the statistic to the Timelines Section.
The new timeline is displayed in the Timelines section.

Monitor Hosts and Services

NetWitness Platform provides a way to monitor the status of the hosts and services installed in your
environment. You can view the current health of all the hosts, services running on the hosts, their
CPU usage and memory consumption, and the host and service details.

To monitor hosts and services in NetWitness Platform:

Q
1. Goto (Admin) > Health & Wellness.
The Health & Wellness view is displayed with the Alarms tab open.

2. Select the Monitoring tab.
A list of all hosts and their associated services that belong to the group All is displayed by
default.
The operational status, CPU usage, and memory usage for each host is displayed.
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A list of services installed on the host is shown below the host. If you cannot see the services,
click £ to the left of a host to display the services.

The name, operating status, CPU usage, memory usage, and the time operating for each service
is displayed.

Filter Hosts and Services in the Monitoring View

You can filter hosts and services in the monitoring view in one of the following ways:
« Hosts belonging to a particular group

« A specific host and its associated services

« Hosts whose services are stopped

o Hosts whose services have stopped processing or processing has been turned off

o Hosts that have physical drive problems

o Hosts that have logical drive problems

o Hosts that have full file systems

For the related reference topic, see Monitoring View.

To filter hosts and services:

QA
1. Goto (Admin) > Health & Wellness.
The Health & Wellness view is displayed with the Alarms tab open by default.

2. Select the Monitoring tab.

3. Filter the hosts and services in one of the following ways:
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o To view a list of hosts and their associated services belonging to a particular group, select the

group in the Groups panel.

All hosts and their associated services belonging to the specified group are displayed in the
Hosts panel.

Note: The grouping of hosts is derived from the groups created in the Admin Hosts
view. All groups created in the Admin Hosts view are displayed here.

For example, if you select the group LC_Group in the Groups panel, a list of all hosts that
are part of the group are displayed.

To view a list of all services that have stopped processing, click Stopped Processing in the
Hosts panel.

A list of all the hosts that have at least one service with the status as stopped processing is
displayed.

Note: The buttons on the top display the system statistics for all of the hosts configured in
NetWitness Platform and does not change with the application of filters on the groups.
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In a similar way, you can filter the list of hosts and the associated services by choosing the
appropriate filter:

« Click Stopped Services to display a list of all stopped services.
« Click Physical Drive Problems to display a list of host with physical drive problems.

o Type the host name in the Filter box to display only the required host and the services
running on the host.

Monitor Host Details

You can view the details of a host, its memory and CPU usage, system information, physical drive,
logical drive, and file system details to investigate potential problems with the host.
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To view host details:

Q
1. Goto (Admin) > Health & Wellness > Monitoring tab.
2. Click a host in the Hosts panel.

The Host Details view shows important system information about the selected host, such as
memory utilization and file system usage.

RSA Users  Hosts  Files  Dashboard  Reports admin v
Hosts Services Event Sources Endpoint Sources Health & Wellness  System  Security
Alarms Monitoring System Stats Browser  Event Source Monitoring Settings adminserver @
HOST AND SERVICES -
Host Details
| Host
System Info
Broker
Last dminserver Memory Utilization
Reporting Engine U - Used Memory
Orchestration Server - Total Memory 17
RuRNing Since ’
Security Server Current Time Cached Memary 78 GB
Admin Server Uptime 2 hours 48 minu swap Utilization
< yetem Info Used Swap
Config Server e Linux 3.10.0-862.14.4.¢17.x86_64 x26_64 Total Swap L00GE
nvestigate Server
Respand Server Physical Drive | Logical Drive | File System =~ Adapter | Message Bus
ntegration Server State Enclosure Slot Failure Count Raw Size Inquiry Data
Content Server
source server
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Monitor Service Details

You can view the details of a service, its memory and CPU usage, system information, and various
details depending on the service selected.

To view service details:

1. Goto K&l (Admin) > Health & Wellness > Monitoring tab.
The Hosts panel shows the services running on each host.
2. In the Hosts panel, click a service name link to get more information.

The service details view shows the health status of the selected service. The Decoder service
details include capture statistics and the Concentrator and Broker details include aggregation
statistics.

Monitor NetWitness Platform Health 47



System Maintenance Guide

RSA e Respond Users Hosts Files Da:

Hosts  Services

admin v

Event Sources

Endpoint Sources

Health & Wellness System  Security

Alarms Monitoring Policies System Stats Browser ~ Event Source Monitoring Settings adminserver concentrator @

HOST AND SERVICES

Concentrator Details

Host

Service

I Concentrator
ey 1.4% Used Memery 170.57 MB
Running Since Max Process ory 7.80 GB
Build Data Version Information 11.3.00
Details
Aggregation State started Time Begin
Meta Rate Time End
Meta Rate Max 238

Session Rate

Session Rate Max 9

RS /\ NETWITNESS" PLATFORM 11.5.0.0

Many services, including the ESA Correlation service, have a Health Stats tab that provides
information about the health status of the service. The JVM tab shows the total memory used by
the selected service and the total memory capacity of the host. For more information, see Health
Stats Tab and JVM Tab.

For more information on the ESA Correlation service and ESA Rule memory usage, see the
Alerting with ESA Correlation Rules User Guide.
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The Malware Analysis service details view has Service information plus the Event, and JVM
tabs that show additional statistics. The Events tab shows event processing statistics.

R SA = Respo Hosts Files Das| r ke admin v
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The Reporting Engine service details view has Service information plus the Report and JVM
tabs that show additional statistics.

R S A Inve: te Respond Users Hosts Files Dashboard Reports admin v

Hosts Services Event Sources Endpoint Sources Health & Wellness  System  Security

Alarms Monitoring Policies Systemn Stats Browser  Event Source Monitoring Settings adminserver &

HOST AND SERVICES -
Reporting Engine Details
Host
Service
Broker
cPU Used Memory 1.49 GB
I Reporting Engine ‘
Running Since Max Process Memory 47.17 GB
Orchestration Server - : -
Build Data Version Information 11.3.0.0
Security Server
Admin Server Report VM
Config server Number Of OAs Failed In Last Hour 0 Number Of Active Requests
nvestigate Server Number Of Reports Failed In Last Hour 0 Average Time Taken For RE Requests 188 milliseconds
Number Of Rules Failed In Last Hour 0 Number Of Enabled Alerts
Respond Server
Maximum Time Taken For RE Request 2181 milliseconds Number Of Alert Execution Failed In Last
ntegration Server 10M s -
gra Number Of Requests Completed 140 0 Minutes
. . M ws Fetche: Alerts
Content server Max Number Of Rows Fetched For N ax Rows Fetched For Alert
_ Charts Number Of Requests Failed In Last 10
Source Server Mine
Number Of Chart Executions Failed In o
Last 10 Mins Number Of Requests Received 140
Number Of Enabled Charts 0 Number Of Requests Failed
Total Disk Space 28.00 GB Number Of Active Rule Executions
Used Disk Space 42815MB Total Number Of Failed Rule Executions 0
Max Rule Execution Time 0 milliseconds

RS /\ NETWITNESS® PLATFORM 11.5.0.0

You can also view the details of other services by clicking the services listed in the options panel on
the left.

Refer to Monitoring View for a detailed description of the Details view for each service.
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Monitor Event Sources

Note: For NetWitness Platform 11.4.1, this view has been deprecated. To manage Event Sources,

4
use the (Admin) > Event Sources view. For details, see "About Event Source Management"
in the RSA NetWitness Platform Event Source Management Guide.

Monitor Alarms

You can set up alarms and monitor them in the Health and Wellness interface for the hosts and
services in your NetWitness Platform domain. Alarms display in the view as Active when the
statistical thresholds for hosts and services have been crossed. Alarms are grayed out and change to
the Cleared status when the clearing threshold has been crossed.

You set up the parameters for alarms in Manage Policies. For the related reference topic, see Health
and Wellness View - Alarms View.

To monitor alarms:

QA
1. Goto (Admin) > Health & Wellness.
The Health & Wellness view is displayed with the Alarms tab open by default.
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2. Click on the alarm for which you want to display details in the Details Panel.
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3. Click */ (expand) to view the details for the alarm you selected.

Alarm Details

d 028-12424-0001 -

Time 2019-01-29 03:43:09 PM

State ACTIVE

Severity CRITICAL

Hostmame dec

Service Host

Palic Host Monitaring Palicy

Rule Name Critical Filesystemn Usage on Rabbitmg Message Broker

nformational Text The RabbitMQ) service filesystem at
fvar/netwitness/rabbitmg (fvar/lib/rabbitmg for 10.8.x
systems) has exceeded 75% of capacity, which is a likely
indicator that messages generated by NetWitness services
are either not being sent over the bus or aren’t being sent
quickly encugh.
The RabbitMQ service will stop transmitting messages
when it reaches 80% of its filesystem capacity, which will
cause Health & Wellness message, Event Source
Maonitoring messages, and Log Collector logs to stop
being delivered.
Possible Remediation Action:
The filesystem is soon likely to fill. Please open a case with
Customer Support as quickly as possible to avoid a
potental service outage.

Stat FileSystemi/Mounted Filesystern Disk Usage Percent
Fearflibfrabbitmg

alue TT%

Count 1

Cleared Value

Cleared Time

Motified Time

Suppression Start T -

Monitor Health and Wellness Using SNMP Alerts

Y ou can monitor a NetWitness Platform component to proactively send alerts, using Simple Network
Management Protocol (SNMP) that is based on thresholds or system failures.

You can monitor the following for NetWitness Platform components:
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« CPU utilization that reaches a defined threshold
« Memory utilization that reaches a defined threshold

o Disk utilization that reaches a defined threshold

SNMP Configuration

NetWitness Servers can be configured to send out SNMPv3 threshold traps and monitor traps.
Threshold traps are sent in conjunction with node thresholds that are configured by the NetWitness
Platform Core applications. Monitor traps are sent by the SNMP daemon for the items indicated in
the SNMP configuration file. You must set up the SNMP daemon on another service to receive
SNMP traps from NetWitness Platform. You can set up SNMP on NetWitness Platform in the
configuration setting for the NetWitness Server. For more information, see "Service Configuration
Settings" in the NetWitness Platform Host and Services Getting Started Guide for a specific type of
host.

Thresholds

Thresholds can be set on any service statistics that can accept the setLimit message. You can
retrieve current thresholds using the getLimit message. To set a limit, you can pass a low and high
threshold value.

When the value of a statistic crosses either the low or high threshold, an SNMP trap is triggered,
indicating that the threshold has been crossed. The trap is not triggered if the value is below the low
and above the high value, but another trap is triggered if it crosses back into the normal range (above
the low and below the high).

You must set the threshold for the service using the Service Explorer view or the REST API.
This example shows a sample threshold for monitoring CPU usage (below 10% or above 90%):
/sys/stats/cpu setLimit low=10 high=90

This example shows how the threshold is set using REST API:

http://<log decoder>:50102/sys/stats/cpu?msg=setLimit&low=10&high=90

If the CPU usage spikes to 90% or higher, an SNMP trap is generated:

23435333 2018-Dec-16 11:08:35 Threshold warning path=/sys/stats/cpu 0ld=77%
new=91

Configure SNMPv3 for a Host

QA
1. Goto (Admin) > Services.
The Services view is displayed.

2. Select the service.
3. Inthe Actions column, select View > Explore.

4. In the nodes list, expand the list and select a configuration folder. For example, logs > config
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5. Set the SNMPv3 configuration.
RSA ves e Respo Users Hosts

Hosts  Servic Event Sources  Endpoint Sources v s Security

admin v

% Change Service conc-Concentrator | Explore

debug,info,a

log.text pataname

log.te

ax 10MB
[ devicesppliance I
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CJindex snmpv3.engine.boots O
B logs snmpv3 engine id

[ config

Cstars

none

none

noAuthNoPriv

Cusers
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Set the Threshold for a Service

Q
1. Goto (Admin) > Services.
The Services view is displayed.

Select the service.
In the Actions column, select View > Explore.
In the nodes list, expand the list and select a stat folder.

Select a stat, for example, CPU, and right-click.

S i

From the drop-down menu, select Properties.

The Properties panel is displayed. The Properties panel has a drop-down list of available
messages for the parameter.

get
getlimit
help
info

setlimit
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7. Select setLimit.

8. Specify the low and high values.

SNMP Traps for System Status

The threshold mechanism can also be used to monitor string-valued stats generated by Core services.
There are two ways to monitor string-valued stats:

1. Generate a trap whenever the status value is NOT an expected value. For example, if you want
monitor the stat /broker/stats/status and generate a trap whenever the value is not
started, set the high limit on the stat to the expected value. You would use the setLimit

message on /broker/stats/status as follows:
setLimit high=started

2. Generate a trap whenever the status value matches an expected value. This is accomplished by
using the 1ow limit on the stat. For example, if you wanted generate a trap when the stat
/sys/stats/service.status has the value "Initialization Failure", you would use

the setLimit message on /sys/stats/service.status as follows
setLimit low="Initialization Failure"

In both of these scenarios, it is possible to check for multiple values by using a comma-separated list
of values to check for.

Troubleshooting Health & Wellness

Issues Common to All Hosts and Services

You may see the wrong statistics in the Health & Wellness interface if:
« Some or all the hosts and services are not provisioned and enabled correctly.

¢ You have a mixed-version deployment (that is, hosts updated to different NetWitness Platform
versions).

« Supporting services are not running.

Issues Identified by Messages in the Interface or Log Files

This section provides troubleshooting information for issues identified by messages NetWitness
Platform displayed in the Health & Wellness Interface or included in the Health & Wellness log
files.

User Interface: Cannot connect to System Management Service
System Management Service (SMS) logs:

Caught an exception during connection recovery!
java.io.IOException
at com.rabbitmg.client.impl.AMQChannel.wrap

(AMQChannel.java:106) at
com.rabbitmg.client.impl.AMQChannel.wrap

Message
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(AMQChannel.java:102) at
com.rabbitmg.client.impl.AMQConnection.start (

AMQConnection.java:346) at
com.rabbitmg.client.impl.recovery.

RecoveryAwareAMQConnectionFactory.
newConnection

(RecoveryAwareAMQConnectionFactory.java:36)
at com.rabbitmg.client.impl.recovery.

AutorecoveringConnection.
recoverConnection (AutorecoveringConnection.java:388)
at com.rabbitmg.client.impl.recovery.

AutorecoveringConnection.beginAutomaticRecovery
(AutorecoveringConnection.java:360)

at
com.rabbitmg.client.impl.recovery.AutorecoveringConnection.

access$000 (AutorecoveringConnection.java:48)
at com.rabbitmg.client.impl.recovery.

AutorecoveringConnection$l.shutdownCompleted
(AutorecoveringConnection. java:345)
at com.rabbitmg.client.impl.ShutdownNotifierComponent.

notifyListeners (ShutdownNotifierComponent.java:75)

at com.rabbitmg.client.impl.AMQConnection$MainLoop.run
(AMQConnection.java:572)

at java.lang.Thread.run (Thread.java:745)

Caused by: com.rabbitmg.client.ShutdownSignalException:
connection error at
com.rabbitmg.utility.ValueOrException.getValue
(ValueOrException.java:67)

at com.rabbitmg.utility.BlockingValueOrException.

uninterruptibleGetValueBlockingValueOrException.java:33)
at
com.rabbitmg.client.impl.AMQChannel$BlockingRpcContinuation.

getReply
(AMQChannel.java:343)
at com.rabbitmg.client.impl.AMQConnection.start
(AMQConnection.java:292)

8 more
Caused by: java.net.SocketException: Connection reset
at java.net.SocketInputStream.read
(SocketInputStream.java:189)
at java.net.SocketInputStream.read
(SocketInputStream.java:121)
at java.io.BufferedInputStream.fill
(BufferedInputStream.java:246)
at java.io.BufferedInputStream.read
(BufferedInputStream.java:265)
at java.ilo.DataInputStream.readUnsignedByte
(DataInputStream.java:288)
at com.rabbitmg.client.impl.Frame.readFrom(Frame.java:95)
at com.rabbitmg.client.impl.SocketFrameHandler.readFrame
(SocketFrameHandler.java:139)
at com.rabbitmg.client.impl.AMQConnection$MainLoop.run
(AMQConnection.java:532)
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RabbitMQ service not running on the NetWitness Server.

Restart the RabbitMQ, SMS, and NetWitness Platform services using the
following commands.

systemctl restart rabbitmg-server

systemctl restart rsa-sms

systemctl restart jetty

User Interface: Cannot connect to System Management Service

The System Management Service, RabbitMQ, or Mongo service is not running,.

Run the following commands on NetWitness Server to make sure all
these services are running.
[root@nwserver ~]# systemctl status rsa-sms
RSA NetWitness SMS :: Server is not running.
[root@nwserver ~]# systemctl start rsa-sms
Starting RSA NetWitness SMS :: Server...
[root@nwserver ~]# systemctl status rsa-sms
RSA NetWitness SMS :: Server is running (5687).
[root@nwserver ~]# systemctl status mongod
mongod (pid 2779) is running...
systemctl status rabbitmg-server
Status of node nw@localhost
[{pid, 2501},
{running applications,
[{rabbitmg federation management, "RabbitMQ Federation
Management",
"3.3.4"},

User Interface: Cannot connect to System Management Service

/var/lib/rabbitmg partition usage is 70% or greater.

Contact Customer Care.

User Interface: Host migration failed.
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One or more NetWitness Platform services may be in a stopped state.

Make sure that the following services are running then restart the NetWitness

Server:

Archiver, Broker, Concentrator, Decoder, Event Stream Analysis, Response
Server, IPDB Extractor, Log Collector, Log Decoder, Malware Analysis,
Reporting Engine, Warehouse Connector, Workbench.

User Interface: Server Unavailable.

One or more NetWitness Platform services may be in a stopped state.

Make sure that the following services are running then restart the NetWitness
Server: Archiver, Broker, Concentrator, Decoder, Event Stream Analysis,
Response Server, IPDB Extractor, Log Collector, Log Decoder, Malware
Analysis, Reporting Engine, Warehouse Connector, Workbench.

User Interface: Server Unavailable

System Management Service (SMS), RabbitMQ, or Mongo service is not running.

Run the following commands on NetWitness Server to make sure all these services

are running,

[root@nwserver ~]# systemctl status rsa-sms

RSA NetWitness SMS :: Server is not running.
[root@nwserver ~]# systemctl start rsa-sms
Starting RSA NetWitness SMS :: Server...
[root@nwserver ~]# systemctl status rsa-sms
RSA NetWitness SMS :: Server 1is running (5687).

[root@nwserver ~]# systemctl status mongod
mongod (pid 2779) is running...
systemctl status rabbitmg-server
Status of node nw@localhost
[{pid, 2501},
{running applications,
[{rabbitmg federation management, "RabbitMQ Federation
Management",
"3.3.4"},
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Make sure /var/1lib/rabbitmg partition is less than 75% full

Check NetWitness Server log files (var/lib/netwitness/uax/logs/nw.log)
for any errors.

ContextHub stops and does not allow you to add or edit data sources and lists.

The storage is full by 95% or above.

Increase the storage by updating the YML file, located at
/etc/netwitness/contexthub-server/ contexthub-server.yml.
For example, to increase storage from 120 to 150 GB, enter a value (in bytes) by

editing the relevant parameter: rsa.contexthub.data.disk-size:
161061273600

Delete unwanted or unused large list.

Configure the TTL index for the list to automatically delete STIX and TAXI data
and to clean up storage space.

Context Hub runs on a fixed memory and 50% is reserved for cache. When cache
is 100% full, the cache response stops. For all new lookups the response will be
slow.

The cache is full by 50% or above.

By default, Context Hub cleans the cache every 30 minutes. Reduce the cache
expiration time of data sources.

Disable cache for data sources.

Increase the RAM of the CH Java process by editing the —-Xmx option available in
the /etc/netwitness/contexthub-server/contexthub-server.conf file. In JAVA OPTS,
search for the -xmx option.

For example, edit the entry as follows:

-Xmx8G

where 8G represents 8GB space. Then restart the ContextHub service.

Note: The memory is less than the available system memory. Be aware that
there are many other services running on the host.
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List Data Source displays an unhealthy stats or status.

Unable to:

o access the data source

o parse or read a CSV file

e schema mismatched CSV

Unable to authenticate when accessing the data source.

Make sure to save the csv file at correct location i.e/var/lib/netwitness/contexthub-
server/data/ and verify the required read permissions.

Make sure the csv file schema specified while configuring the data source
matches. If not, then either create a new data source with the new schema or edit
the csv file to match the schema. For example, if you configure a List Data Source
with a schema with columnl, column2, and column3. And next time you update the
csv file where the number of column increase or decrease or the order of the
columns are changed. In this case there is a schema mismatch and the configured
list data source will show “Unhealthy” in Health and Wellness stats.

Make sure the password is correct. To confirm edit the data source, enter the
password and click test connection.

For more information related the above solutions, see "Configure Lists as a Data
Source" topic in the Context Hub Configuration Guide.

Issues Not Identified by the User Interface or Logs

This section provides troubleshooting information for issues that are not identified

by messages NetWitness Platform displays in the Health & Wellness Interface or includes in the
Health & Wellness log files. For example, you may see incorrect statistical information in the
Interface.

Incorrect statistics displayed in Health and Wellness interface.

SMS service is not running. SMS service must be running on the NetWitness
Server.

Restart SMS service.
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Problem

Possible

Cause

Solution

Problem

Possible
Cause

Solution

Problem

Solution

NetWitness Platform does not show the version to which you upgraded until
you restart jettysrv (jeTTy server).

When NetWitness Platform checks a connection, it polls a service every 30
seconds to see if it is active. During that 30 seconds, if the service comes back up,
it will not get the new version.

1. Manually stop the service.

2. Wait until you see that it is it offline.

3. Restart the service.
NetWitness Platform displays the correct version.

NetWitness Server does not display the Service Unavailable page.

After you upgrade to NetWitness Platform version 10.5, JDK 1.8 is not default
version and this causes the jettysrv (jeTTy server) to fail to start. Without the
jeTTy server, the NetWitness Platform server cannot display the Service
Unavailable page.

Restart jettysrv.

The SMS service is stopped and the following error is displayed in the log file:
java.lang.OutOfMemoryError: Java heap space

You can use the following solution to increase the memory according to your needs.

1. Open /opt/rsa/sms/conf/wrapper.conf

2P 1oot@NWAPPLIANCE3290:
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wrapper.java.additional.l=-Xmx1l6g

Restart the SMS service:
systemctl start rsa-sms

Replace wrapper.java.additional.l=-Xmx8192m with:
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Monitor New Health and Wellness

RSA NetWitness New Health and Wellness is an advanced monitoring and alerting system that provides
insights on the operational state of the host and services in your deployment, and helps identify potential
issues. NetWitness Platform is prepackaged with a third-party tool that renders interactive dashboards
and visualizations.

New Health and Wellness provides:

« Dashboards with interactive visualization.

« Easy-to-create customized content.

o Alerts on your data and customize alert conditions.

« Ability to add alert notifications (for example, Email and Syslog notifications).

« Ability to suppress alert notifications for a time period as required.

New Health and Wellness provides default content, such as dashboards, visualizations, and monitors, to
set up monitoring and alerting.

Please direct any New Health and Wellness feedback to nw.health.wellness.feedback@rsa.com.

Dashboard

The dashboard is a collection of intuitive visualizations for the administrator to monitor the health of the
host and services, identify trends, track performance, and drill down to specific details.

After installation of the New Health and Wellness service, the following default dashboards are
available to begin monitoring.

o Deployment Health Overview dashboard
« Hosts dashboard

o Logs dashboard

« Packets Overview dashboard

o Analysis dashboard

« Endpoint dashboard

o ESA Correlation Overview dashboard

For more information on the dashboards, see New Health and Wellness Dashboards .

Visualization

A visualization is a graphical representation of data in your deployment. You can create new
visualizations or use the existing visualizations to build dashboards. Depending on the visualization you
select the data is displayed in the dashboard.
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Monitors

A monitor is a job that runs on a defined schedule, which queries Elasticsearch to evaluate the system
health. You can define one or more triggers for a monitor and assign a severity level based on the
threshold. When one or more trigger conditions are met, New Health and Wellness generates an alerts.
You can create new monitors or customize the existing monitors based on your requirement.

Notifications

Notifications can be sent when health alerts are generated, for example, email and syslog notifications.

If you do not want to receive notifications, you can suppress them for a time period. For example, if you
want to suppress low-severity alerts during weekends, you can do so by specifying a suppression policy.

After the suppression time period, the notifications will be sent for the alerts triggered during the
suppression time.

Installing New Health and Wellness

You can deploy the New Health and Wellness feature on any one of the following, listed in the order of
preferred deployment method with most preferred first:

« Standalone virtual host (Most preferred recommendation to ensure no performance impact on any
other functionality of deployed nodes)

« Physical machine:
o Broker
o Admin Server

o ESA

Installing New Health and Wellness enables all hosts and services in your deployment to start sending
metrics for monitoring. For more information on installing New Health and Wellness, see the
"Deployment Optional Setup Procedures" topic in the Deployment Guide.

Accessing New Health and Wellness Dashboards

After you deploy New Health and Wellness, you can access New Health and Wellness dashboards. By
default, only Administrator can access New Health and Wellness dashboards. Other roles do not have
permission to view New Health and Wellness dashboards.

To access New Health and Wellness dashboards:

1. Log in to NetWitness Platform.

A
2. Goto (Admin) > Health & Wellness.
3. Click New Health & Wellness.
4. Click Pivot to Dashboard.

Note: To view dashboards, your browser must be configured to allow popups and redirects.
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Configuring Notifications

You can choose to receive notifications of alert, when an alert (monitor) is triggered. You can
configure the following types of notifications for the alerts.

o Email

« Syslog

To set up notifications, you must configure the following :

« Notification Server: This is the source of the notifications and must be configured to specify the
Email or Syslog server settings.

« Notifications Output: This is the notification type, namely Email or Syslog. When you set up a
notification, you must specify the notification output for an alert.

o Templates: The message format of an alert notification is defined using template. Default
template is available for New Health and Wellness notifications or you can create new templates.
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Adding Alert Notifications

To add notifications such as email or syslog, you must specify the notification details as follows:
o Output Type

« Recipient

« Notification Server

o Template

Note: You must ensure that the notification server and template is configured before you set up
the notifications. You can use an existing server if required. For detailed procedures, see the
System Configuration Guide.

To add a notification:

L.

Goto (Admin) > Health & Wellness.

Click New Health & Wellness.

Click View Notifications Settings.

Specify the following:

o Output Type - Notification type such as Email or Syslog.

« Recipient - Select the recipient based on the output type selected.

« Notification Server - Select the server that will send the notification. If you want to add a

new notification server, see "Configure Notification Servers" in the System Configuration
Guide.

o Template - Notification template such as Email or Syslog.

5. If you want to add another notification, click Add Condition and repeat step 4.

Note: You can specify a maximum of four conditions in the notification settings.

6. Click Save.
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Suppressing Notifications

You can suppress notifications for a time period by specifying a suppression policy. For example,
you do not want to receive notifications of low-severity alerts during peak hours or weekends. This
ensures that notifications are not sent during the selected time period. The notifications triggered
during this time period will be sent after the suppression period.

A suppression policy consists of condition that defines the day and time range for suppressing a
notification.

Note: You can specify a maximum of seven conditions in the policy.

To suppress alert notification:

1. Goto (Admin) > Health & Wellness.

2. Click New Health & Wellness.

3. Inthe New Health & Wellness tab, do anyone of the following:
« Select the alert or alerts for which you want to apply a suppression policy.
« Select all to apply a suppression policy to all alerts.

« Filter alerts on suppression applied, monitor name, trigger name, and severity and apply
the suppression policy.

4. Click View Suppression Policy.
The policy suppression dialog is displayed.

5. Specify the days and time range during which you want to suppress the notification.

Note: Time range is based on the Time Zone configured in the User Preferences panel as
described in "Setting User Preferences" in the Getting Started Guide.

6. To add an additional suppression policy, click Add condition and repeat step 5.

Note: The maximum number of suppression policy supported for an alert is seven, after which the
Add Condition option is disabled.

7. Click Save.
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Monitoring through Dashboards

For a thorough analysis of the health of NetWitness Platform hosts and services using the different
dashboards, you can pivot to dashboard without any additional authentication. By default, the last 6
hours of data is displayed in the dashboard. For more information on the default dashboards, see
New Health and Wellness Dashboards.

To monitor through the dashboard:

A
1. Goto (Admin) > Health & Wellness.
2. Click New Health & Wellness.

3. Click Pivot to Dashboard.
The Deployment Health Overview dashboard is displayed.

4. Click S0 to view all the available dashboards.

5. Select the dashboard you want to view.

6. Click the dashboard link. For example, Hosts.
Once the dashboard view is displayed you can look at the visualizations (charts, tables, and so
on) to view current disk usage of hosts, incoming and outgoing traffic of the host, active queries
on a service, and so on.

== Current Memory Usage vs Total Avallable Memory Disk Usage by Partitions

26.28GB

28.47GB

Sarvice(s) by Open File Descriptors
‘Current Disk Usaga vs Total Available Disk

10.99GB

191.2GB

7. You can adjust the time range on the top right corner and apply filters to view the statistics.

Create a New Dashboard

You can create a new dashboard by adding one or more existing visualizations or a new
visualization that you created.
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To create a new dashboard:

1. Log in to NetWitness Platform.

2. Goto (Admin) > Health & Wellness.

3. Click New Health & Wellness.

4. Click Pivot to Dashboard.

5. Inthe Dashboards panel, click Create new dashboard.

6. Click Add to add visualizations to the dashboard. For more information on adding visualization,
see the "Visualize" topic in the Kibana 7.4.2 guide.

7. Select the visualizations that you want to add to the dashboard.

8. Click Save.
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Creating a Custom Dashboard

You can create a new dashboard by adding one or more existing visualizations or a new
visualization.

To create a new dashboard:
1. Log in to NetWitness Platform.

A
Go to (Admin) > Health & Wellness.
Click New Health & Wellness.
Click Pivot to Dashboard.

In the Dashboards panel, click Create new dashboard.

AN e T

Click Add to add visualizations to the dashboard. For more information on adding visualization,
see "Visualize" topic in the Kibana 7.4.2 guide.

~

Select the visualizations that you want to add to the dashboard.

8. Click Save.
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Monitoring through Alerts

You can monitor the health of NetWitness Platform hosts and services using the alerts.

To monitor using alerts:

A
1. Goto (Admin) > Health & Wellness.
2. Click New Health & Wellness.

The alerts view summarizes the alerts generated over the period of time along with the trigger,
severity (Critical, High, Medium or Low) and state of the alert.

4. To view the monitors and triggers associated with the alert, click the Monitor name link.

| / Alerting

Alerts

All severity levels All alerts

Alert start time .- Alert end time Monitor name Trigger name Severity State Time acknowledged
01/17/20 3:48 pm 01/17/20 4:18 pm .. Capture Not Started 1 Completed

01/17/20 3:48 pm 01/17/20 4:18 pm ...  Capture Pool Depleted 2 Completed

01/17/20 3:01 pm 01/17/203:37 pm .. Capture Not Started 1 Completed

01/17/20 3:01 pm 01/17/20 3:37 pm ... Capture Pool Depleted Completed

01/06/20 11:57 am 01/07/20 3:28 pm ... Capture Not Started Completed

01/06/20 11:57 am 01/07/20 3:28 pm ... Capture Pool Depleted Completed

01/06/20 11:57 am = ...  Service in Bad State Active

01/06/20 11:57 am - ... Aggregation Stopped Active

01/06/20 11:57 am = ... MetaRateis0 Active

01/06/20 11:57 am = ... Service in Bad State Active

For example, if an alert is generated by the monitor name Broker Aggregation Stopped, you can
view more details by clicking on the Broker Aggregation Stopped monitor link.
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Broker Aggregation Stopped

Broker Aggregation Stopped

Overview

State Monitor definition type Total active alerts Schedule
Enabled Visual graph 1 Every 2 minutes

Last updated Monitor ID Monitor version number
01/06/20 11:55 am IST 2LuHeW8BTA: v 1
Triggers

Name - Number of actions Severity

Aggregation Stopped 0 L

Aggregation Stopped

History
o 01/18/2020 12:00 AM > 01/20/2020 11:56 AM

Aggregation St
opped

IE——SSS————F

Triggered I Error I Acknowledge No alerts

Iriggered . Error . Acknowledge No alerts

Alerts
All severity levels All alerts

Alert start ti... \|-  Alert end time Monitor name Trigger name Severity Time acknowle...

01/06/20 11:57

am Aggregation ... Active

Rows per page: 20
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Creating Custom Monitors

You can create a new monitor for the host and services and define a trigger.

To create monitors:

1. Log in to NetWitness Platform.

A
2. Goto (Admin) > Health & Wellness.
3. Click New Health & Wellness.
Click Pivot to Dashboard.

o |

Click Create monitors.

>

In the Create Monitors section, specify the required details.
Click Create.

S S

After a monitor is created, you can add a trigger to this monitor.
9. Inthe Create Trigger view, provide the required details:
a. Trigger name - Specify the name of the trigger.

b. Severity level - Set the severity level from range 1-5. 1 is the highest severity and 5 is the
lowest severity.

c. Trigger condition - Set the trigger condition with the value. The options are IS ABOVE, IS
BELOW, IS EQUAL. For example, IS ABOVE 200.

10. Click Create to save the trigger.

For more information on creating monitors, see "Alerting" in the Open Distro for Elasticsearch 1.4.0
guide.
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Adding Custom Trigger to an Existing Monitor

You can add one or more triggers to an existing monitor and assign severity level.

To add trigger to an existing monitor:

1. Log in to NetWitness Platform.

A
2. Goto (Admin) > Health & Wellness.
3. Click New Health & Wellness.
Click Pivot to Dashboard.

cio

In the Monitor section, click the monitor to which the new trigger need be added.

>

In the Triggers section, select Create.

> N

In the Create Trigger view, provide the required details:
a. Trigger name — specify the name of the trigger.

b. Severity level - Set the severity level from range 1-5. 1 is the highest severity and 5 is the
lowest severity.

c. Trigger condition — Set the trigger condition with the value. The options are IS ABOVE, IS
BELOW, IS EQUAL. For example, IS ABOVE 200.

9. Click Create to save the trigger.
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Managing Dashboards and Alerts

You can modify the dashboards and alerts to monitor details of interest.

Modify a Dashboard

You can modify the dashboard to edit the visualization, delete visualization, customize the panel
title, or change the positions of visualization. You can organize the visualization in the dashboard to
display data of greatest interest on the top.

Note: Any changes to the visualization in a dashboard modifies the visualization content.

To modify a dashboard:

A
1. Goto (Admin) > Health & Wellness.
2. Click New Health & Wellness.
3. Click Pivot to Dashboard.

4. Click Hmmll

5. Select the dashboard you want to modify. For example, Hosts overview.

6. Click Edit and make the necessary changes to the dashboard. For example, you can edit or
delete visualization, customize panel.

7. Click Save.

Delete a Dashboard

Once the dashboard is deleted, you cannot monitor the details specific to the dashboard.

To delete a dashboard:

A
1. Goto (Admin) > Health & Wellness.
2. Click New Health & Wellness.
3. Click Pivot to Dashboard.

4. Click .

5. Select the check box of the dashboard you want to delete and click Delete.

You can delete one or more dashboards at a time.
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Delete a Visualization

To delete a visualization:

L.
2.

A
Go to (Admin) > Health & Wellness.
Click New Health & Wellness.
Click Pivot to Dashboard.

o
il
Click .

In the Visualizations view, select the visualizations you want to delete.
Click Delete visualization.

You can delete one or more visualization at a time.

Modify an Existing Trigger

To modify an existing trigger:

L.
2.
3.

A
Go to (Admin) > Health & Wellness.
Click New Health & Wellness tab.
Click Pivot to Dashboard.

Click “

Select the monitor whose trigger is to be modified.

In the Triggers section, select the trigger you want to modify from list of Triggers and select
Edit.

In the Edit Trigger view, make the necessary changes. You can change the Trigger name,
severity level, Trigger condition.

Click Update to save the changes.
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Managing Notifications

You can manage alert (monitor) notifications based on your requirement.

Modify a Notification

To modify a notification:

1. Log in to NetWitness Platform.

2. Goto (Admin) > Health & Wellness.
3. Click New Health & Wellness.

4. Click View Notifications Settings.

5

6

. Make the necessary changes.
. Click Save.

Modify a Notification Suppression Policy

When you modify a suppression policy, you can change the day or time ranges. If you select multiple
alerts to modify the policy, any changes would overwrite all the existing policies.

To modify suppression policy:
QA
1. Goto (Admin) > Health & Wellness.
. Click New Health & Wellness.

2
3. Select one or multiple rows for which you to modify suppression policy.
4

. Click View Suppression Policy.

Note: If you have selected multiple alerts to modify the suppression policy,

- Only policies that are common are displayed. Policy suppression settings would be empty if
there is no common polices.

- If you edit the common policies, the changes would overwrite all the selected alert policies.

5. Make the necessary changes.
6. Click Save.
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Advanced Configurations

Restore Default Content

This allows you to bring back all the default content such as dashboards, visualizations, monitors to
its original or default state. This overwrites any changes made to the default content. For example, if
you have deleted any dashboard or visualization and want to bring back the default content.

1. Log in to NetWitness Platform UI.

2. Click (Configure) > LIVE CONTENT.

3. Inthe Search Criteria panel, select the Resource Types as:
o Health and Wellness Dashboards

o Health and Wellness Monitors
4. Click Search.

5. In the Matching Resources view, select the checkbox to the left of the resources that you want
to deploy.

In the Matching Resources toolbar, click . 2219y

In the Deployment Wizard > Resources tab, click Next.

In the Services tab, select the Metrics Server service.

o x®» =N

Click Next.

10. Click Deploy.
The Deploy page is displayed. The Progress bar turns green when you have successfully
deployed the resources to the selected services.

11. Click Close.

Enable Services

This is used to enable all the services to start sending metrics for monitoring. For example, if you
have disabled few services from sending metrics for monitoring and want to enable all those
disabled services to start sending again.

1. SSH to the Admin Server.

2. Enter the following command:
nw-shell
The console window is displayed.
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Connect to metrics-server using the following command:

connect --service metrics-server

Enter the login command:

login

Enter the admin username and password.

Navigate to the enable option using the following command:
cd /rsa/metrics/elastic/enable-all

Execute the following command to enable all services:

invoke

Disable Services

This is used to disable all the services to send metrics for monitoring. Once disabled, none of the
services sends alerts to the Elasticsearch and the dashboards are not updated, and alerts will not be
triggered.

1.
2.

SSH to the Admin Server.

Enter the following command:
nw-shell
The console window is displayed.
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3. Connect to metrics-server using the following command:
connect --service metrics-server
4. Enter the login command:
login
5. Enter the admin username and password.
6. Navigate to Elasticsearch using the following command:
cd /rsa/metrics/elastic/disable-all
7. Execute the following command to disable all services to stop writing to Elasticsearch:

invoke

Note: This disables all services to send metrics to Elasticsearch but does not stop metric beat to
send system level metrics to Elasticsearch. You need to manually stop metric beat on all hosts if
you wish to stop using Health and Wellness.

Update an Interval

You can update a common interval for all the services to send data for monitoring. For example, if
all the services are set to different intervals and you want to configure all the services to send data
to elastic search on the same interval.

The interval can be set in seconds, minutes and hours.
1. SSH to the Admin Server.

2. Enter the following command:
nw-shell
The console window is displayed.
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Connect to metrics-server using the following command:

connect --service metrics-server

Enter the login command:

login

Enter the admin username and password.

Navigate to the update-interval directory using the following command:
cd /rsa/metrics/elastic/update-interval

Execute the following command to set a common interval for all the services:
invoke <interval>

For example, invoke 30seconds

Update the Default Configuration

By default, New Health and Wellness configurations are applied after the New Health and Wellness
is enabled successfully. To change the configuration of a service, you need to update the existing
configuration. After the configuration is updated, the service is notified of the changes.

To update the configuration, perform the following:

1.
2.

SSH to the Admin Server.

Enter the following command:
nw-shell
The console window is displayed.
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3. Connect to the metrics-server using the following command:

connect --service metrics-server

4. Enter the login command:
login

5. Enter the admin username and password.

6. To get configuration of a service, execute following commands:

a. cd /rsa/metrics/elastic/get-config

b. invoke <service-id>

Note:
To get the service id for core services:

a
1) Go to (Admin) > Core service.
2) Click > View > Explore.
3) Expand the sys/stats node list.
4) In the UUID filed, copy the value.
To get the service id for launch services:

1) Go to (Admin) > Launch service.
2) Click > View > Explore.
3) Click the process node.
4) In the service-id field, copy the value.
To get the service id for Carlos services:
1) SSH to host in which the Carlos service is deployed.
2) Execute the following command:
For Reporting Engine:
cat /var/netwitness/re-server/rsa/soc/reporting-engine/service-id
For Legacy Web Server:

cat /var/netwitness/uax/service-id
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Note: The core services are Archiver, Broker, Concentrator, Decoder, Log Decoder and;
Carlos services are Reporting Engine, Legacy Web Server. All the other services that are not
included in Core and Carlos services are part of launch services.

Copy the configuration and save it in a file.
a. Copy the configuration from step 6 and exit from nw-shel1 using command:
exit
b. Create a file under /root in admin server, copy the configurations to the file and save it.

For example, For the Reporting Engine service, create a file reporting-engine.json under
/root/ and copy the configurations obtained from step 6 and save.

To set configurations for a service:
a. cd /rsa/metrics/elastic/set-config
b. invoke --file <absolute path of the path>

For example, invoke —--file /root/reporting-engine.json

Configure the Data Retention Policy

You can configure the retention policy for monitors (alerts triggered) and metrics based on age and
size.

By default, 90 days of data with 100 GB of size for monitors (alerts triggered ) and 30 days of data
with 100 GB of size for metrics are retained.

To change the configure for monitor (alerts triggered) retention:

1.
2.

SSH to the Admin Server.

Enter the following command:
nw-shell
The console window is displayed.
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10.

Connect to metrics-server using the following command:

connect --service metrics-server

Enter the login command:

login

Enter the admin username and password.

Go to alert-retention-threshold using command:

cd /rsa/metrics/elastic/data/retention/alert-retention-threshold
Set the value between lday to 90days using command:

set <number of days>

For example, set 50days

Exit from nw-shell using the command:

exit

SSH to the host on which New Health and Wellness is installed.

Restart the metrics server on which New Health and Wellness is installed using the command:

service rsa-nw-metrics-server restart

To change the configuration for metrics time threshold:

1.
2.

3.

4.

SSH to the Admin Server.

Enter the following command:
nw-shell
The console window is displayed.

Connect to metrics-server using the following command:

connect --service metrics-server

Enter the login command:
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10.

To

login

Enter the admin username and password.

Go to time-threshold using command:

cd /rsa/metrics/elastic/data/retention/time-threshold
Set the value from 1day to 90days using command:

set <number of days>

For example, set 40days

Exit from nw-shell using the command:

exit

SSH to the host on which New Health and Wellness is installed.

Restart the metrics server on which the New Health and Wellness is installed using the
command:

service rsa-nw-metrics-server restart

change the size configuration:
SSH to the Admin Server.

Enter the following command:
nw-shell
The console window is displayed.

Connect to metrics-server using the following command:

connect --service metrics-server

Enter the login command:
login

Enter the admin username and password.
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10.

Go to allocated-size using command:

cd /rsa/metrics/elastic/data/retention/allocated-size
Set the value using command:

set <size to be allocated>

For example, set 200GB

Exit from nw-shell using the command:

exit

SSH to the host on which New Health and Wellness is installed.

Restart the metrics server on which the New Health and Wellness is installed using the
command:

service rsa-nw-metrics-server restart

Note: Make sure the /var/netwitness partition on standalone New Health and Wellness has
enough disk space. After you review your datastore configuration, you may determine that you
need to add a new volume. For more information on adding a new volume, see “Add New Volume
and Extend Existing File Systems” topic in the Virtual Host Installation Guide.
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Backup and Restore New Health and Wellness

Perform the following steps in the order given:

1. Back up the Admin Server. For more information on the instructions, see "Disaster Recovery
(Back Up and Restore)" topic in Recovery Tool User Guide.

2. At the root level, type the following command on the host on which New Health and Wellness is
installed :

nw-recovery-tool --export --dump-dir /var/netwitness/backup --category
Search

Note: Make sure that the Admin Server is restored, up and running successfully.

3. Restore the New Health and Wellness using the following command:

nw-recovery-tool —--import --dump-dir /var/netwitness/backup --category
Search

Note: Restore the search category (New Health and Wellness) on the same host on which
New Health and Wellness is installed.

4. Reboot the Host on which search category (New Health and Wellness) is restored.
5. Restore the default content using RSA Live:
a. Log in to NetWitness Platform UlI.

b. Click (Configure) > LIVE CONTENT.

c. Inthe Search Criteria panel, select the Resource Types as:
o Health and Wellness Dashboards
o Health and Wellness Monitors

d. Click Search.

e. Inthe Matching Resources view, select the checkbox to the left of the resources that you
want to deploy.
In the Matching Resources toolbar, click <% P&RI9y

In the Deployment Wizard > Resources tab, click Next.

5 @ o

In the Services tab, select the Metrics Server service.

Click Next.

—

j. Click Deploy.
The Deploy page is displayed. The Progress bar turns green when you have successfully
deployed the resources to the selected services.

k. Click Close.
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Troubleshooting New Health and Wellness

This topic describes how to troubleshoot New Health and Wellness issues.

An error ‘n of m shards failed’ or ‘unknown field in the index’ in the New Health and
Wellness dashboards.

Refresh the index patterns, perform the following:

1. Log in to NetWitness Platform.

Go to (Admin) > Health & Wellness.
Click New Health & Wellness.

Click Pivot to Dashboard.

Go to Management > Index Patterns.

Click nw* index pattern.

NS kLD

Click Refresh to refresh the index pattern on top right corner.

Note: If the issue still persists, refresh other index patterns such as nw-
metricbeat* or nw-concentrator* and so on.

Unable to send data to elastic search once disk usage reaches 85%.

If the Elasticsearch disk usage reaches 85%,

the saved objects (index patterns, dashboards, visualizations etc) becomes read-only
mode.

And, services does not write new metrics to Elasticsearch or allow to edit any saved
objects.

To change the indexes to write mode, execute the following command on the host in
which Elasticsearch is installed:

curl -k --cert /etc/pki/nw/elastic/elasticsearch-cert.pem --
key /etc/pki/nw/elastic/elasticsearch-key.pem -X PUT -H
"Content-Type: application/json" -d '{"index.blocks.read only
allow delete": null }' https://localhost:9200/ all/ settings

Note: This command is supported only with certificates.

New Health and Wellness > Pivot to Dashboard fails due to time
synchronization issue.

Pivot to dashboard fails if there is no time synchronization between the
NetWitness Server and the host on which New Health and Wellness is
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installed.

You must synchronize the time and pivot to dashboard. To synchronize the
time do one of the following:

o Configure the NTP Server. For more information, see "Configure NTP
Servers" in the System Configuration Guide.

« Run the following commands on the host on which New Health and
Wellness is installed

1. SSH to NetWitness host.
2. Run the following commands.
o systemctl stop ntpd

°© ntpdate nw-node-zero

o systemctl start ntpd

NW Host High Swap Utilization monitor generates many false alerts.

By default, the set threshold is > 50 %, which might generate many false
alerts on NW Host High Swap Utilization monitor for Linux hosts, which
is considered normal.

Note: On upgrade to 11.5.3.0 version or later, the monitor will be
automatically deleted on the New Health & Wellness monitors view.

On version 11.5.2.0 or lower, you can perform the following steps to
delete the monitor:

1. Log in to the NetWitness Platform.

A
2. Goto (Admin) > Health & Wellness.
3. Click New Health & Wellness.

4. Click Pivot to Dashboard.
The Deployment Health Overview dashboard is displayed.

5. Click to display the available alerts in the alerts Dashboard

view.

6. Click the Monitor tab to view all the available monitors.

7. Select the NW Host High Swap Utilization monitor and click

> Delete.

The monitor is deleted.
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Appendices

This section is a collection of appendices for new health and wellness:

o New Health and Wellness Dashboards

¢ New Health and Wellness Monitors

o Uninstall New Health and Wellness
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New Health and Wellness Dashboards

This topic provides the list of default New Health and Wellness dashboards and associated
visualizations and metrics.

Deployment Health Overview Dashboard

This dashboard provides the overall health of the NetWitness Platform hosts and services. The
following table provides the information on default visualizations available on this dashboard.

service.

Note: The parameters and metrics listed below are the default values. You can customize the
parameters and metrics of any visualization based on your requirement. For example, you can
customize a visualization to view the CPU utilization for all the core services or any particular

Visualization

Parameters
and

Metrics

Objective

Description

Alarms
Summary

Offline
Services

Stopped
Archiver
Aggregation

Stopped Broker
Aggregation

e Count of
active alert

* Alert
severity

* Service
name

* Status Time

* Refresh time
15 minutes

* Count of
archivers
where
aggregation is
stopped

» Refresh time
15 minutes

* Count of
Brokers
where
aggregation is
stopped

* Refresh time
15 minutes

Provides the summary of active
health alarms based on the
severity.

Identifies the list of unavailable

services.

Identifies the number of Archivers
where aggregation is stopped.

Identifies the number of Brokers
where aggregation is stopped.

Displays the active
alarms grouped by
severity (Critical, High,
Medium, Low).

Displays the list of offline
services.

Displays the number of
Archivers where
aggregation is stopped.
For more information, see
Notifications.

Displays the number of
Brokers where
aggregation is stopped.
For more information, see
Notifications.
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Visualization

Parameters
and

Metrics

Objective

Description

Stopped
Concentrator
Aggregation

Stopped
Decoder/Log
Decoder
Capture

Total vs Offline
Services

Stopped State
Aggregation &
Capture

NetWitness
Services
Version Status

NetWitness
Services —
Uptime
Summary

* Count of
Concentrators
where
aggregation is
stopped

* Refresh time
15 minutes

* Count of
Decoders or
Log Decoders
where capture
is stopped

* Refresh time
15 minutes

» Total
number of
services

* Count of
offline
services

* Refresh time
15 minutes

* Services
name

e Host name

* Service
version

* Service
version

* Service
name

e Host name

* Running
since

Identifies the number of
Concentrators where aggregation
is stopped.

Identifies the number of Decoders
or Log Decoders where capture is
stopped.

Identifies the number of offline
services versus total number of
services.

Provides the list of services where
aggregation and capture are
stopped.

Provides the status of NetWitness
Platform service versions.

Provides an overview on the
uptime of the services in the
deployment.

Displays the number of
Concentrators where
aggregation is stopped.
For more information, see
Notifications.

Displays the number of
Decoder or Log Decoder
where capture is stopped.
For more information, see
Notifications.

Displays the total number
of services and the
number of services that
are offline.

Displays the list of
services where
aggregation and capture
are stopped.

Displays the status of
NetWitness Platform
service versions.

Displays the list of
services and their uptime.

Monitor NetWitness Platform Health

91



System Maintenance Guide

Visualization

Parameters
and

Metrics

Objective

Description

Memory
Utilization
Trend

Current CPU
Usage

Current Disk
Usage

Capture Rate
for Log
Decoders

Capture Rate
for Network
Decoders

Session
Aggregation
Rate and Trend
for
Concentrators

Retention
Summary

* Service
name

* Memory
usage
* Services
name

* CPU usage

 Services
name

* Disk usage

* Service
name

* Capture rate

* Service
name

* Capture rate

* Service
name

* Session
aggregation
rate

* Service id

* Service
name

* Running on
host

* Oldest meta
file time

e Oldest
packet file
time

e Oldest
session file
time

Provides the memory utilization
trend to detect any high utilizations
and take necessary action.

Provides the CPU usage trend of
the hosts to identify any high
utilizations and take necessary
action.

Provides the disk utilization in the
real time to identify any high
utilizations and take necessary
action.

Provides the capture rate trend to
identify any high values and take
necessary action.

Provides the capture rate trend to
identify any high values and take
necessary action.

Provides an overview on the
session rate of the Concentrators
to identify any high values and
take necessary action.

Provides a quick view on the
current retention of the Decoders,
Concentrators and Archivers to
check if the retention is lower than
the configured retention.

Displays the memory
utilization trend of the
hosts.

Displays the current CPU
usage of the services.

Displays the current disk
usage of the hosts.

Displays the trend of Log
Decoders capture rate.

Displays the trend of
Network Decoders
capture rate.

Displays the session
aggregation rate and trend
of Concentrator.

Displays the oldest date
for meta, session, packet
present in decoders,
logdecoders and
concentrators
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Objective

Description

Parameters
Visualization | and
Metrics
Total CPU * CPU usage
Usage Trend o Yeroios
for Services ST
Total Memory < Service
Usage name
Sumrpary for « Memory
ervices usage
Hosts Dashboard

Provides the CPU usage trend of
the services to detect the high
utilization and take necessary
action.

Displays the top 20
services where CPU
usage is high.

Provides the memory usage
summary of NetWitness Platform
services to detect any high usage
and take necessary actions.

Displays the top services
that are utilizing the
resident memories.

This dashboard provides the resource utilization and health of NetWitness hosts in your deployment.
The following table provides information on default Visualizations available on this dashboard.

Disk Used * Disk
usage
Current Memory * Current
Usage vs Total memory
Available usage
* Total
available
memory
Current Disk Usage * Current
vs Total Available  disk usage
Disk * Total
available
disk
Disk Usage by * Disk
Partitions partition
* Disk
usage

Provides the current disk usage of
the hosts to detect the high
utilization and take immediate
action.

Displays the current
disk usage of the host.

Displays the current
memory usage and
total available memory
of the host.

Provides the current memory usage
versus total available memory to
identify high usage and take
necessary action.

Provides the current disk usage
versus total available disk to identify
high usage and take necessary
action.

Displays the current
disk usage versus total
available disk.

Provides the disk usage by different
partitions to identify high usage and
take necessary action.

List of partitions and
associated disk
percentage.
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Resident Memory
Usage by Services

Memory Usage

CPU Usage

CPU Usage by
Services

Interfaces by
Incoming Traffic

Interfaces by
Outgoing Traffic

Services by Open
File Descriptors

TOP APPLIANCES
BY DISK IO
READ (Line) Vs
WRITE (Bar)

Total Inbound
Traffic for All
Interfaces

* Service
name

* Resident
memory
usage

Memory
usage

CPU usage

* Service
name

* CPU
usage

Incoming
traffic on
interfaces

Outgoing
traffic on
interfaces

 Services

* Open file
descriptor

* Service
name

* Disk IO
Read

* Disk IO
Write

e Count of
inbound
traffic on
Interfaces

* Total
transferred
traffic

Provides the resident memory usage
per service to identify high usage
and take necessary action.

Provides the current memory usage
percentage of the hosts to identify
high memory usage and take
necessary action.

Provides the CPU usage percentage
to identify high usage and take
necessary action.

Provides the CPU Percentage per
service to detect high usage and take
necessary action.

Provides the trend on interfaces
incoming traffic to detect any
deviation on time.

Provides the trend on interfaces
outgoing traffic to detect any
deviation on time.

Provides the list of open file
descriptor associate with a service.

Provides the list of top appliances by
disk IO read and write to detect any
high usage and take necessary
action.

Provides the total inbound traffic to
detect any deviation on time.

Displays the resident
memory usage of the
service.

Displays the memory
usage of the host.

Displays the CPU
usage of the host.

Displays the CPU
usage of the service.

Display the incoming
traffic interfaces.

Display the interfaces
outgoing traffic.

Displays the list of
open file descriptor
associated with a
service.

Displays top
appliances based on
disk IO read and write
usage.

Displays the current
inbound traffic and
total transferred
traffic.
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Total Outbound * Count of  Provides the total outbound traffic to Display the current
Traffic for All outbound  detect any deviation on time. outbound traffic and
Interfaces traffic on total transferred
Interfaces traffic.
* Total
transferred
traffic
Logs Dashboard

This dashboard provides information on various NetWitness Platform logs. The following table
provides information on default Visualizations available on this dashboard.

Log Decoders * Service name Provides the  Displays the
by Capture Rate Capture Rate capture rate  Log Decoders
of Log by capture
Decoders to  rate.
detect high
capture rate
on time and
take
necessary
action.

Log Decoders ¢ Service name Provides the  Displays the
by Capture « Capture Packet Rate capture Log Decoders
Packet Rate packet rate by capture

of Log packet rate.

Decoder to

detect high

capture

packet rate

on time and

take

necessary

action.

Log Decoders ¢ Service name Identifies the Display the
by CPU « CPU usage Log Log Decoders
Percentage Decoders by by CPU

CPU usage usage..

to detect high

usage and

take

necessary

action.
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Log Decoders ~ * Service name Identifies the Display Log
by Resident « Resident Memory Usage Log decpder by
Memory Usage Decoders by resident
resident memory
memory usage.
usage to
detect high
usage and
take
necessary
action.
SDK Active * Service name Identifies the Display
Queries on « Count of active queries concentrators concentrators
Concentrators by SDK by SDK active
active queries.
queries.
Concentrators ~ * Service running on host Provides the  Display the
Status « Service type concentrator  list of
) ) status. concentrators
» Aggregation status
* Average session rate
* Max session rate
* Active queries
Concentrator * Service name Provides the  Displays
Session . S RS trend of Congentrator
Aggregation Concentrator session
Rate [Trend] session aggregation
aggregation  rate.
rates to
detect high
session rates
and take
necessary
action.
SDK Active * Service name Identifies the Lists Brokers
Queries on « Count of Active Queries Brokers l?y by SDK active
Brokers SDK active  queries.
queries.
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Brokers Status  ® Service running on host Provides the ~ Displays the
» Service type Broker list of Brokers
. . status. and their
* Service version status.
» Aggregation status

» Average session rate
» Max session rate

* Active queries

Packet Overview Dashboard

This dashboard provides information on NetWitness Platform network data. The following table
provides information on default Visualizations available on this dashboard.

Network
Decoders by
Capture Rate

Network
Decoders by
Capture Drop

Network
Decoders by
CPU
Percentage

* Service name

* Capture rate

» Service name

* Capture drop percentage

 Service name
* CPU usage

Identifies the
capture rate
of Network
Decoder to
detect high
value and
take
necessary
action.

Identifies the
capture drop
rate of
Network
Decoders to
detect drop
rate and take
necessary
action.

Identifies the
Network
Decoders by
CPU usage
to detect high
usage and
take
necessary
action.

Displays
Network
Decoders by
capture rate.

Displays
Network
Decoders by
capture drop.

Displays
Network
Decoder by
CPU used.
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Network
Decoders by
Resident

Memory Usage

SDK Active
Queries on

Concentrators

Concentrators

Status

Concentrator
Session

Aggregation
Rate [Trend]

SDK Active
Queries on
Brokers

» Service name

* Resident memory usage

 Service name

* Count of active queries

* Service running on host
* Service type

* Service version

» Aggregation status

» Average session rate

* Max session rate

* Active queries

» Service name

» Session rate

 Service name

* Count of active queries

Identifies the
Network
Decoders by
resident
memory
usage to
detect high
usage and
take
necessary
action.

Identifies the
concentrators
by SDK
active
queries.

Provides the
Concentrator
status.

Provides the
trend of
Concentrator
session
aggregation
rate to detect
high value
and take
necessary
action.

Identifies the
Brokers by
SDK active
queries.

Displays
Network
Decoder by
resident
memory
usage.

Displays
Concentrators
by SDK active
queries.

Displays the
list of
Concentrators
and their
status.

Displays the
trend of
concentrator
session
aggregation
rate.

Display the
Broker by
SDK active
queries.
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Brokers Status

Analysis Dashboard

* Service running on host
* Service type

* Service version

» Aggregation status

» Average session rate

* Max session rate

* Active queries

Provides the
Broker
status.

Displays the
list of brokers
and its status.

This dashboard provides details about Reporting Engines on Primary UI or Analyst UI. The
following table provides the information on default Visualizations available on this dashboard.

Reporting
Engine Rule

Query
Executions

Reporting
Engine Reports
Executions

Reporting
Engine Alerts
Execution

* Hostname

* Failed rule executions

* Cancelled rule execution
* Active rule execution

* Total rule execution

* Hostname

* Failed in last hour

* Running more than one hour
* Cancelled in last hour

* Output actions failed in last hour

* Enabled alerts

* Execution failed

* Execution skipped in las 10 minutes
* Running alerts

* Output actions failed in last 10 minutes

Provides the
status of the
queries
executed by
Reporting
Engine to
detect any
deviations on
time.

Provides the
status of the
reports
executed by
Reporting
Engine to
detect any
deviations on
time.

Provides the
status of the
alerts
generated by
Reporting
Engine to
detect any
deviations on
time.

Displays the
queries
executed by
Reporting
Engine.

Displays the
Reporting
Engine
reports.

Displays the
Reporting
Engine alerts.
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Reporting * Hostname Provides the  Displays
Engine Charts  , ghabled charts status of the ~ Reporting

Executions ) ) charts Engine charts.
* Execution failed executed by

« Execution cancelled in last 10 minutes Reporting
Engine to
detect
deviations on
time.

Reporting * Disk Used Provides the ~ Displays the
{Ejngme Disk « Total disk space ?gsk ﬁ?ge by ?:Sk I;igd by
sage eporting eporting
Engine to Engine.

detect any
deviations
high usage
and take
necessary
action.

Unassigned Count of unassigned open incidents Identifies Displays the
Open Incidents unassigned unassigned
incidents to  incidents.
assist
Administrator
to take
necessary
action.

Incidents Sent ~ Count of incidents sent to archer Provides Displays the
to Archer statistics on incidents sent

the incidents  Archers.

sent to

Archer to

assist

Administrator

to take

necessary

action.

Endpoint Dashboard

This dashboard provides information on NetWitness Endpoints and agents installed on Endpoints.
The following table provides information on default Visualizations available on this dashboard.
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Endpoint Server
to Agent
Communication
Queued

Endpoint Server
to Agent

Communication
Rejected Count

Endpoint Agent
Overview

Relay Servers
Overview

e Service name

* Count of
queued request
to Agent

» Service name

* Count of
rejected request
to agent

¢ Hostname

« Total active
agents

* Active
advanced

* Active insights
agents

* Active
advanced
windows agents

e Active
advanced linux
agents

e Active
advanced mac
agents

¢ Hosts

* Total relay
servers

» Agents
communicated
via relay server

» Agents
communicated
in last two days
via relay server

Provides an overview of the queued agent Displays the

communication to the Endpoint Server to
identify any issues around the queued
communication.

Provides an overview of rejected agent
communication to the Endpoint Server to
identify any issues related to the rejected
count.

Provides an overview of Endpoint
Agents.

Provides an overview of the Relay
Servers.

queued request
to agent.

Displays the
rejected request
to agent.

Displays list of
agents and its
details.

Displays the
Relay server
details.
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Files Count by
File Status

Files Count by
Certificate
Status

File Count by
Reputation
Status

Endpoint Hosts
with Risk Score
Greater than 90

e Count of
blacklisted files

* Count of
graylisted files

* Count of
netural file

* Count of
whitelisted files

e Count of
blacklisted
certificates

* Count of gray
listed
certificates

e Count of
neutral
certificates

* Count of
whitelisted
certificates

e Count of
unknown status

* Count of
suspicious
status

e Count of
malicious status

¢ Count of
known good
status

* Count of
known status

* Count of
invalid status

Count of hosts
with risk score
greater than 90

Provides an overview of file status by
count to assist an Administrator on the
overall statistics of Endpoint actions on
files.

Provides an overview on certificate status
to assist an Administrator to take
necessary action.

Provides an overview on the reputation
status to assist an Administrator to take
necessary action.

Identifies the number of hosts with risk
score higher than 90 for immediate
attention.

Displays the file
count of file
statuses.

Displays the
count of
certificate
statuses.

Displays the
count of files
reputation status.

Displays the
count of hosts
with risk score
greater than 90.
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Identifies the number of files with risk
score higher than 90 for immediate
attention.

Endpoint Files Count of files
with Risk Score  with risk score
Greater than 90  greater than 90

Displays the
count of files
with risk score

ESA Correlation Overview Dashboard

greater than 90.

This dashboard provides health statistics and trends on the ESA deployment. The following table
provides the information on default Visualizations available on this dashboard.

You can choose the ESA host and Deployment name for the Dashboard view source using the filter.

Sessions Behind Count of

Provides the session behind trend for

Displays the count of

by Sources sessions the sources to take necessary actions  sessions behind by
behind by when the session behind goes higher.  sources.
sources.
Sessions Rate Count of Provides the session rate trend for the Displays the count of
by Sources sessions rate sources to take necessary actions sessions rate by
by sources. when the session rate goes higher. sources.
Top Rules by Memory used  Provides the memory usage per rule Displays the top rules
Memory by rules. to identify the rule with high memory  based on memory
usage and take necessary action. usage.

Top Rules by CPU used by  Provides the CPU usage per rule to Displays the top rules
CPU rules. identify the rule with high CPU usage based on CPU usage.
and take necessary action.

ESA Resident Provides resident memory usage trend Displays the trend of

Correlation memory usage. to be able to detect high usage and ESA correlation

Resident take necessary action. resident memory

Memory Usage usage.

ESA CPU usage. Provides CPU usage trend to detect Displays the trend of

Correlation high usage and take necessary action. ESA correlation CPU

CPU Usage usage.

ESA CR - Event rate of  Identify the event rate by each Displays the trend of

Event Rate by  each ESA deployment under ESA Correlation to ESA correlation event

Deployments correlation detect high usage and take necessary rate of each
deployment. action. deployment.
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New Health and Wellness Dashboards

This topic provides the list of default New Health and Wellness dashboards and associated
visualizations and metrics.

Deployment Health Overview Dashboard

This dashboard provides the overall health of the NetWitness Platform hosts and services. The
following table provides the information on default visualizations available on this dashboard.

service.

Note: The parameters and metrics listed below are the default values. You can customize the
parameters and metrics of any visualization based on your requirement. For example, you can
customize a visualization to view the CPU utilization for all the core services or any particular

Visualization

Parameters
and

Metrics

Objective

Description

Alarms
Summary

Offline
Services

Stopped
Archiver
Aggregation

Stopped Broker
Aggregation

e Count of
active alert

* Alert
severity

* Service
name

* Status Time

* Refresh time
15 minutes

* Count of
archivers
where
aggregation is
stopped

» Refresh time
15 minutes

* Count of
Brokers
where
aggregation is
stopped

* Refresh time
15 minutes

Provides the summary of active
health alarms based on the
severity.

Identifies the list of unavailable

services.

Identifies the number of Archivers
where aggregation is stopped.

Identifies the number of Brokers
where aggregation is stopped.

Displays the active
alarms grouped by
severity (Critical, High,
Medium, Low).

Displays the list of offline
services.

Displays the number of
Archivers where
aggregation is stopped.
For more information, see
Notifications.

Displays the number of
Brokers where
aggregation is stopped.
For more information, see
Notifications.
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Visualization

Parameters
and

Metrics

Objective

Description

Stopped
Concentrator
Aggregation

Stopped
Decoder/Log
Decoder
Capture

Total vs Offline
Services

Stopped State
Aggregation &
Capture

NetWitness
Services
Version Status

NetWitness
Services —
Uptime
Summary

* Count of
Concentrators
where
aggregation is
stopped

* Refresh time
15 minutes

* Count of
Decoders or
Log Decoders
where capture
is stopped

* Refresh time
15 minutes

» Total
number of
services

* Count of
offline
services

* Refresh time
15 minutes

* Services
name

e Host name

* Service
version

* Service
version

* Service
name

e Host name

* Running
since

Identifies the number of
Concentrators where aggregation
is stopped.

Identifies the number of Decoders
or Log Decoders where capture is
stopped.

Identifies the number of offline
services versus total number of
services.

Provides the list of services where
aggregation and capture are
stopped.

Provides the status of NetWitness
Platform service versions.

Provides an overview on the
uptime of the services in the
deployment.

Displays the number of
Concentrators where
aggregation is stopped.
For more information, see
Notifications.

Displays the number of
Decoder or Log Decoder
where capture is stopped.
For more information, see
Notifications.

Displays the total number
of services and the
number of services that
are offline.

Displays the list of
services where
aggregation and capture
are stopped.

Displays the status of
NetWitness Platform
service versions.

Displays the list of
services and their uptime.
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Visualization

Parameters
and

Metrics

Objective

Description

Memory
Utilization
Trend

Current CPU
Usage

Current Disk
Usage

Capture Rate
for Log
Decoders

Capture Rate
for Network
Decoders

Session
Aggregation
Rate and Trend
for
Concentrators

Retention
Summary

* Service
name

* Memory
usage
* Services
name

* CPU usage

 Services
name

* Disk usage

* Service
name

* Capture rate

* Service
name

* Capture rate

* Service
name

* Session
aggregation
rate

* Service id

* Service
name

* Running on
host

* Oldest meta
file time

e Oldest
packet file
time

e Oldest
session file
time

Provides the memory utilization
trend to detect any high utilizations
and take necessary action.

Provides the CPU usage trend of
the hosts to identify any high
utilizations and take necessary
action.

Provides the disk utilization in the
real time to identify any high
utilizations and take necessary
action.

Provides the capture rate trend to
identify any high values and take
necessary action.

Provides the capture rate trend to
identify any high values and take
necessary action.

Provides an overview on the
session rate of the Concentrators
to identify any high values and
take necessary action.

Provides a quick view on the
current retention of the Decoders,
Concentrators and Archivers to
check if the retention is lower than
the configured retention.

Displays the memory
utilization trend of the
hosts.

Displays the current CPU
usage of the services.

Displays the current disk
usage of the hosts.

Displays the trend of Log
Decoders capture rate.

Displays the trend of
Network Decoders
capture rate.

Displays the session
aggregation rate and trend
of Concentrator.

Displays the oldest date
for meta, session, packet
present in decoders,
logdecoders and
concentrators
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Objective

Description

Parameters
Visualization | and
Metrics
Total CPU * CPU usage
Usage Trend o Yeroios
for Services ST
Total Memory < Service
Usage name
Sumrpary for « Memory
ervices usage
Hosts Dashboard

Provides the CPU usage trend of
the services to detect the high
utilization and take necessary
action.

Displays the top 20
services where CPU
usage is high.

Provides the memory usage
summary of NetWitness Platform
services to detect any high usage
and take necessary actions.

Displays the top services
that are utilizing the
resident memories.

This dashboard provides the resource utilization and health of NetWitness hosts in your deployment.
The following table provides information on default Visualizations available on this dashboard.

Disk Used * Disk
usage
Current Memory * Current
Usage vs Total memory
Available usage
* Total
available
memory
Current Disk Usage * Current
vs Total Available  disk usage
Disk * Total
available
disk
Disk Usage by * Disk
Partitions partition
* Disk
usage

Provides the current disk usage of
the hosts to detect the high
utilization and take immediate
action.

Displays the current
disk usage of the host.

Displays the current
memory usage and
total available memory
of the host.

Provides the current memory usage
versus total available memory to
identify high usage and take
necessary action.

Provides the current disk usage
versus total available disk to identify
high usage and take necessary
action.

Displays the current
disk usage versus total
available disk.

Provides the disk usage by different
partitions to identify high usage and
take necessary action.

List of partitions and
associated disk
percentage.
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Resident Memory
Usage by Services

Memory Usage

CPU Usage

CPU Usage by
Services

Interfaces by
Incoming Traffic

Interfaces by
Outgoing Traffic

Services by Open
File Descriptors

TOP APPLIANCES
BY DISK IO
READ (Line) Vs
WRITE (Bar)

Total Inbound
Traffic for All
Interfaces

* Service
name

* Resident
memory
usage

Memory
usage

CPU usage

* Service
name

* CPU
usage

Incoming
traffic on
interfaces

Outgoing
traffic on
interfaces

 Services

* Open file
descriptor

* Service
name

* Disk IO
Read

* Disk IO
Write

e Count of
inbound
traffic on
Interfaces

* Total
transferred
traffic

Provides the resident memory usage
per service to identify high usage
and take necessary action.

Provides the current memory usage
percentage of the hosts to identify
high memory usage and take
necessary action.

Provides the CPU usage percentage
to identify high usage and take
necessary action.

Provides the CPU Percentage per
service to detect high usage and take
necessary action.

Provides the trend on interfaces
incoming traffic to detect any
deviation on time.

Provides the trend on interfaces
outgoing traffic to detect any
deviation on time.

Provides the list of open file
descriptor associate with a service.

Provides the list of top appliances by
disk IO read and write to detect any
high usage and take necessary
action.

Provides the total inbound traffic to
detect any deviation on time.

Displays the resident
memory usage of the
service.

Displays the memory
usage of the host.

Displays the CPU
usage of the host.

Displays the CPU
usage of the service.

Display the incoming
traffic interfaces.

Display the interfaces
outgoing traffic.

Displays the list of
open file descriptor
associated with a
service.

Displays top
appliances based on
disk IO read and write
usage.

Displays the current
inbound traffic and
total transferred
traffic.
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Total Outbound * Count of  Provides the total outbound traffic to Display the current
Traffic for All outbound  detect any deviation on time. outbound traffic and
Interfaces traffic on total transferred
Interfaces traffic.
* Total
transferred
traffic
Logs Dashboard

This dashboard provides information on various NetWitness Platform logs. The following table
provides information on default Visualizations available on this dashboard.

Log Decoders * Service name Provides the  Displays the
by Capture Rate Capture Rate capture rate  Log Decoders
of Log by capture
Decoders to  rate.
detect high
capture rate
on time and
take
necessary
action.

Log Decoders ¢ Service name Provides the  Displays the
by Capture « Capture Packet Rate capture Log Decoders
Packet Rate packet rate by capture

of Log packet rate.

Decoder to

detect high

capture

packet rate

on time and

take

necessary

action.

Log Decoders ¢ Service name Identifies the Display the
by CPU « CPU usage Log Log Decoders
Percentage Decoders by by CPU

CPU usage usage..

to detect high

usage and

take

necessary

action.
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Log Decoders ~ * Service name Identifies the Display Log
by Resident « Resident Memory Usage Log decpder by
Memory Usage Decoders by resident
resident memory
memory usage.
usage to
detect high
usage and
take
necessary
action.
SDK Active * Service name Identifies the Display
Queries on « Count of active queries concentrators concentrators
Concentrators by SDK by SDK active
active queries.
queries.
Concentrators ~ * Service running on host Provides the  Display the
Status « Service type concentrator  list of
) ) status. concentrators
» Aggregation status
* Average session rate
* Max session rate
* Active queries
Concentrator * Service name Provides the  Displays
Session . S RS trend of Congentrator
Aggregation Concentrator session
Rate [Trend] session aggregation
aggregation  rate.
rates to
detect high
session rates
and take
necessary
action.
SDK Active * Service name Identifies the Lists Brokers
Queries on « Count of Active Queries Brokers l?y by SDK active
Brokers SDK active  queries.
queries.
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Brokers Status  ® Service running on host Provides the ~ Displays the
» Service type Broker list of Brokers
. . status. and their
* Service version status.
» Aggregation status

» Average session rate
» Max session rate

* Active queries

Packet Overview Dashboard

This dashboard provides information on NetWitness Platform network data. The following table
provides information on default Visualizations available on this dashboard.

Network
Decoders by
Capture Rate

Network
Decoders by
Capture Drop

Network
Decoders by
CPU
Percentage

* Service name

* Capture rate

» Service name

* Capture drop percentage

 Service name
* CPU usage

Identifies the
capture rate
of Network
Decoder to
detect high
value and
take
necessary
action.

Identifies the
capture drop
rate of
Network
Decoders to
detect drop
rate and take
necessary
action.

Identifies the
Network
Decoders by
CPU usage
to detect high
usage and
take
necessary
action.

Displays
Network
Decoders by
capture rate.

Displays
Network
Decoders by
capture drop.

Displays
Network
Decoder by
CPU used.
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Network * Service name Identifies the Displays
Decoders by Resi Network Network
: * Resident memory usage
Resident R Decoders by Decoder by
Memory Usage resident resident
memory memory
usage to usage.
detect high
usage and
take
necessary
action.
SDK Active * Service name Identifies the Displays
Queries on « Count of active queries concentrators Concentratqrs
Concentrators by SDK by SDK active
active queries.
queries.
Concentrators ~ * Service running on host Provides the  Displays the
Status « Service type Concentrator list of
) ) status. Concentrators
* Service version and their
* Aggregation status status.
* Average session rate
* Max session rate
* Active queries
Concentrator * Service name Provides the  Displays the
Session . S RS trend of trend of
Aggregation Concentrator concentrator
Rate [Trend] session session
aggregation  aggregation
rate to detect rate.
high value
and take
necessary
action.
SDK Active * Service name Identifies the Display the
Queries on « Count of active queries Brokers l?y Broker by
Brokers SDK active  SDK active
queries. queries.
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Brokers Status

Analysis Dashboard

* Service running on host
* Service type

* Service version

» Aggregation status

» Average session rate

* Max session rate

* Active queries

Provides the
Broker
status.

Displays the
list of brokers
and its status.

This dashboard provides details about Reporting Engines on Primary UI or Analyst UI. The
following table provides the information on default Visualizations available on this dashboard.

Reporting
Engine Rule

Query
Executions

Reporting
Engine Reports
Executions

Reporting
Engine Alerts
Execution

* Hostname

* Failed rule executions

* Cancelled rule execution
* Active rule execution

* Total rule execution

* Hostname

* Failed in last hour

* Running more than one hour
* Cancelled in last hour

* Output actions failed in last hour

* Enabled alerts

* Execution failed

* Execution skipped in las 10 minutes
* Running alerts

* Output actions failed in last 10 minutes

Provides the
status of the
queries
executed by
Reporting
Engine to
detect any
deviations on
time.

Provides the
status of the
reports
executed by
Reporting
Engine to
detect any
deviations on
time.

Provides the
status of the
alerts
generated by
Reporting
Engine to
detect any
deviations on
time.

Displays the
queries
executed by
Reporting
Engine.

Displays the
Reporting
Engine
reports.

Displays the
Reporting
Engine alerts.
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Reporting * Hostname Provides the  Displays
Engine Charts  , ghabled charts status of the ~ Reporting

Executions ) ) charts Engine charts.
* Execution failed executed by

« Execution cancelled in last 10 minutes Reporting
Engine to
detect
deviations on
time.

Reporting * Disk Used Provides the ~ Displays the
{Ejngme Disk « Total disk space ?gsk ﬁ?ge by ?:Sk I;igd by
sage eporting eporting
Engine to Engine.

detect any
deviations
high usage
and take
necessary
action.

Unassigned Count of unassigned open incidents Identifies Displays the
Open Incidents unassigned unassigned
incidents to  incidents.
assist
Administrator
to take
necessary
action.

Incidents Sent ~ Count of incidents sent to archer Provides Displays the
to Archer statistics on incidents sent

the incidents  Archers.

sent to

Archer to

assist

Administrator

to take

necessary

action.

Endpoint Dashboard

This dashboard provides information on NetWitness Endpoints and agents installed on Endpoints.
The following table provides information on default Visualizations available on this dashboard.
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Endpoint Server
to Agent
Communication
Queued

Endpoint Server
to Agent

Communication
Rejected Count

Endpoint Agent
Overview

Relay Servers
Overview

e Service name

* Count of
queued request
to Agent

» Service name

* Count of
rejected request
to agent

¢ Hostname

« Total active
agents

* Active
advanced

* Active insights
agents

* Active
advanced
windows agents

e Active
advanced linux
agents

e Active
advanced mac
agents

¢ Hosts

* Total relay
servers

» Agents
communicated
via relay server

» Agents
communicated
in last two days
via relay server

Provides an overview of the queued agent Displays the

communication to the Endpoint Server to
identify any issues around the queued
communication.

Provides an overview of rejected agent
communication to the Endpoint Server to
identify any issues related to the rejected
count.

Provides an overview of Endpoint
Agents.

Provides an overview of the Relay
Servers.

queued request
to agent.

Displays the
rejected request
to agent.

Displays list of
agents and its
details.

Displays the
Relay server
details.
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Files Count by
File Status

Files Count by
Certificate
Status

File Count by
Reputation
Status

Endpoint Hosts
with Risk Score
Greater than 90

e Count of
blacklisted files

* Count of
graylisted files

* Count of
netural file

* Count of
whitelisted files

e Count of
blacklisted
certificates

* Count of gray
listed
certificates

e Count of
neutral
certificates

* Count of
whitelisted
certificates

e Count of
unknown status

* Count of
suspicious
status

e Count of
malicious status

¢ Count of
known good
status

* Count of
known status

* Count of
invalid status

Count of hosts
with risk score
greater than 90

Provides an overview of file status by
count to assist an Administrator on the
overall statistics of Endpoint actions on
files.

Provides an overview on certificate status
to assist an Administrator to take
necessary action.

Provides an overview on the reputation
status to assist an Administrator to take
necessary action.

Identifies the number of hosts with risk
score higher than 90 for immediate
attention.

Displays the file
count of file
statuses.

Displays the
count of
certificate
statuses.

Displays the
count of files
reputation status.

Displays the
count of hosts
with risk score
greater than 90.
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Identifies the number of files with risk
score higher than 90 for immediate
attention.

Endpoint Files Count of files
with Risk Score  with risk score
Greater than 90  greater than 90

Displays the
count of files
with risk score

ESA Correlation Overview Dashboard

greater than 90.

This dashboard provides health statistics and trends on the ESA deployment. The following table
provides the information on default Visualizations available on this dashboard.

You can choose the ESA host and Deployment name for the Dashboard view source using the filter.

Sessions Behind Count of

Provides the session behind trend for

Displays the count of

by Sources sessions the sources to take necessary actions  sessions behind by
behind by when the session behind goes higher.  sources.
sources.
Sessions Rate Count of Provides the session rate trend for the Displays the count of
by Sources sessions rate sources to take necessary actions sessions rate by
by sources. when the session rate goes higher. sources.
Top Rules by Memory used  Provides the memory usage per rule Displays the top rules
Memory by rules. to identify the rule with high memory  based on memory
usage and take necessary action. usage.

Top Rules by CPU used by  Provides the CPU usage per rule to Displays the top rules
CPU rules. identify the rule with high CPU usage based on CPU usage.
and take necessary action.

ESA Resident Provides resident memory usage trend Displays the trend of

Correlation memory usage. to be able to detect high usage and ESA correlation

Resident take necessary action. resident memory

Memory Usage usage.

ESA CPU usage. Provides CPU usage trend to detect Displays the trend of

Correlation high usage and take necessary action. ESA correlation CPU

CPU Usage usage.

ESA CR - Event rate of  Identify the event rate by each Displays the trend of

Event Rate by  each ESA deployment under ESA Correlation to ESA correlation event

Deployments correlation detect high usage and take necessary rate of each
deployment. action. deployment.
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Uninstall New Health and Wellness

To uninstall New Health and Wellness, perform the following:

1.

Take a backup of NetWitness Server host. For more information, see “Disaster Recovery (Back
Up and Restore)” topic in the NetWitness Recovery Tool User Guide.

nw-recovery-tool —--export --dump-dir /some/folder --category AdminServer
—-—-category Search

Note: If New Health and Wellness is not installed on NetWitness Server, you must take a
backup of the host on which New Health and Wellness is installed.

Make sure that the installation or upgrades are not in progress and stop the orchestration server
on NetWitness Server host:

systemctl stop rsa-nw-orchestration-server
Remove the New Health and Wellness service category (“Search") from the host:

a. SSH to Admin server

b. Fetch host details where New Health and Wellness is installed using the following command:
mongo localhost/orchestration-server -u deploy admin -p <deploy
admin-password> --authenticationDatabase admin --eval 'db.host.find ({
"installedServices": /.*Search.*/1i })'

Sample output

{ " id" : "56£f2a90b-1£03-d0%a-fb71-42c2a93958a8", "hostname"
"10.10.10.11", "ipv4"™ : "10.10.10.11", "ipv4Public" : "",
"displayName" : "adminserver", "version" : { "major"™ : 11, "minor"
5, "servicePack" : 0, "patch" : 0, "snapshot" : false, "rawVersion"
"11.5.2.0" }, "lastFailedRefreshAttempt" : NumberLong(0),
"refreshAttemptDelayFactor" : 0, "thirdParty" : false,
"installedServices" : [ "Search", "AdminServer" ], "meta" : { "node-
zero" : true }, " class"

"com.rsa.asoc.orchestration.host.HostEntity" }

c. Remove the "Search" from the installedServices.

IMPORTANT: Do not remove any other category names.

d. Replace <LIST-OF-CATEGORIES-EXCEPT-SEARCH> with a comma-delimited AND

double-quoted list of all the existing installed services found earlier EXCEPT "Search":
mongo localhost/orchestration-server -u deploy admin -p <deploy

admin-password> --authenticationDatabase admin --eval 'db.host.update
({ " id" : "<hw-node-uuid>" }, {$set: {"installedServices" : [ <LIST-
OF-CATEGORIES-EXCEPT-SEARCH> ]1}1})'

Example

mongo localhost/orchestration-server -u deploy admin -p netwitness --
authenticationDatabase admin --eval 'db.host.update({ " id"

"56£2a90b-1£f03-d09%a-fb71-42c2a93958a8" }, {$set: {"installedServices"
[ "AdminServer" ]}1})"!
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5.

Sample output
MongoDB shell version v4.0.19

connecting to: mongodb://localhost:27017/orchestration-
server?authSource=adminé&gssapiServiceName=mongodb

Implicit session: session { "id" : UUID("04e32380-347e-4b7d-a63e-
a094536d7242") 1}

MongoDB server version: 4.0.19

WriteResult ({ "nMatched" : 1, "nUpserted" : 0, "nModified" : 1 })

e. Make sure that the "Search" category is removed in the updated host record in the
installedServices

mongo localhost/orchestration-server -u deploy admin -p <deploy

admin-password> --authenticationDatabase admin --eval 'db.host.find ({
" id" : "<hw-node-uuid>" })'
Example

mongo localhost/orchestration-server -u deploy admin -p netwitness --
authenticationDatabase admin --eval 'db.host.find({ "_id"
"56£f2a90b-1£03-d09%a-fb71-42c2a93958a8" 1})'

Note: Any inconsistencies can result in unrecoverable errors.

Sample output

{ " id" : "56£f2a90b-1£03-d0%a-£fb71-42c2a93958a8", "hostname"
"10.10.10.11", "ipv4"™ : "10.10.10.11", "ipv4Public" : "", "displayName"
"adminserver", "version" : { "major" : 11, "minor" : 5, "servicePack"
: 0, "patch" : 0, "snapshot" : false, "rawVersion" : "11.5.2.0" },
"lastFailedRefreshAttempt" : NumberLong(0), "refreshAttemptDelayFactor"
0, "thirdParty" : false, "installedServices" : [ "AdminServer" ],
"meta"™ : { "node-zero" : true }, " class"

"com.rsa.asoc.orchestration.host.HostEntity" }

Stop the New Health and Wellness services:

systemctl stop rsa-nw-metrics-server elasticsearch opendistro-
performance-analyzer kibana

Disable the New Health and Wellness services:

systemctl disable rsa-nw-metrics-server elasticsearch opendistro-
performance-analyzer kibana

6.

Uninstall the New Health and Wellness packages using the command:

yum erase -y rsa-nw-metrics-server opendistroforelasticsearch
opendistroforelasticsearch-kibana

Note: rsa-nw-shell (installed with metrics server) is a shared package and should not be
removed.
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7. Remove the configuration folders or files:

e /etc/netwitness/metrics-server

e /etc/netwitness/platform/elasticsearch

/etc/netwitness/platform/nodeinfo/metrics-server

e /etc/netwitness/platform/nodeinfo/elasticsearch-open-distro
e /etc/netwitness/platform/nodeinfo/kibana-open-distro

e /etc/systemd/system/rsa-nw-metrics-server.service.d

e /etc/systemd/system/elasticsearch.service.d

e /etc/pki/nw/service/bootstrap/metrics-server.completed
e /etc/pki/nw/service/rsa-nw-metrics-server-cert.pem

e /etc/pki/nw/service/rsa-nw-metrics-server.chain

e /etc/pki/nw/elastic

e /etc/pki/nw/kibana

e /var/log/netwitness/metrics-server

e /var/log/kibana

e /etc/collectd.d/rsa-metrics-server.conf

e /etc/logrotate.d/kibana

e /etc/elasticsearch

e /etc/kibana

e /var/lib/elasticsearch

e /var/lib/kibana

e /var/netwitness/elasticsearch

8. Start the orchestration Server on NetWitness Server:
systemctl start rsa-nw-orchestration-server

9. Unregister the New Health and Wellness from the installedService:

a. Find the service IDs for metrics-server, elasticsearch-open-distro, and kibana-open-distro

Note: Make sure you look for service IDs for the correct host; do not unregister elastic or
kibana on an UEBA host.

orchestration-cli-client --list-services | grep <hw-node-IP-address>

Sample output

ID=50082d04-320c-4ce2-8379-00£38ae2dldf, NAME=metrics-server,
HOST=192.168.1.2:7018, TLS=true
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ID=530ff46a-8793-4e8e-be9c-742193d1705a, NAME=elasticsearch-open-
distro, HOST=192.168.1.2:9200, TLS=true

ID=4bad6ea8-e3a4-46ab-a342-34356bea65bb, NAME=kibana-open-distro,
HOST=192.168.1.2:5601, TLS=true

(other services)

b. Remove the service IDs returned above for metrics-server, elasticsearch-open-distro, and
kibana-open-distro (associated with New Health new Wellness host):

orchestration-cli-client --remove-service --id <metrics-server-
service-id>

orchestration-cli-client --remove-service --id <elasticsearch-open-
distro-service-id>

orchestration-cli-client --remove-service --id <kibana-open-distro-
service-id>

c. Verify if the services are removed:

orchestration-cli-client --list-services | grep <hw-node-IP-address>

10. On all hosts, except for UEBA, stop and disable metricbeat:

11.

12.

13.

systemctl stop metricbeat

systemctl disable metricbeat

Note: For NetWitness Platform without UEBA, you can stop and disable metricbeat on all

hosts through salt:
salt '*' cmd.run 'systemctl stop metricbeat && systemctl disable
metricbeat'

(Optional) - If you are not reinstalling New Health and Wellness (on same or other hosts), you
can also remove metricbeat package and configuration:

a. Package to uninstall:
metricbeat

b. Service configurations to uninstall:
© /etc/metricbeat
o /var/log/metricbeat
© mongo account

© systemd configuration

Refresh the New Health and Wellness host:

nw-manage --refresh-host --host-key <node-ip>

Make sure that the New Health and Wellness service is not installed or running and metricbeat
service is not active on the New Health and Wellness host.

If you are not reinstalling New Health and Wellness on another host, you must refresh UI hosts
(NetWitness Server host and Analyst UI) to update NGNIX:

nw-manage --refresh-host --host-key <node-ip>
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Note: After uninstalling New Health and Wellness, if you want to install New Health and
Wellness again, see "New Health and Wellness" in the Deployment Guide.
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Manage NetWitness Platform Updates

RSA issues NetWitness Platform software version updates on a regular basis as it strives to continually
improve the product. A software version update consists of a release, service pack, or patch (including
security patch) and ancillary software on which the release, service pack, or patch depends. User guides
are provided for each software version update release, which include detailed steps for installing the
update. It is important that you download the update guide for the release from RSA Link
(https://community.rsa.com/community/products/netwitness) and follow the steps described there.
Additional information is available in the "Apply Version Updates to a Host" topic in the Hosts and
Services Getting Started Guide and in System Updates Panel - Settings Tab.
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Reissue Certificates

Introduction

For a secure deployment, NetWitness Platform has installed internal RSA-issued certificates such as CA
Certificate and Service certificates .

The validity for NetWitness Platform certificates are as follows:

o CA root certificate for 11.x deployment is valid for 10 years
o CA root certificate for 10.6.x deployment is valid for 5 years

« Service certificates are valid for 1000 days

Note: The certificate expiration warning is triggered 30 days prior to expiration.

When these certificates are about to expire or have expired, you must renew and reissue the certificates
as soon as possible to avoid any issues with your NetWitness deployment.

Note: You can view the expiration details, by executing the ca-expire-test-sh script on the
NetWitness Server. For more information, see Reissue root CA security certificates on RSA
NetWitness Platform 11.x and download the script.

CA Certificate Reissue

To renew the CA certificates, do the following:

o Before you upgrade from 10.6.x to 11.x, check the expiry and reissue those certificates. For more
information, see the Reissue root CA security certificates on RSA NetWitness Platform 11.x.

o Ifyouare on 10.6.x , check the expiry and reissue all the certificates. For more information, see the
Reissuing security certificates on RSA NetWitness Platform 10.6.x.

Note: If you have Windows Legacy Collectors (WLC) in your deployment, renew the CA certificate
of the WLC after renewing the CA certificate of the NetWitness Admin Server.

Service Certificate Reissue

To renew the Service certificates, do the following:

« If your hosts are on NetWitness Platform 11.3 or later, you must use the cert-reissue script. For
more information, see the Reissuing Service Certificate .

« If your hosts are on 11.1.x or 11.2.x, you must upgrade the NetWitness Platform to 11.3 or later and
run the cert-reissue script.
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Note: If you have a host that is decommissioned or plan to remove, do not renew the certificate for
that host.

Reissuing Service Certificate

You can reissue service certificates in the following two ways.
o All at once
Reboot NW Server host after the cert-reissue --host-all command completes.
e One at a time
Reissue the NW Server host certificates first, restart the host, then reissue each component host.

IMPORTANT: If you are reissuing certificates for each host individually (one at a time), you must
reissue the certificate for the NW Server host before you can reissue certificates for any other host.
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When to Use the --host-all Argument

Use the cert-reissue --host-all command string if you have a large number of hosts. Make sure
that:

o All your hosts are running 11.3.0.0 or later.
o All your hosts are online.

o The NW Server host run time services are running.

cert-reissue Arguments and Options for All Hosts

The following tables lists the argument you can use to reissue certificates for all hosts at one time. See
Troubleshooting Cert-Reissue Command for additional options you can use with Customer Support to
troubleshoot errors.

s o

--host-all Reissues certificates for all hosts at one time applying system health checks and
restarts services.

Note: If even one host is not online, this command fails. If you have numerous hosts
in your deployment, make sure that all hosts are up and running.

Caution: Make sure you do not run this argument on a node or host that you plan to remove or
decommission.
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When to Use the Individual Host Argument (--host-xey <10, 1P,

hostname or display name of host>)

The cert-reissue --host-key <ID, IP, hostname or display name of host> command
reissues a certificate for an individual host. You may want to reissue certificates for an individual host if
you have a small number of hosts.

Make sure that:

o Each host is running 11.3.0.0 or later.

o Each host is online.

o The N'W Server host run time services are running

¢ You reissue certificates for the NW Server host first.

IMPORTANT: If you are on NetWitness Platform version 11.3 or 11.4, cert-reissue could use any of
the below arguments to identify the host.

*Reissue a specific host

—-host-id <id> to specify host (by ID).

--host-name <display-name> to specify host (by display name).

--host-addr <ip/host name> to specify host (by address/host name).

If you are on NetWitness Platform version 11.5 you can use any type of host identified with ——host-
key argument.

*Reissue a specific host
--host-key <identifier> to specify host to upgrade (by ID/IP/host name/display name).

Note: You must run the command for the NW Server host first and reboot that host before you run the
command for each component host.
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Reissuing Certificates for All Hosts Except Windows Legacy
Collection (WLC) host

Use the cert-reissue command to reissue certificates for all hosts except the WLC host with the
following procedures.
Running the Cert-Reissue Command for All Hosts

1. SSH to the NW Server host.

2. Submit the appropriate command string.
cert-reissue --host-all

Running the Cert-Reissue Command for an Individual Host

1. SSH to the NW Server host.

2. Submit the appropriate command string:
cert-reissue --host-key <ID, IP, hostname or display name of host>

Reissuing Certificates for a WLC Host

You must use the wlc-cli-client utility to reissue certificates for a WLC host (you cannot use the
cert-reissue command). You also need to specify a number of WLC identification parameters with
this utility.

Note: The certificates for a Windows Legacy Server host are stored in the following directories on the
host.

C:\ProgramData\netwitness\ng\logcollector cert.pem
C:\ProgramData\netwitness\ng\logcollector dh2048.pem

Th validity period of WLC certificates can range from 2 to 20 years. If you rename or remove the files
and restart NwLogCollector Service, NetWitness regenerates them.

/ssl/truststore.pem - is no longer used in 11.x

Every reissue of a certificate on the Windows Legacy server creates a new private key.
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To reissue certificates on a WLC host.
1. SSH to the NW Server host.

2. Submit the following command string.

wlc-cli-client --cert-renew --host 10.129.43.13 --port 50101 --use-ssl
false --username <nwadmin service account> --password <'nwadmin service
account password'> --ss-username <deploy admin> --ss-password <'deploy

admin password'>

Note: nwadmin service account is the WLC rest UI User and 'nwadmin service account
password' is the WLC rest UI password.

Successful Reissue Summary Report

When you run cert-reissue --host-all , the following summary report will be displayed if all
hosts are online, all run time services are running, and all hosts on version 11.4.0.0 or higher.

Unsuccessful Reissue Summary Reports

You must contact Customer Support (https://community.rsa.com/docs/DOC-1294) to troubleshoot
problems. You know there is a problem if any <host-id> does not return a SuccessStatus. Success
indicates that certificates were reissued for a host. The following examples illustrate unsuccessful

reissues.

Reissue Failed for Host and Aborted Command

The following three examples illustrate the failure of certificate reissuing for any hosts.
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e e e e e +
Host | Status | Me=sage

4 4 4 4

I<host-id>| <IP-address> |IFailed! |version <version-earlier-than-11.3.0.0> not supported|
|<host-id>| <IP-address> |IFailed! |version <version-earlier-than-11.3.0.0> not supported|
I<host-id>| <IP-address> IN/A I[ Skipped... ]

|<host-id>| <IP-address> IN/A I[ Skipped... ] |
I<host-id>| <IP-address> IN/A I[ Skipped... ]

4 4 4 4 4

Reissue Certificate Partially Executed

The NW Server Host certificates were reissued but failed to properly distribute the reissued certificates
to one or more component hosts.

4 + :

| | Host

+ + +

| <host-id>| <IP-address>

| <host-id>| <JIP-address>

e o +

$-——————- e e e ettt +
| Host | Status | Message |
et e st pommmm o |
| <host-id>| <IP-address> |Partial |Reissue completed, triggers failed |
| <host-id>| <IP-address> IN/5 I[ Skipped.. ] |
|<host-id>| <IP-address> IN/A | [ Skipped... ] |
| <host-id>| <IP-address> IN/A ] |
|<host-id>| <JIP-address> IM/A | |
+ + + + +
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Display System and Service Logs

NetWitness Platform provides views into system logs and service logs. When you view service logs, you
can select messages for the service or host.

View System Logs

QA
1. Goto (Admin) > System.
2. In the options panel, select System Logging.
RSA

Hosts

nfo

Updates

Licensing

Email

Global Notifications

otifications

Global Auditing

Jobs

Live Services

URL Integration
Context Menu Actions

tion

nalytics

Cloud Gateway
Whois

HTTP Proxy Settings

NTP Settings

System Logging

Realtime | Historical | Settings
ALL ~||keywords Search
Timestamp Level | Message

0:0:1%l0, 10.4.61.95,127.00.1]

ged

anged by admin
nanged by admin

1 to ContextHuB was not established

ged by admin
nanged by admin

om.rsa,

unch.zpisransportclient RequestTimeoutException: Request to esa-anziyti

admin v

rver.any./rsa/process/ready timed out &t com.rsa.asoc.

RS /\ NETWITNESS' PLATFORM 11.5.0.0

Display Service Logs

To display NetWitness Platform service logs:

Q
1. Goto (Admin) > Services.

2. In the Services list, select a service.

Display System and Service Logs
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3. Inthe Actions column, select View > Logs.

RSA Ve te Respond Users

Hosts Files Dashboard

Hosts S Event Sources  Endpoint Sources

& Change Service conc-Concentrator | Logs

System Logging
Realtime Historical

v || Keywords Concentrator
Timestamp

201

RS /\ NETWITNESS PLATFORM

Filter Log Entries

To filter the results shown in the Realtime tab:

v Sear

Health & Wellnes

ch

command, a re

command, a reply

& ping command, & reply

4 3 ping command, a re|

d 5 ping command, & re|

4 2 ging command, a reply

d 3 ping command, & reply

< received 2 ping command, 2 re

Reports

ystem

Security

admin v

11.5.00

1. (Optional) For system and service logs, select a Log Level and a Keyword, or both. System logs
have seven log levels. Service logs have only six log levels because they do not include the TRACE
level. The default is ALL log entries.

2. (Optional) For service logs, select the Service: host or service.

Click Filter.

The view is refreshed with the most recent 10 entries matching your filter. As new matching log

entries become available, the view is updated to show those entries.

Show Details of a Log Entry

Each row of the Realtime tab Log list provides the summary information of a log entry. To view

complete details:

1. Double-click a log entry.

The Log Message dialog, which contains the Timestamp, Logger Name, Thread, Level and

Message, is displayed.
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Log Message

Timestamp 2019-02-01721:46:30.000
Logger Name Ping
Thread
Level DEBUG
Message has received a ping command, a reply of 51 bytes was sent
-
2

2. After viewing, click Close.

Access Reporting Engine Log File

All Log Files

The Reporting Engine stores the following logs in the rsasoc/rsa/soc/reporting-engine/log
directory:

o Current logs in the reporting-engine.log file.
« Backup copies of previous logs in the reporting-engine.log. * file.
o All UNIX script logs in the files that have the following syntax: reporting-engine.sh

timestamp.log (for example, reporting-engine.sh 20120921.10g9).

The Reporting Engine rarely writes command line error messages to the rsasoc/nohup.out file.

Upstart Logs

The Reporting Engine appends the log messages and output written by upstart daemon and the commands
used to start the reporting-engine to the /var/log/secure directory.

An upstart log file is a system log file, which means that only the root user can read it. The Reporting
Engine generates log files, retains backup copies of previous log files, stores UNIX script log files, and
appends upstart log files to another directory.

Search and Export Historical Logs

NetWitness Platform provides a searchable view of the NetWitness Platform log or the service log in a
paged format. When initially loaded, the grid shows the last page of the log entries for the system or the
service. You can export logs from the current view.
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Display the Historical System Log
To display the historical log for the system:
4
1. Goto (Admin) > System.
2. In the options panel, select System Logging.
The System Logging panel is opened to the Realtime tab by default.

3. Click the Historical tab.
A list of historical logs for the system is displayed.

admin v

nfo e Ao

System Logging
Updates

Realtime | Historical Settings
Licensing

- End Date ALL ~ || Keywords Search ¥ Export
Email
Timestamp Level

Global Notifications

Notifications

m Logging .db.backup.2019-02-08_165016.2ip

Global Auditing established
Jobs

Live Services
URL Integration

Context Menu Actions

nvestigation
£5A Analytics

]

Gateway

HTTP Proxy Settings

NTP Settings

LicensingMiscConfiguration changed by admin

{ € | Page 103 of 103 | N Displaying 5101 - 5142 of 5142

RS /\ NETWITNESS PLATFORM 11.5.00

Display a Historical Service Log

To display the historical log for services:

1. Select (Admin) > Services.
2. Select a service.
In the Actions column, select View > Logs.
The service logs view is displayed with the Realtime tab open.

4. Click the Historical tab.
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A list of historical logs for the selected service is displayed.

RSA vestigate  Respond  Users  Hosts  Files  Dashboard  Reports admin v

Hosts  Sef Event Sources  Endpoint Sources  Health & Wellness  System  Security

& Change Service | 3 broker - Broker Logs

System Logging

Realtime | Historical

Broker ~  Search  Export

Timestamp

55c8f2dc-6896-49c3-5o6a-30ad5dIeTenT

 exception typs: nur Exception std-exceptionswhat Parsmeter usermame: Value cannot be empty

jmin has been granted Q.

User agmin (sessio

€ (| Page 200 of200 | 1 Displaying 2951 - 10000 of 10000

RS/ NETWITNESS PLATFORM 11.5.0.0

Search Log Entries

To search the results shown in the Historical tab:

1.
2.

(Optional) Select a Start Date and End Date. Optionally, select a Start Time and End Time.

(Optional) For system and service logs, select a Log Level and a Keyword, or both. System logs
have seven log levels. Service logs have only six log levels because they do not include the TRACE
level. The default is ALL log entries.

(Optional) For service logs, select the Service: host or service.

Click Search.
The view is refreshed with the most recent 10 entries matching your filter. As new matching log
entries become available, the view is updated to show those entries.

Show Details of a Log Entry

Each row of the Historical tab Log grid provides the summary information of a log entry. To display all
the details for a log message:

L.

Double-click a log entry.

The Log Message dialog, which contains the Timestamp, Logger Name, Thread, Level and
Message, is displayed.
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Log Message

Timestamp 2019-02-01T21:46:30.000
Logger Mame Ping

Thread

Level DEBUG

Message has received a ping command, a reply of 51 bytes was sent

2. After viewing, click Close.

Page Through Log Entries

To peruse the different pages of the list, use the paging controls on the bottom of the grid as follows:
o Use the navigation buttons

o Manually type the page number you want to view, and press ENTER.

Export a Log File

To export the logs in the current view:

Click Export, and select one of the drop-down options: CSV Format or Tab Delimited.

The file is downloaded with a filename that identifies the log type and the field delimiter. For example,
a NetWitness Platform system log exported with comma-separated values is named UAP log export
CSV.txt, and a host log exported with tab-separated values is named APPLIANCE log export
TAB. txt.
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Maintain Queries Using URL Integration

A URL integration provides a way to represent the bread crumbs, or query path, you take when actively
investigating a service in the Navigate view. You do not need to display and edit these objects often.

A URL integration maps a unique ID that is automatically created each time you click on a navigation
link in the Navigation view to drill into data. When the drill-down completes, the URL reflects the query
IDs for the current drill point. The Display Name is displayed in the bread crumb in the Navigate view.

The URL Integration panel provides a list of queries and allows users who have the proper permissions
to modify this underlying source of data and analyze the query patterns of other users of the NetWitness
Platform system. Within the panel, you can:

« Refresh the list.

« Edit a query.

o Delete a query.

 Clear all queries in the list.

Caution: After a query has been removed from the system, any Investigation URLs that included the
ID of that query will no longer function.

Edit a Query

QA
I. Goto (Admin) > System.
2. In the options panel, select URL Integration.

URL Integration

= [ | ORefresh & Clear

O Display Name Query Username When Created ~
O o nwappliance11639 did = 'nwappliance 11639 admin Tue Jul 11 201 :09 +00:00 (UTC)
[ threat.category ='spe...  threat.category = 'spectrum admin Tue Jul 11 2017 08:3%:33 +00:00 (UTC)
O 2 CONTENt = 'spectrum,C..  CONTENT = 'spectrum.consume’ admin Tue Jul 11 2017 08:41:33 +00:00 (UTC)
O = content = 'spectrum.a..  content='spectrum.analyze’ admin Tue Jul 11 201 +00:00 (UTC)
O a4 gwu.edu domain.dst ="gwu.edu’ admin Tue Jul 11 201 +00:00 (UTC)
0 s 10.100.33.1 ip.src=10.100.33.1 admin Ved Jul 12 2017 02:48:56 +00:00 (UTC)
O s ip.src="127.0.0.1 ip.src=127.0.0.1 admin ed Jul 12 2017 09:35:24 +00:00 (UTC)
[ tep.sroport = 54004 tep.srcport = 54004 admin Ned Jul 12 2017 09:37:44 +00:00 (UTC)
[ nwappliance23912 did ="nwappliance23912 admin Ned Jul 12 2017 11:09:05
e gwu.edu domain.src = 'gwu.edu’ admin Thu Jul 13 2017 13:58:52 +0!
O 1o OTHER ervice = 0 admin
O 1 test dom alert = test dom admin

| page |1 | of1 | | C Displaying 1-12 of 12

3. Select the row in the grid and either double-click the row or click =,
The Edit Query Dialog is displayed.

Maintain Queries Using URL Integration
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Display Name content = 'spectrum.consume’

Query content = 'spectrum.consume’

Cancel Save

4. Edit the Display Name and the Query, but do not leave either field blank.

5. To save the changes, click Save.

Delete a Query

Caution: After a query has been removed from the system, any Investigation URLs that included the
ID of that query will no longer function.

To remove a query from NetWitness Platform entirely:

1. Select the query.
2. Click =

A dialog requests confirmation that you want to delete the query.

3. Click Yes.

Clear All Queries
To clear all queries from the list:

« Click & Clear

The entire list is cleared.

Use a Query in a URI

URL integration facilitates integrations with third-party products by allowing a search against the
NetWitness Platform architecture. By using a query in a URI, you can pivot directly from any product
that allows custom links, into a specific drill point in the Investigation view in NetWitness Platform.

The format for entering a URI using a URL-encoded query is:

http://<nw host:port>/investigation/<serviceld>/navigate/query/<encoded
query>/date/<start date>/<enddate>
where
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e <nw host: port> is the IP address or DNS, with or without a port, as appropriate (ssl or
not). This designation is only needed if access is configured over a non-standard port through a
proxy.

e <serviceId> is the internal Service ID in the NetWitness Platform instance for the service
to query against. The service ID can be represented only as an integer. You can see the

relevant service ID from the url when accessing the investigation view within NetWitness
Platform. This value will change based on the service being connected to for analysis.

e <encoded query> is the URL-encoded NetWitness Platform query. The length of query is
limited by the HTML URL limitations.

e <start date> and <end date> define the date range for the query. The formatis <yyyy-
mm-dd>T<hh :mm>. The start and end dates are required. Relative ranges (for example, Last
Hour) are not supported in this version. All times are run as UTC.

For example:
http://localhost:9191/investigation/12/navigate/query/alias%20exists/date
/2018-09-01T00:00/2018-10-31T00:00

Examples

These are query examples where the NetWitness Server is 192.168.1.10 and the servicelD is identified
as 2.

All activity on 03/12/2018 between 5:00 and 6:00 AM with a hostname registered

e Custom Pivot: alias.host exists

e https://192.168.1.10/investigation/2...13-03-12T06:00

All activity on 3/12/2018 between 5:00 and 5:10 PM with http traffic to and from IP address 10.10.10.3
e Custom Pivot: service=80 && (ip.src=10.10.10.3 || ip.dst=10.0.3.3)
e Encoded Pivot Dissected:

e service=80 => service&3D80

e ip.src=10.10.10.3 => ip%$2Esrc%$3D10%2E10%2E10%2E3

e ip.dst=10.10.10.3 => ip%2Esrc%3D10%2E10%2E10%2E3

e https://192.168.1.10/investigation/2...13-03-12T17:10

Additional Notes

Some values may not need to be encoded as part of the query. For example, commonly the IP source
(src) and destination (dst) is used for this integration point. If leveraging a third-party application for
integration of this feature, it is possible to reference those without encoding applied.
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Manage the deploy_admin Account

The deploy admin account is a system account that is used throughout multiple NetWitness Platform
components for system-specific access. It is a password-based account that may need periodic password
updating if deployment environment policies require it. The deploy admin account is used on every
NetWitness Platform host, and must be kept in sync between all hosts. Prior to 11.4.1, the process to
change the deploy admin account required administrators to log into every NetWitness Platform host
and run the /opt/rsa/saTools/bin/set-deploy-admin-password script on each system. Starting
with 11.4.1, the deploy admin password is centrally managed with the nw-manage script on the NW
Server. nw-manage script execution updates the password on all NetWitness Platform component hosts
that use the deploy admin account. The nw-manage script output displays the password update results
for each host. If a NetWitness Platform component host is down or unreachable for any reason, the nw-
manage script provides an additional option to synchronize the deploy admin password on the
previously unresponsive host with the NW Server when that host becomes available again.

The following procedures describe how to change the deploy admin password for all hosts in your
environment, for hosts in a mixed version environment, and for hosts that are unavailable during the first
attempt to change the deploy admin password.

Change the deploy _admin Account Password

1. Log in to the NW Server host using SSH or the NwConsole.

2. Run the following command:
nw-manage --update-deploy-admin-pw
A prompt for the new password is displayed.

3. Enter the new password.

Change the deploy_admin Account Password in a Mixed

Version Environment

If you are operating in a mixed version environment (for example, NW Server is on a newer version
(greater than or equal to 11.4.1) and the NW component hosts are still on an older version of NetWitness
(less than 11.4.1), the nw-manage script prompts you to run the /opt/rsa/saTools/bin/set-
deploy-admin-password script on those older component hosts first. After the hosts on the older
versions are updated, you rerun the nw-manage script on the NW Server with the --skip-version-
checks argument.

1. On each component host that is on an older version, reset the deploy admin password by running
the following command:
/opt/rsa/saTools/bin/set-deploy-admin-password
This resets the deploy admin password on all the component hosts with the older versions.

2. Log in to the NW Server host using SSH or the NwConsole and run the following command:
nw-manage --update-deploy-admin-pw --skip-version-checks
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A prompt for the new password is displayed.

3. Enter the new password.

Change the deploy_admin Account Password for a

Component Host that is Unavailable

If a component host is down or otherwise unreachable the first time you run the nw-manage script, it is
identified as skipped in the nw-manage --update-deploy-admin-pw output. When the host is back
online, its deploy admin password must be synchronized with the NW Server.

To synchronize the previously unreachable host with the NW Server:
1. Log in to the NW Server host using SSH or the NwConsole.

2. Run the following command:
nw-manage --sync-deploy-admin-pw --host-key <ID, IP, hostname or display

name of host>
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Management

Starting with 11.5, the NW Server has a new attribute, secondary IP that facilitates automated
failover and IP address change management.

Note: For clarification, this attribute is simply another metadata host attribute that is specific to the
NW Server; it does NOT describe, nor is it related to, a secondary network interface on the NW
Server.

In the failover use case, the active NW Server has a secondary IP value that matches the standby
server IP address. This secondary IP value is known to the other NetWitness hosts, and when the
primary NW Server fails to respond in a timely fashion due to an IP address change of the active NW
Server, or when there is a scheduled failover to the NW standby server, the other NetWitness hosts and
services are configured to automatically attempt to connect to the secondary IP address, which in this
case is the NW standby server.

The secondary IP attribute is also used for NW Server IP address change and for the NW standby
server. The NW Server IP address change procedures automatically populate the secondary IP address
of the NW Server to the new IP address and propagate that information to the other NetWitness hosts
and services. Then, similar to the failover use case when NW Server’s original IP address is no longer
valid and the new IP address is active, the NetWitness hosts and services automatically switch to the
new secondary IP address, which becomes the new NW Server IP address. If the NW standby server’s
IP address is changed, the secondary IP attribute on the NW Server needs to be updated with the new
NW standby server IP address.

The secondary IP attribute is managed primarily with automated processes, but there are use cases
that require manual management of the NW Server host secondary IP attribute, such as an IP address
change of the NW standby server or a one-time registration during an NW standby server upgrade.

The secondary IP is managed using the nw-manage script on the NW Server:

o To add a secondary IP address to the NW Server host, run the following command:
nw-manage --add-nws-secondary-ip --ipv4 <secondary ip address>

o Toremove a secondary IP address from the NW Server host, run the following command:
nw-manage --remove-nws-secondary-ip --ipv4 <secondary ip address>

o To view secondary IP addresses assigned to the NW Server host, run the following command:
nw-manage --get-nws-secondary-ip

For information about changing IP addresses, see Change Host Network Configuration.

For information about failover procedures, see "Warm Standby NW Server Host" in the Deployment
Guide for RSA NetWitness Platform.
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This topic describes how to change the network configuration for NW Server and component hosts in
your environment. The instructions in this section assume that all the hosts in your environment are
on version 11.5.

Note: If your NW Server is referenced by other NW hosts that use a Network Address Translation
(NAT) IP address, and you want to change the NAT IP address, you must remove the old NAT IP
address and add the new NAT IP address using the instructions provided in NW Server Host
Secondary IP Configuration Management.

This section contains the following procedures:

o Change Host Network Configuration

o Change Network Configuration for Warm Standby (Secondary) Server

o Reconnecting Component Hosts with NW Server Hosts

Note: Changing [Pv6 addresses is not supported in 11.5.

Change Host Network Configuration

Use this procedure to update the network configuration for any host type in your environment for version
11.5.

To change the network configuration of a host:

1. From the console, log in to the host for which you wish to change the network configuration.

Note: If you are updating the IP address of your NW Server and you are using DHCP, run the
following command before you go to step 2:

nw-manage --add-nws-secondary-ip --ipv4 <new DHCP allocated ip address of
NW Server>

2. Run the following command:

nwsetup-tui
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The nwsetup-tui license dialog is displayed.

By clicking "Accept”™, vou (the "Customer”) hereby agree, on behalf of your
company or organization, to be bound by the terms and conditions of the
End User License Lgreement (the “EULA™) located at
https://www.rsa.com/content/dam/rsa/PDF/shrinkwrap-license—combined.pdf
with R5a Security LLC (“R5A", or appropriate affiliate entity in the
relevant jurisdiction). In addition, Customer hereby agrees and
acknowledges that, if Customer chooses to host its data with any third
party or in a public cloud environment, RS5SA has no responsibility for the
sStorage or protection of any Customer data or for any associated security
breach notifications. The terms herein and in the EULA shall supersede any
relevant terms in any other agreement between the Customer and RSA. For
customers of the RSA NetWitness® products, all data analyzed in connection
herewith shall be at a cost to Customer based on R5A"s then current

[¥s]
(R ]
o

3. Click Accept. The NetWitness Platform Update Configuration dialog is displayed:

HetWitness Platform 11.5 Update Configuration -
A previous NetWitness configuration has been
detected on this node. You may re-run the
installation or =select a specific
configuration area to update.

1 Reinstall
! Update Network Confi

Static IP Comfiguratio
Use DHCP
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5. Select option 1, Static IP Configuration, and click OK.
The NetWitness Platform Network Configuration Static IP configuration dialog is displayed.

NetWitness Platform Network Configuration
Static IP configuration

IP Address '
Subnet Mask I
Default Gateway s
Primary DNS server [
Secondary DNS Server [N
Local Domain Name I

< OK > < Exit >

6. Enter the new network and DNS configuration and click OK.
The new network and DNS configuration is applied to the host.

Note: While changing the IP address, the user interface may become temporarily unavailable
while the update is in process. The user interface will come back up shortly.

Note: After upgrading the NW Server host or a component host to 11.5, review the contents of the
/etc/hosts.user file for any obsolete host entries. The /etc/hosts.user file contains system
and user-generated entries that are not managed by NetWitness Platform. However, entries from
/etc/hosts.user are merged with NetWitness Platform-generated host mappings to create and
update /etc/hosts. To avoid conflicts with NetWitness Platform-generated mappings, and to avoid
generating connectivity errors resulting from an IP address change, RSA recommends that you remove
any entries in /etc/hosts.user that include a non-loopback IP address of a NetWitness Platform
host. After updating /etc/hosts.user, you must refresh the system by running the following
command:

nw-manage --refresh-host --host-key <ID, IP, hostname or display name of
host>

Follow the steps in the sections that apply to your environment.
« SSO

o Reporting Engine

+ UCF

« PAM

« ECAT

o RSA NetWitness Orchestrator (By Demisto)

« Audit Logging
o Health and Wellness

o Malware Analysis

o Windows Legacy Collection
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SSO

Update Configuration for Single Sign-On

Note: You must disable SSO configurations ONLY when NW Server IP is changed.

When the host network is configured with a new IP address, the SSO configurations also must be
updated.

To do this:

1. Disable the SSO configuration using nw-shell after failover from new IP.
To resolve this issue you must disable SSO manually, using the following commands:

SSH to admin server node

IS

Connect to nw-shell.

Connect to admin server service using the connect --service admin-server command.

& o

Log in to admin server using the 1ogin command.

o

Enter the admin username and password.

f. Execute the following commands:

e cd /rsa/security/authentication/web/saml/sso-enabled
e set false

e logout

e exit
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e systemctl restart rsa-nw-admin-server

2. Change the host IP address to the new IP.

3. Generate the new metadata and reupload it in ADFS. For more information, see the "Configure
SAML 2.0 provider settings for portals" topic in the Microsoft documentation.

For more information, see the "Troubleshooting" topic in the System Security and User Management
Guide.

Reporting Engine

Update Configuration for Reporting Engine

Note: You must update the Reporting Engine configurations ONLY when NW Server IP is changed.

When the host network is configured with a new IP address, you must update and verify the Reporting
Engin configurations. The hostname for NetWitness Platform configurations under the Output Actions
must be updated with the new IP.

To manually configure the new IP, perform the following steps:

1. Login to NetWitness Platform.

: :
2. Navigate to K&l (Admin) > Services > Reporting Engine > View > Config.
3. Click the Output Actions tab.
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4. Add the new IP address in the Hostname field.
5. Click Apply.

UCF

To enable UCF to communicate with NetWitness Platform:

1. On the UCF server, execute the runConnectionManager.bat file (the same file that is used for
adding connection details).

2. Select Option #2, Edit endpoints.
3. Select the NW Server connection from the options that are displayed.

4. When you are prompted for Host Address (the old IP address is shown in parentheses) enter the new
IP address.

Note: Do not change any other setting.

PAM

If you have PAM configured, after the failover, you must configure the system again using the
instructions in the "Configure PAM Login Capability" topic in the System Security and User
Management Guide. Go to the Master Table of Contents to find all RSA NetWitness Platform 11.x
documents.

ECAT

Update the following services:

o Incident Message Broker

o NetWitness Suite

o Syslog Server Settings

Incident Message Broker

1. Log in to the NetWitness Endpoint user interface and go to Configure > Monitoring and External
Components Configuration > Incident Message Broker.
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Update the server Hostname and IP Address to the current active server and test the settings.

. - o x
..
=
= a Incident Message Broker
) [saone - API SE:T:;;;%?!:::\‘nmg‘ % @ @ Version Info  Last Scan User N
4400 6/17/2019 2:56:12 ... V, Vigy
NetWitness Suite Connection 4400 6/27/201912:18:19...
Server Hostname/IP : e
Port : 5671
Test Settings Edit
* 2 items total 4 »
Downloads (UTE:0800] Pacific Time (US. Canada) |
UserName=WINDOWS2012-001\Administrator, Host=, Instance=, Database=ECATSPRIMARY, Build=1400014, Version=4.4.0, Schema=33, Number of Servers=1 |

RSA NetWitness Endpoint: Version 4.4.0.0

NetWitness Suite
1. Log in to the NetWitness Endpoint user interface and go to Configure > Monitoring and External

Components Configuration > Netwitness Suite.
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2. Update the server Hostname and IP address to the current active server and test settings.

Configure Tools | View About

Main Menu a

[ ;
» NetWitness Suite
.' CD | -
Dashboard
F NetWitness Suite Connection
D’:I Server Hostname/IP 8 L
Machines
Configure NetWitness Suite
6." l Servers Time Zone | (UTC-11:00) Coordinated Universal Time-11
Device Identifier 18
Modules
URI https://* % #lvinvestigation/18/
m
' Query Optimization
| Do Not Perform Query Older Than 0 days *Set 0 fo query ail.
IP List
1
Query Time Range
C) 1
.‘ Minimum: (] minutes
Certificates ! Maximum: | 30 .| minutes
‘
InstantiOCs
a Test Settings
* 2 items total 4
Downloads

RSA NetWitness Endpoint: Version 4.4.0.0 UserName=WINDOWS:

Syslog Server Settings

Port: 443

Configure RSA NetWitness Endpoint Feeds for NetWitness Suite

| Enable RSA NetWitness Endpoint Feed

URL | https://Windows2012-001:9443/api/v2/feed/machines.csv

* Al SQL Users with valid permissions have access to above URL

Feed Publishing Interval

Time Interval: 0 Hrs 30 min

Enable URL access to below user to
Username:

Password: @

2-001\Administrator, Host=, Instance=, Database=ECATSPRIMARY, Build=1400014, Version=4.4.0, Schema=33, Number of Servers=1 ‘

BO®

Edit

t Scan
7/2019 2:56:12 ...

/2019 1219:19...

(UTC08:00] Pacific Time (US. Canada) |

User B

v, Vig

If you are forwarding syslog messages to a NetWitness Platform Log Decoder, update the syslog server
settings to point to the new IP address of the Log Decoder host.

1. Log in to the NetWitness Endpoint user interface and go to Configure > Syslog Server.

Configure Tools | View About

.‘ % SYSL0G Server
4 ) | togdecoder

Sysiog Connection
Server Hostname/IP :

Port

= Transport Protocol :

Modules
a
1P List

@®

an

Certificates

A

InstantioCs

@ Test Settings

Downloads

—-N OO0

2. Select logdecoder, and in Server Hostname/IP, enter the new IP address of the Log Decoder host.
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RSA NetWitness Orchestrator (By Demisto)

Update the Current Active NW Server to Fetch Respond Incidents and Alerts
1. Log in to Orchestrator and go to Settings > server&services.

2. Edit the RSA NetWitness V11.1 instance by updating the server URL to the current active NW
Server to fetch respond incidents and alerts.

Settings

USERS AND ROLES ADVANCED ABOUT

Classification & Mapping Pre-Process Rules Engines Agent Tools Credentials

Show: Type: Ca y Ef

RSA NetWitness v11.1

Home
Incidents

admin
Jobs
Indicators
et Case Management (1)
Playbo
Automation

£ Seitings

@

Update Component Hosts Acting as Data Sources

If you change the IP address of a component host, for example, a Concentrator, Network or Log
Decoder, or Broker, that is acting as data source to the Orchestrator, update the following settings to
point to the new IP address of the host.

1. Login to Orchestrator and go to Settings > server&services and select the component host.

Settings

Analytics & SIEM (3)

T —
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2. Enter the new IP address of the component host in Server URL and click Done.

Settings

Analytics & SIEM (3)

RSA NetWitness Packetsand ... 8 x

Audit Logging

If you have changed the IP address of the NW Server, you must reconfigure audit logging. For
instructions, see "Configure Global Audit Logging" in the System Configuration Guide.

Health and Wellness

If you have any Health and Wellness rules that contain IP addresses that have been changed, you must
update those rules with the new IP addresses. For information about managing Health and Wellness
rules, see "Monitor Health and Wellness using NetWitness Platform UI" in the System Maintenance
Guide.

Malware Analysis

Source host IP address changes are not updated in the NetWitness Platform user interface for Malware
Analysis continuous scan configurations. Y ou must manually update this configuration in the Malware
Analysis Config view > General > Continuous Scan Configuration and update the source host IP
address to the new host IP address.
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% Change Service | [ Malware - Malware Analytics |  Config &

General Indicators of Compromise  10C Summary  Auditing Hash AV Proxy ThreatGRID  Integration
Continuous Scan Configuration Modules Configuration
Name Config Value Name Config Value
Enabled O = Static
Query select * where content="spectrum.consume’ | | ... Enabled [
Query Expiry 3600 Bypass PDF |
Query Interval 5 Bypass Office m}
Meta Limit 25000 Bypass Executable O
Time Boundary 24 Walidate Windows PE Authenticate Settings ... m}
3
Source Host 172.16.0.0 = Community
Source Port (NwPort) 0 Enabled O
Username admin Bypass PDF ™
User Password FEARARAE Bypass Office [
SsL O Bypass Executable |
Denial of Service (DOS) Prevention 1 T = Sandbox
H ; + H Enabled

Repository Configuration nable .

Bypass PDF £
MName Config Value

Bypass Office ™
Directary Path fvarinetwitnessimalware-analytics-server/spectr...

Bypass Executable O
File Sharing Protocol None

A Preserve Original File Name when Perfarmi.. [
Retention (in days) 60
GFl Sandbox (Local)
Miscellaneous Enzbled m
Name Config Value Server Name localhost
Maximum File Size (MB) 64 Server Port 20 -
Apply

Windows Legacy Collection

On occasion, you may need to change the IP address of your Windows Legacy Collector. You may also
need to edit any Destination Groups that you have configured.

Change WLC IP Address

The following procedure describes how to change the IP address for your system.
1. Log onto the Windows Legacy Collector system and manually change the IP address on the system.

2. In the UI, confirm that the Log Collector service corresponding to the WLC system shows up in error
(Red). It might take some time for it to reflect the changed status.

3. On the NetWitness Server, use the nw-manage utility to view the host information for the WLC
using the following command:

nw-manage --list-hosts
Sample output from running the command is shown here:

{

"id" : "£db8150c-e040-459e-8cc5-3c60ec2c65ae",
"displayName" : "WLC-HOST-104",

"hostname" : "10.101.216.102",

"ipv4™ : "10.101.216.102",

"ipv4Public" : null

bl

You use the value of "id" from your output in the following step.
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4. Use the nw-manage utility to change the [P address of the WLC. For the host-id argument, use the
value for the "id" that you noted from step 3. For the ipv4 value, use the new IP Address to which
you are changing.

nw-manage --update-host --host-id "£db8150c-e040-459e-8cc5-3c60ec2c65ae" --
ipv4 10.101.216.105

5. After you see the message that the previous command ran successfully, go to the NetWitness Server
Ul and verify that the WLC service is running without any errors.

Edit Destination Groups For Log Collectors and VLCs

The Windows Legacy Collector is often configured with Destination Groups to forward events to Log
Collectors or Virtual Log Collectors. If the IP address of any such Destination LC or VLC is changed,
the Windows Legacy Collector can no longer forward events. To remediate this, you must edit the
Destination groups for the WLC, making sure to select the new LC or VLC IP Address.

Change Network Configuration for Warm Standby

(Secondary) Server
You can change the network configuration of a warm standby (secondary server) by following these
steps:

1. Follow the steps described in Change Host Network Configuration to change the IP address on the
secondary server.

2. Log in to the active NW Server and remove the previous secondary server IP address by running the
following command:
nw-manage --remove-nws-secondary-ip --ipv4 <previous standby server ip

address>

3. On the active NW Server, add the new standby server secondary IP address value by running the

following command:
nw-manage --add-nws-secondary-ip --ipv4 <new standby server ip address>

4. Schedule the backup of the primary NW Server and the copying of backed-up data to the secondary
NW Server. See step 18 in "Setup Secondary NW Server in Standby Role" in the Deployment Guide
for RSA NetWitness Platform.

For information about configuring warm standby servers, see "Warm Standby NW Server Host" in the

Deployment Guide for RSA NetWitness Platform and NW Server Host Secondary IP Configuration

Management.

Reconnecting Component Hosts with NW Server Hosts

While changing a host's IP address or during failover, component hosts can become disconnected from
NW Server hosts. Follow these steps to reconnect a host system to its NW Server system.

154 Change Host Network Configuration



System Maintenance Guide

1. Log in to the component host using SSH or the console.

2. Run the following command:
nw-manage --override-nws-ip --ipv4 <current IP address of the NW Server>
When this command completes, the component host is reconnected to the NW Server at the specified
IP address.
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If you have hosts in your environment that use custom entries, or if you want to use NAT IPv4 addresses
for your hosts, this topic provides instructions for configuring these settings.

Manage Custom Host Entries in /etc/hosts

If you identify hosts in your environment that need custom entries, you can add custom entries for your
hosts in the /etc/hosts.user file.

To add custom host entries:
1. From the console, log in to the host on which to define custom entries.

2. Add the custom entry to the /etc/hosts.user file.

To update or refresh a custom entry in /etc/hosts:

Run the following command:

nw-manage --refresh-host --host-key <ID, IP, hostname or display name of
host>

Manage Public or NAT IPv4 Addresses for Hosts

To add or update public or Network Address Translation (NAT) IPv4 addresses for NW Hosts, run the

following command:
nw-manage --update-host --host-id <NW Server Host UUID> --ipvéd-public <IP
address>

Manage Custom Jetty Configuration

If you want to have custom jetty configurations or additional JAVA OPTIONS that persist during the
upgrade, this topic provides the instructions for configuring custom jetty settings.

To add custom jetty configuration

1. From SSH prompt, create a copy of jetty configuration as jetty.user using the below command.
$ cp /etc/default/jetty /etc/default/jetty.user

2. Editthe /etc/default/jetty.user and remove all lines EXCEPT one of the JAVA OPTIONS
additional settings lines.
For example, JAVA OPTIONS="${JAVA OPTIONS} -Drsa.primary.host=true "

3. Edit the line with the option (in this example increasing the max memory option from 8G to 24G):
JAVA OPTIONS="${JAVA OPTIONS} -Xmx24G "

4. Make sure to use the JAVA OPTIONS="${JAVA OPTIONS} " formatto EXTEND the Java
OPTIONS.
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5. REMOVE the [ -f /etc/default/jetty.user ] && source /etc/default/jetty.user
file.

6. Save the file.

7. Restart the jetty service.
systemctl restart jetty
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Configure FIPS Support

NetWitness Platform 11.x ships with FIPS-validated 140-2 Cryptographic Modules that support all
cryptographic operations within NetWitness Platform. NetWitness Platform leverages two modules that
support a level three design assurance:

« RSA BSAFE Crypto-J
« RSA OwB

Both modules have been certified with an operational environment comparable to the standard
NetWitness Platform configuration.

By default, the cryptographic modules enforce the usage of FIPS-certified cipher suites wherever
possible. For exceptions, refer to the information below and to the release notes. For additional
information about the FIPS modules, see https://csrc.nist.gov/publications/detail/fips/140/2/final.

The RSA BSAFE Crypto-J FIPS Certificate number is 3172, and OwB uses the CCME FIPS Module in
FIPS-approved mode.

In 11.x, FIPS is enabled on all services except Log Collector. This includes Log Decoder and Decoder if
they were FIPS-enabled in 10.6.x or any previous version. FIPS cannot be disabled on any services
except for Log Collector, Log Decoder and Decoder.

Note: For a fresh installation of 11.x, by default, all core services will be FIPS enforced except Log
Collector and Log Decoder. FIPS cannot be disabled on any services except for Log Collector, Log
Decoder and Network Decoder.

Note: For upgrades to 11.x from previous versions, the following conditions apply for the Log
Collector, Log Decoder and Decoder services:

- Log Collector is not FIPS enabled after upgrading to 11.x, even if FIPS was enabled in a previous
version. You must enable FIPS support after upgrading to 11.x. See the instructions in FIPS support for
Log Collectors.

- If FIPS was enabled for the Log Decoder and Network Decoder services in a prevous version, FIPS
will also be enabled in 11.x. However, if Log Decoder and Network Decoder were NOT FIPS
enabled in a previous version, they will not be enabled in 11.x, and you can manually enable FIPS for
these services if required. See the instructions in FIPS support for Log Decoders and Decoders.
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FIPS support for Log Collectors

To enable FIPS for Log Collectors:

1.
2.

Stop the Log Collector service.

Open the /etc/systemd/system/nwlogcollector.service.d/nwlogcollector-opts-
managed.conf file.

Change the value of the following variable to off as described here:
Environment="OWB ALLOW NON FIPS=on"

to

Environment="OWB ALLOW NON FIPS=off"

Reload the system daemon by running the following command:
systemctl daemon-reload

Restart the Log Collector service.

Set the FIPS mode for the Log Collector service in the Ul:

Note: This step is not required if you are upgrading from 10.6.x to 11.x and FIPS was enabled in
10.6.x.

A
a. Goto (Admin) > Services.
b. Select the Log Collector service and go to View > Config.

c. In SSL FIPS Mode, select the checkbox under Config Value and click Apply.

FIPS support for Log Decoders and Decoders

To enable FIPS for Log Decoders and Decoders that did not have FIPS enabled in 10.6.x:

1.
2.

QA
Go to (Admin) > Services and select a Log Decoder or Network Decoder service.

Select View > Config, and in System Configuration, enable SSL FIPS Mode by selecting the
check box in the Config Value column.
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Hos

admin v

Event Sources  Endpoint Sources

LHYB - Log Decoder |  Config ©
Data Retention Scheduler ~ App Rules  Correlation Rules Feeds Parsers Parser Mappings Data Privacy ~ Appliance Service Configuration
Enable All Disable All
- ConfigValue y if relevant meta data is generated to disk (Enabled), gen: y in memary for other Decoder content use
(Transient], or not generated at all (Dissbled).
- Name Config Value
50002
# ALERTS Enabled
]
N # DOMAINSCAN Enabled
56002
. [ EMAILSCAN Enabled
1000
N # FeedParser Enabled
20
@ file_category Enabled -
Log Decoder Configuration R : .
< e Service Parsers Configuration Enable Al Disable Al
Name Config Value
Name Config Value
= Adapter
sccurey ™
Berkeley Packet Filter
antage =4
Capture Interface Selected log_events,Log B
actividentity =4
i Cache
sforecloudlink 4
Cache Direct: fvar/netwitness/logd
sirdefense ™
Cache 4GB
airmagnet O
= Capture Settings
.| | airtighmme ™
Assembler Maximim Size 3 MR .
e =
Apply

RS/ NETWITNE

3. Restart the service.

4. Click Apply.
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DISA STIG

Note: 11.3.1 feature - DISA STIG (Defense Information Systems Agency Security Technical
Implementation Guide) support was introduced in NetWitness Platform 11.3.1. Versions 11.0.0.0 to
11.3.0.0 do not support DISA STIG.

RSA NetWitness Platform version 11.3.1 supports all Audit Rules in the DISA STIG Control Group. The
supported version for DISA STIG is Red Hat Enterprise Linux V1R4. RSA will expand its support of
STIG rules in future NetWitness Platform versions.

This section includes the following topics.

How STIG Limits Account Access

NetWitness Passwords

Generate the OpenSCAP Report

Manage STIG Controls Script (manage-stig-controls)
Rules List

Exceptions to STIG Compliance

IMPORTANT: All rules are enabled by default except for control goup 1-ssh-prevent-root an
control group 3-fips-kernel. You can enable or disable rules by control group using the manage-
stig-controls script.

How STIG Limits Account Access

The STIG hardening RPM helps to lock down information, systems, and software, which might
otherwise be vulnerable to a malicious computer attack by limiting account access to a system. For
example, the STIG script:

« Ensures that the account password has a length, complexity, expiration period, and lockout period that
are in accordance with DISA best practices.

o Applies auditing and logging of user actions on the host.

NetWitness Passwords

RSA NetWitness Platform requires passwords that are STIG compliant.

Generate the OpenSCAP Report

Security Content Automation Protocol (SCAP) is a line of standards or rules managed by the National
Institute of Standards and Technology (NIST). It was created to provide a standardized approach to
maintaining the security of enterprise systems, such as automatically verifying the presence of patches,
checking system security configuration settings, and examining systems for signs of compromise.
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The OpenSCAP report evaluates your environment against the SCAP rules. The results are sent to the
HOSTNAME-ssg-results. (XML | HTML) depending on the output format you select.

Disable Rules in OpenSCAP Report that Hang the Report

There may be STIG rules that you do not want to include in the OpenSCAP report because they make
the report hang. Use the following command to disable items on the SCAP report:

sed -1 's/select idref="rule-id" selected="true"/select idref="rule-id"
selected="false"/g' /usr/share/xml/scap/ssg/content/ssg-rhel7-xccdf.xml

where rule-id is the Rule ID that you can replace with the Rule ID that may hang during a test.

For example, the report has a rule ID called partition for audit (shownas Rule ID:
partition for audit). If you disable a rule, OpenSCAP does not check against that rule. This
means that you need to check for compliance to the partition for audit rule manually.

Install OpenSCAP

Y ou must
1. SSH to the host.

2. Create a centos-Base.repo file under /etc/yum. repos.d directory.
The following example shows the contents of the centos-Base. repo file.

[base]

name=CentOS-$releasever - Base
mirrorlist=http://mirrorlist.centos.org/?release=Sreleasever&arch=S$basearch&repo=os
baseurl=http://mirror.centos.org/centos/$releasever/os/$basearch/

enabled=1

gpgcheck=1

gpgkey=file:///etc/pki/rpm-gpg/RPM-GPG-KEY-Cent0S-5

priority=1

freleased updates

[updates]

name=CentOS-$releasever - Updates
mirrorlist=http://mirrorlist.centos.org/?release=Sreleasever&arch=$basearché&repo=updates
baseurl=http://mirror.centos.org/centos/Sreleasever/updates/Sbasearch/

enabled=1

gpgcheck=1

gpgkey=file:///etc/pki/rpm-gpg/RPM-GPG-KEY-Cent0S-5

priority=1

#packages used/produced in the build but not released

[addons]

name=CentOS-$releasever - Addons
mirrorlist=http://mirrorlist.centos.org/?release=S$releasever&arch=$basearch&repo=addons
baseurl=http://mirror.centos.org/centos/Sreleasever/addons/Sbasearch/

enabled=0

gpgcheck=1
gpgkey=file:///etc/pki/rpm-gpg/RPM-GPG-KEY-Cent0S-5
priority=1

#additional packages that may be useful

[extras]

name=CentOS-$releasever - Extras
mirrorlist=http://mirrorlist.centos.org/?release=Sreleasever&arch=Sbasearché&repo=extras
baseurl=http://mirror.centos.org/centos/S$releasever/extras/Sbasearch/

enabled=1

gpgcheck=1

gpgkey=file:///etc/pki/rpm-gpg/RPM-GPG-KEY-Cent0S-5

priority=1

#additional packages that extend functionality of existing packages
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[centosplus]

name=CentOS-$releasever - Plus
mirrorlist=http://mirrorlist.centos.org/?release=Sreleasever&arch=$basearch&repo=centospl
us

baseurl=http://mirror.centos.org/centos/Sreleasever/centosplus/Sbasearch/

enabled=1

gpgcheck=1
gpgkey=file:///etc/pki/rpm-gpg/RPM-GPG-KEY-Cent0S-5
priority=2

#contrib - packages by Centos Users

[contrib]

name=CentOS-$releasever - Contrib
mirrorlist=http://mirrorlist.centos.org/?release=Sreleasever&arch=Sbasearché&repo=contrib
baseurl=http://mirror.centos.org/centos/S$releasever/contrib/S$basearch/

enabled=0

gpgcheck=1

gpgkey=file:///etc/pki/rpm-gpg/RPM-GPG-KEY-Cent0S-5

priority=2

3. Execute the following commands.
yum install openscap-scanner

yum install scap-security-guide

For fresh installs, the OpenSCAP report is on the Image.

Sample Report

The following report is a sample section from an OpenSCAP report.

_______________________________________________________________ Introduction e
Test Result
Start time End time Benchmark Benchmark version
xeedf org.open-scap testresult stig-rhel6-server.upstream stig-rthalf.server-upstream 2015-06-26 04:58 2015-06-26 04:59 embadded 0.9
Target info
Targets Addresses
« NWAPPLIANCE20809

Score

system
um:xcedfscormg:default 79.95 100.00 79.95%

Results overview

not selected not checked not applicable informational
153 0 49 0 173 19 0 0 ] 396

Ensure tmp Located On Separate Partition pass
Ensure var Located On Separate Partition pass
Ensure varlog Located On Separate Partition pass
Ensure 'varlog/audit Located On Separate Partition fail
Ensure 'home Located On Separate Partition pass
Encrypt Partitions notchecked
Ensure Red Hat GPG Key Installed fail
Ensure gpgcheck Enabled In Main Yum Configuration pass
Ensure gpgcheck Enabled For All Yum Package Reposttories fail
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Report Fields

N

Result ID The Extensible Configuration Checklist Description Format
(XCCDF) identifier of the report results.
Profile XCCDF profile under which the report results are categorized.
ek i Start time When the report started.
Lt 1ol End time When the report ended.
Benchmark  XCCDF benchmark
Benchmark  Version number of the benchmark.
version
Introduction - system XCCDF scoring method.
Score
score Score attained after running the report.
max Highest score attainable.
% Score attained after running the report as a percentage.
bar Not Applicable.
Results pass Passed rule check.
overview - Rule ) ) )
Results fixed Rule check that failed previously is now fixed.
Summary fail Failed rule check.
error Could not perform rule check.
not selected  This check was not applicable to your NetWitness Platform
deployment.
not checked  Rule could not be checked. There are several reasons why a rule
cannot be checked. For example, the rule check requires a check
engine not supported by the OpenSCAP report.
not Rule check does not apply to your NetWitness Platform deployment.
applicable
informational Rule checks for informational purposes only (no action required for
fail),
unknown Report was able to check the rule. Run steps manually as described
in the report to check the rule.
total Total number of rules checked.
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N

Exceptions Title Name of rule being checked.

Result Valid values are pass, fixed, fail error, not selected, not
checked, not applicable, informational or unknown.

Note: Results values are defined the Results overview - Rule
Results Summary.

Create the OpenSCAP Report

The following tasks show you how to create the OpenSCAP Report in HTML, XML, or both HTML and
XML.

Create Report in HTML Only

To create an OpenSCAP report in HTML only:
1. SSH to the host.
2. Submit the following command:
mkdir -p /opt/rsa/openscap
3. Submit the following command for report upgrades only:

sed -1 -r -e "s/<platform.*//g" /usr/share/xml/scap/ssg/content/ssg-rhel7-
xccdf . xml

4. Submit the following command:
oscap xccdf eval --profile "stig" --report
/opt/rsa/openscap/ hostname  .html --cpe
/usr/share/xml/scap/ssg/content/ssg-rhel7-cpe-dictionary.xml
/usr/share/xml/scap/ssg/content/ssg-rhel7-xccdf.xml

5. Report will be available under following location:

/opt/rsa/openscap/

Create Report in XML Only

To create an OpenSCAP report in xml only:
1. SSH to the host.
2. Submit the following command:
mkdir -p /opt/rsa/openscap
3. Submit the following command for report upgrades only:

sed -1 -r -e "s/<platform.*//g" /usr/share/xml/scap/ssg/content/ssg-rhel7-
xccdf . xml

4. Submit the following command:
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S.

oscap xccdf eval --profile "stig" --results

/opt/rsa/openscap/ hostname’ .xml --cpe /usr/share/xml/scap/ssg/content/ssg-
rhel7-cpe-dictionary.xml /usr/share/xml/scap/ssg/content/ssg-rhel7-
xccdf.xml

Report will be available under following location:
/opt/rsa/openscap/

Create Report in Both XML and HTML
To create an OpenSCAP report in both xml and html:

1.
2.

SSH to the host.

Submit the following command:

mkdir -p /opt/rsa/openscap

Submit the following command for report upgrades only:

sed -1 -r -e "s/<platform.*//g" /usr/share/xml/scap/ssg/content/ssg-rhel7-
xccdf . xml

Submit the following command:

oscap xccdf eval --profile "stig" --results

/opt/rsa/openscap/ hostname’ .xml --report /opt/rsa/openscap/ hostname .html
--cpe /usr/share/xml/scap/ssg/content/ssg-rhel7-cpe-dictionary.xml
/usr/share/xml/scap/ssg/content/ssg-rhel7-xccdf.xml

Report will be available under following location:
/opt/rsa/openscap/

Manage STIG Controls Script (manage-stig-controls)

You can use the manage-stig-controls script and its arguments to enable or disable STIG Control
groups for which you want to apply STIG configuration. You can specify all hosts or individual hosts as
arguments and you can enable or disable all control groups or individual control groups. This script is
available in /ust/bin/ directory.

To manage STIG controls for a host:

1.
2.

SSH to the NW Server host or use the Console from the NetWitness Platform User Interface.

Submit the manage-stig-controls script with the commands, control groups, and other arguments
you want to apply.

3. Reboot the host.
Commands
--enable-all-controls Enables all STIG controls. For example:

manage-stig-controls --enable-all-controls
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—-—-disable-all-controls

-—-enable-default-controls

—--enable-control-groups
<IDs>

—-—-disable-control-groups
<IDs>

Control Groups

Disables all STIG controls. For example:
manage-stig-controls --disable-all-controls

Enables all STIG Controls except ssh-prevent-root and fips-kernel.
For example:

manage-stig-controls --enable-default-controls

Enables (comma delimited) list of STIG Control GrouplDs. For

example:
manage-stig-controls --enable-control-groups '1l,
2, 3'

Disables (comma delimited) list of STIG Control Group IDs For
example:

manage-stig-controls --disable-control-groups '1l,
2, 3

You use the ID as an argument for the control group or groups.

Specified
Description
by Default
1 ssh-prevent-root Preyent root login through SSH. no
2 |ssh SSH STIG configuration. yes
3 fips-kernel FIPS Kernel configuration no
4 auth Authentication STIG configuration yes
5 audit Audit STIG configuration yes
6 packages RPM Package STIG configuration yes
7 services Services STIG configuration yes
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Other Arguments

pomen psserpten

--host-all

--skip-
health-
checks

--host-id
<id>

==IneSTt=
name
<display-
name>

--host-
addr
<Hostname-
in UI>

or

--host-
addr
<hostname>

N —
verbose

Apply STIG configuration to all hosts. For example:

manage-stig-controls --host-all

Disable health checks for all hosts (not recommended). For example:
manage-stig-controls --skip-health-checks

Apply STIG configuration for the host identified by <id> (host identification code). For

example:
manage-stig-controls --host-id <id>

Apply STIG configuration for host identified by <display-name>. display-name is

a4
the value shown under Name in the (Admin) > Hosts View in the NetWitness
Platform Interface. For example:

manage-stig-controls --host-name <display-name>

Apply STIG configuration for the host identified by the value shown under Hostname
Q

in the (Admin) > Hosts > Edit dialog in the NetWitness Platform Interface. This

value can be an ip-addres (default) or a user-specified name. For example:

manage-stig-controls --host-addr <hostname>

Edit Host

Name

112Core

Hostname <ip-address>

Cancel

You can change the
default <ip-address>to a
user-specific name.

Edit Host

Name

112Core

Hostname | N '.'.'Ser-.-e—l

Enable verbose output. For example:

manage-stig-controls -v
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Rules List

The following table lists all the STIG rules with their:

o Control Group - you can use the Control Group ID as an argument in the manage-stig-controls script
to expand on reduce the scope of rules checked. (1= ssh-prevent-root, 2 = ssh, 3 = fips-kernel, 4 =
auth, 5 = audit, 6 = packages, 7 = services)

o Default Status - tells you if the rule is enabled or disabled by default.

o Passed or Exception status - tells you if the rule passed (that is, complies with STIG) or is an
exception.

Control | Default | Passed/

CCE Number Rule Name .
Group Exception

CCE-26404-4 Ensure /var Located On n/a n/a Exception
Separate Partition

CCE-26631-2 Set Password Strength auth enabled Passed
Minimum Different
Characters

CCE-26828-4 Set GNOME Login n/a n/a Exception
Inactivity timeout

CCE-26884-7 Set Lockout Time For Failed auth enabled Exception
Password Attempts

CCE-26892-0 Set the GNOME3 Login n/a enabled Passed
Warning Banner Text

CCE-26923-3 Limit Password Reuse n/a enabled Passed

CCE-26952-2 Configure Periodic audit enabled Exception
Execution of AIDE

CCE-26970-4 Enable GNOMES3 Login audit enabled Passed
Warning Banner

CCE-26971-2 Ensure /var/log/audit audit enabled Exception
Located On Separate
Partition

CCE-26989-4 Ensure gpgcheck Enabled In  n/a enabled Passed
Main Yum Configuration

CCE-27002-5 Set Password Minimum Age n/a enabled Passed

CCE-27051-2 Set Password Maximum Age auth enabled Passed
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CCE Number

Rule Name

Control

Group

Default
Status

Passed/

Exception

CCE-27053-8

CCE-27082-7
CCE-27096-7
CCE-27127-0

CCE-27157-7

CCE-27160-1

CCE-27200-5

CCE-27209-6

CCE-27213-8

CCE-27214-6

CCE-27218-7

CCE-27275-7

CCE-27277-3

CCE-27279-9

CCE-27280-7

CCE-27286-4

CCE-27287-2

Set Password Hashing
Algorithm in
/etc/libuser.conf

Set SSH Client Alive Count
Install AIDE

Enable Randomized Layout
of Virtual Address Space

Verify File Hashes with
RPM

Set Password Retry Prompts
Permitted Per-Session

Set Password Strength
Minimum Uppercase
Characters

Verify and Correct File
Permissions with RPM

Record Events that Modify
the System's Discretionary
Access Controls - setxattr

Set Password Strength
Minimum Digit Characters

Remove the X Windows
Package Group

Set Last Logon/Access
Notification

Disable Modprobe Loading
of USB Storage Driver

Configure SELinux Policy

Record Events that Modify
the System's Discretionary
Access Controls - Isetxattr

Prevent Log In to Accounts
With Empty Password

Require Authentication for
Single User Mode

n/a

n/a

n/a

auth

n/a

audit

auth

n/a

n/a

services

n/a

audit

n/a

n/a

enabled

disabled
n/a
enabled

n/a

enabled

enabled

n/a

enabled

enabled

enabled

enabled

enabled

enabled

enabled

enabled

enabled

Passed

Passed
Exception

Exception

Exception

Passed

Passed

Exception

Passed

Passed

Passed

Passed

Exception

Passed

Passed

Passed

Passed
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Control | Default | Passed/

CCE Number Rule Name .
Group | Status | Exception

CCE-27293-0 Set Password Minimum auth enabled Passed
Length

CCE-27295-5 Use Only FIPS 140-2 n/a enabled Exception
Validated Ciphers

CCE-27297-1 Set Interval For Counting auth enabled Passed
Failed Password Attempts

CCE-27303-7 Modify the System Login ssh enabled Exception
Banner

CCE-27309-4 Set Boot Loader Password in n/a enabled Exception
grub2

CCE-27311-0 Verify Permissions on SSH  n/a enabled Passed
Server Public *.pub Key
Files

CCE-27314-4 Enable SSH Warning Banner ssh enabled Passed

CCE-27320-1 Allow Only SSH Protocol 2 n/a enabled Passed

CCE-27326-8 Ensure No Device Files are  n/a enabled Exception
Unlabeled by SELinux

CCE-27334-2 Ensure SELinux State is n/a enabled Exception
Enforcing

CCE-27339-1 Record Events that Modify audit enabled Passed

the System's Discretionary
Access Controls - chmod

CCE-27342-5 Uninstall rsh-server Package n/a enabled Passed

CCE-27343-3 Ensure Logs Sent To Remote n/a n/a Passed
Host

CCE-27345-8 Set Password Strength auth enabled Passed
Minimum Lowercase
Characters

CCE-27349-0 Set Default firewalld Zone n/a n/a Exception
for Incoming Packets

CCE-27350-8 Set Deny For Failed auth enabled Passed
Password Attempts

CCE-27351-6 Install the screen Package n/a enabled Passed
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CCE Number

Rule Name

Control

Group

Default
Status

Passed/

Exception

CCE-27353-2

CCE-27355-7

CCE-27356-5

CCE-27358-1

CCE-27360-7

CCE-27363-1

CCE-27364-9

CCE-27367-2

CCE-27375-5

CCE-27377-1

CCE-27386-2

CCE-27387-0

CCE-27388-8

CCE-27389-6

Record Events that Modify
the System's Discretionary
Access Controls -
fremovexattr

Set Account Expiration
Following Inactivity

Record Events that Modify
the System's Discretionary
Access Controls - fchown

Deactivate Wireless
Network Interfaces

Set Password Strength

Minimum Special Characters

Do Not Allow SSH
Environment Options

Record Events that Modify
the System's Discretionary
Access Controls - chown

Record Events that Modify
the System's Discretionary
Access Controls -
removexattr

Configure auditd space left
Action on Low Disk Space

Disable SSH Support for
.thosts Files

Ensure Default SNMP
Password Is Not Used

Record Events that Modify
the System's Discretionary
Access Controls - fchownat

Record Events that Modify
the System's Discretionary
Access Controls - fchmodat

Record Events that Modify
the System's Discretionary
Access Controls - fsetxattr

audit

n/a

audit

n/a

auth

ssh

audit

audit

audit

n/a

n/a

audit

audit

audit

enabled

enabled

enabled

enabled

enabled

enabled

enabled

enabled

enabled

enabled

n/a

enabled

enabled

enabled

Passed

Passed

Passed

Passed

Passed

Passed

Passed

Passed

Passed

Passed

Exception

Passed

Passed

Passed
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CCE Number

CCE-27389-6

CCE-27393-8

CCE-27394-6

CCE-27399-5
CCE-27401-9

CCE-27407-6
CCE-27410-0

CCE-27413-4

CCE-27433-2

CCE-27434-0

CCE-27437-3

CCE-27445-6
CCE-27447-2

CCE-27455-5

CCE-27458-9

Rule Name

Record Events that Modify
the System's Discretionary
Access Controls - ichown

Record Events that Modify
the System's Discretionary
Access Controls - fchmod

Configure auditd mail acct
Action on Low Disk Space

Uninstall ypserv Package

Uninstall telnet-server
Package

Enable auditd Service

Record Events that Modify
the System's Discretionary
Access Controls -
Iremovexattr

Disable Host-Based
Authentication

Set SSH Idle Timeout
Interval

Configure Kernel Parameter
for Accepting IPv4 Source-
Routed Packets for All
Interfaces

Ensure auditd Collects
Information on the Use of
Privileged Commands

Disable SSH Root Login

Ensure auditd Collects
Information on Exporting to
Media (successful)

Use Only FIPS 140-2
Validated MACs

Mount Remote Filesystems
with Kerberos Security

Control

Group

audit

audit

audit

n/a

audit

audit

ssh

n/a

audit

n/a

audit

n/a

n/a

Default
Status

enabled

enabled

enabled

enabled
enabled

enabled
enabled

enabled

enabled

enabled

enabled

n/a
enabled

enabled

enabled

Passed/

Exception

Passed

Passed

Passed

Passed

Passed

Passed

Passed

Passed
Passed

Passed

Passed

Exception

Passed

Passed

Passed
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CCE Number

Rule Name

Control

Group

Default
Status

Passed/

Exception

CCE-27461-3

CCE-27471-2

CCE-27485-2

CCE-27498-5

CCE-27503-2

CCE-27511-5

CCE-27512-3

CCE-27557-8

CCE-80104-3

CCE-80105-0
CCE-80108-4

CCE-80110-0

CCE-80111-8

CCE-80112-6

CCE-80127-4

CCE-80129-0

CCE-80134-0

Ensure auditd Collects
System Administrator
Actions

Disable SSH Access via
Empty Passwords

Verify Permissions on SSH
Server Private * key Key
Files

Disable the Automounter

All GIDs referenced in
/etc/passwd must be defined
in /etc/group

Disable Ctrl-Alt-Del Reboot
Activation

Set Password Maximum
Consecutive Repeating
Characters

Set Interactive Session
Timeout

Disable GDM Automatic
Login

Disable GDM Guest Login

Enable the GNOME3 Login
Smartcard Authentication

Set GNOMES3 Screensaver
Inactivity Timeout

Enable GNOME3
Screensaver Idle Activation

Enable GNOME3
Screensaver Lock After Idle
Period

Install McAfee Virus
Scanning Software

Virus Scanning Software
Definitions Are Updated

Ensure All Files Are Owned
by a User

audit

n/a

n/a

n/a
n/a

services

n/a

auth

n/a

enabled

enabled

n/a

enabled

enabled

enabled

enabled

disabled

enabled

enabled
enabled

enabled

enabled

enabled

enabled

Passed

Exception

Passed

Passed

Passed

Passed

Passed

Passed

Passed

Passed

Passed

Passed

Passed

Passed

Exception

Exception

Passed
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CCE Number

Rule Name

Control

Group

Default | Passed/

CCE-80135-7

CCE-80136-5

CCE-80144-9

CCE-80148-0

CCE-80156-3

CCE-80157-1

CCE-80158-9

CCE-80162-1

CCE-80163-9

CCE-80165-4

CCE-80174-6

CCE-80179-5

CCE-80192-8

CCE-80205-8

Ensure All Files Are Owned
by a Group

Ensure All World-Writable
Directories Are Owned by a
System Account

Ensure /home Located On
Separate Partition

Add nosuid Option to
Removable Media Partitions

Disable Kernel Parameter
for Sending ICMP Redirects
for All Interfaces

Disable Kernel Parameter
for [P Forwarding

Configure Kernel Parameter
for Accepting ICMP
Redirects for All Interfaces

Configure Kernel Parameter
for Accepting Source-Routed
Packets By Default

Configure Kernel Parameter
for Accepting ICMP
Redirects By Default

Configure Kernel Parameter
to Ignore ICMP Broadcast
Echo Requests

Ensure System is Not Acting
as a Network Sniffer

Configure Kernel Parameter
for Accepting IPv6 Source-
Routed Packets for All
Interfaces

Ensure rsyslog Does Not
Accept Remote Messages
Unless Acting As Log
Server

Ensure the Default Umask is
Set Correctly in login.defs

n/a

n/a

n/a

n/a

n/a

Status | Exception
enabled Passed
enabled Passed
enabled Passed
enabled Passed
n/a Exception
n/a Exception
n/a Exception
enabled Passed
n/a Exception
n/a Exception
enabled Passed
n/a Exception
enabled Passed
enabled Passed
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Control | Default | Passed/

CCE Number Rule Name .
Group | Status | Exception

CCE-80207-4 Enable Smart Card Login n/a n/a Exception

CCE-80213-2 Uninstall tftp-server Package n/a enabled Passed

CCE-80214-0 Ensure tftp Daemon Uses n/a enabled Passed
Secure Mode

CCE-80215-7 Install the OpenSSH Server  n/a enabled Passed
Package

CCE-80216-5 Enable the OpenSSH n/a enabled Passed
Service

CCE-80220-7 Disable GSSAPI ssh enabled Passed
Authentication

CCE-80221-5 Disable Kerberos n/a enabled Passed
Authentication

CCE-80222-3 Enable Use of Strict Mode n/a enabled Passed
Checking

CCE-80223-1 Enable Use of Privilege n/a enabled Passed
Separation

CCE-80224-9 Disable Compression Or Set n/a enabled Passed
Compression to delayed

CCE-80225-6 Print Last Log n/a enabled Exception

CCE-80226-4 Enable Encrypted X11 n/a n/a Exception
Forwarding

CCE-80240-5 Mount Remote Filesystems  n/a enabled Passed
with nosuid

CCE-80245-4 Uninstall vsftpd Package n/a enabled Passed

CCE-80258-7 Disable KDump Kernel services enabled Passed
Crash Analyzer (kdump)

CCE-80346-0 Ensure YUM Removes packages enabled Passed
Previous Package Versions

CCE-80347-8 Ensure gpgcheck Enabled for packages enabled Passed
Local Packages

CCE-80348-6 Ensure gpgcheck Enabled for n/a n/a Exception
Repository Metadata
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CCE Number

Rule Name

Control

Group

Default | Passed/

CCE-80350-2

CCE-80351-0

CCE-80352-8

CCE-80353-6

CCE-80354-4

CCE-80359-3

CCE-80370-0

CCE-80371-8

CCE-80372-6

CCE-80373-4

CCE-80374-2

CCE-80375-9

CCE-80376-7

CCE-80377-5

Ensure Users Re-
Authenticate for Privilege
Escalation - sudo
lauthenticate

Ensure Users Re-
Authenticate for Privilege
Escalation - sudo
NOPASSWD

Ensure the Logon Failure
Delay is Set Correctly in
login.defs

Configure the root Account
for Failed Password
Attempts

Set the UEFI Boot Loader
Password

Enable FIPS Mode in
GRUB2

Set GNOMES3 Screensaver
Lock Delay After Activation
Period

Ensure Users Cannot
Change GNOME3
Screensaver Settings

Disable SSH Support for
User Known Hosts

Disable SSH Support for
Rhosts RSA Authentication

Configure Notification of
Post-AIDE Scan Details

Configure AIDE to Verify
Access Control Lists
(ACLs)

Configure AIDE to Verify
Extended Attributes

Configure AIDE to Use
FIPS 140-2 for Validating
Hashes

n/a

n/a

auth

auth

fips-
kernel

fips-
kernel

n/a

n/a

ssh

audit

n/a

n/a

n/a

n/a

Status | Exception
enabled Passed
enabled Passed
enabled Passed
enabled Passed
disabled Passed
disabled Exception
enabled Passed
enabled Passed
enabled Passed
enabled Passed
n/a Exception
n/a Exception
n/a Exception
n/a Exception
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CCE Number

Rule Name

Control

Group

Default
Status

Passed/

Exception

CCE-80378-3

CCE-80379-1

CCE-80380-9

CCE-80381-7

CCE-80382-5

CCE-80383-3

CCE-80384-1

CCE-80385-8

CCE-80386-6

CCE-80387-4

CCE-80388-2

CCE-80389-0

CCE-80390-8

CCE-80391-6

Verify User Who Owns
/etc/cron.allow file

Verity Group Who Owns
/etc/cron.allow file

Ensure cron Is Logging To
Rsyslog

Shutdown System When
Auditing Failures Occur

Record Attempts to Alter
Logon and Logout Events -
tallylog

Record Attempts to Alter
Logon and Logout Events -
faillock

Record Attempts to Alter
Logon and Logout Events -
lastlog

Record Unauthorized
Access Attempts to Files
(unsuccessful) - creat

Record Unauthorized
Access Attempts to Files
(unsuccessful) - open

Record Unauthorized
Access Attempts to Files
(unsuccessful) - openat

Record Unauthorized
Access Attempts to Files
(unsuccessful) - open_by
handle at

Record Unauthorized
Access Attempts to Files
(unsuccessful) - truncate

Record Unauthorized
Access Attempts to Files
(unsuccessful) - ftruncate

Record Any Attempts to Run
semanage

n/a

n/a

n/a

audit

audit

n/a

audit

audit

audit

audit

audit

audit

audit

audit

enabled

enabled

enabled

enabled

enabled

enabled

enabled

enabled

enabled

enabled

enabled

enabled

enabled

Passed

Passed

Passed

Passed

Passed

Passed

Passed

Passed

Passed

Passed

Passed

Passed

Passed

Passed
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Control | Default | Passed/

CCE Number Rule Name .
Group | Status | Exception
CCE-80392-4 Record Any Attempts to Run audit enabled Passed
setsebool
CCE-80393-2 Record Any Attempts to Run audit enabled Passed
chcon
CCE-80395-7 Ensure auditd Collects audit enabled Passed

Information on the Use of
Privileged Commands -
passwd

CCE-80396-5 Ensure auditd Collects audit enabled Passed
Information on the Use of
Privileged Commands -
unix_chkpwd

CCE-80397-3 Ensure auditd Collects audit enabled Passed
Information on the Use of
Privileged Commands -
gpasswd

CCE-80398-1 Ensure auditd Collects audit enabled Passed
Information on the Use of
Privileged Commands -
chage

CCE-80399-9 Ensure auditd Collects audit enabled Passed
Information on the Use of
Privileged Commands -
userhelper

CCE-80400-5 Ensure auditd Collects audit enabled Passed
Information on the Use of
Privileged Commands - su

CCE-80401-3 Ensure auditd Collects audit enabled Passed
Information on the Use of
Privileged Commands - sudo

CCE-80402-1 Ensure auditd Collects audit enabled Passed
Information on the Use of
Privileged Commands -
sudoedit

CCE-80403-9 Ensure auditd Collects audit enabled Passed
Information on the Use of
Privileged Commands -

newgrp
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Control | Default | Passed/
CCE Number Rule Name

Group | Status | Exception

CCE-80404-7 Ensure auditd Collects audit enabled Passed
Information on the Use of
Privileged Commands - chsh

CCE-80405-4 Ensure auditd Collects audit enabled Passed
Information on the Use of
Privileged Commands -
umount

CCE-80406-2 Ensure auditd Collects audit enabled Passed
Information on the Use of
Privileged Commands -
postdrop

CCE-80407-0 Ensure auditd Collects audit enabled Passed
Information on the Use of
Privileged Commands -
postqueue

CCE-80408-8 Ensure auditd Collects audit enabled Passed
Information on the Use of
Privileged Commands - ssh-

keysign

CCE-80410-4 Ensure auditd Collects audit enabled Passed
Information on the Use of
Privileged Commands -
crontab

CCE-80411-2 Ensure auditd Collects audit enabled Passed
Information on the Use of
Privileged Commands -
pam_timestamp_check

CCE-80412-0 Ensure auditd Collects File audit enabled Passed
Deletion Events by User -
rmdir

CCE-80413-8 Ensure auditd Collects File audit enabled Passed
Deletion Events by User -
renameat

CCE-80414-6 Ensure auditd Collects audit enabled Passed
Information on Kernel
Module Loading - init
module
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CCE Number

Rule Name

Control

Group

Default
Status

Passed/

Exception

CCE-80415-3

CCE-80430-2

CCE-80431-0

CCE-80432-8

CCE-80433-6

CCE-80434-4

CCE-80435-1

CCE-80436-9

CCE-80437-7

CCE-80438-5

CCE-80439-3

CCE-80447-6

CCE-80513-5

CCE-80514-3

Ensure auditd Collects
Information on Kernel
Module Unloading - delete
module

Record Events that Modify
User/Group Information -
/etc/security/opasswd

Record Events that Modify
User/Group Information -
/etc/shadow

Record Events that Modify
User/Group Information -
/etc/gshadow

Record Events that Modify
User/Group Information -
/etc/group

Ensure Home Directories
are Created for New Users

Record Events that Modify
User/Group Information -
/etc/passwd

Mount Remote Filesystems
with noexec

Configure PAM in SSSD
Services

Configure Multiple DNS
Servers in /etc/resolv.conf

Configure Time Service
Maxpoll Interval

Configure the Firewalld
Ports

Remove Host-Based
Authentication Files

Remove User Host-Based
Authentication Files

audit

audit

audit

audit

audit

n/a

audit

n/a

services

enabled

enabled

enabled

enabled

enabled

enabled

enabled

enabled

n/a

n/a

enabled

n/a

enabled

enabled

Passed

Passed

Passed

Passed

Passed

Passed

Passed

Passed

Exception

Exception

Passed

Exception

Passed

Passed
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Control | Default | Passed/

CCE Number Rule Name .
Group | Status | Exception
CCE-80515-0 Configure SSSD LDAP n/a n/a Exception
Backend Client CA
Certificate Location
CCE-80519-2 Install Smart Card Packages n/a n/a Exception
For Multifactor
Authentication
CCE-80537-4 Configure auditd space left  audit enabled Passed

on Low Disk Space

CCE-80544-0 Ensure Users Cannot n/a enabled Passed
Change GNOME3 Session
Idle Settings

CCE-80545-7 Verify and Correct n/a n/a Exception
Ownership with RPM

CCE-80546-5 Configure SSSD LDAP n/a n/a Exception
Backend to Use TLS For All
Transactions

CCE-80547-3 Ensure auditd Collects audit enabled Passed

Information on Kernel
Module Loading and
Unloading - finit_ module

CCE-80563-0 Ensure Users Cannot n/a enabled Passed
Change GNOME3
Screensaver Lock After Idle
Period

CCE-80564-8 Ensure Users Cannot n/a enabled Passed
Change GNOME3
Screensaver Idle Activation

CCE-80660-4 Record Any Attempts to Run audit enabled Exception
setfiles
CCE-80661-2 Ensure auditd Collects audit enabled Exception

Information on Kernel
Module Loading - create
module

CCE-80995-4 Ensure auditd Collects File audit enabled Passed
Deletion Events by User -
rename

CCE-80996-2 Ensure auditd Collects File audit enabled Passed
Deletion Events by User -
unlinkat
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Control | Default | Passed/

CCE Number Rule Name .
Group | Status | Exception
CCE-80998-8 Verify firewall Enabled n/a n/a Exception
CCE-811006-7 Ensure auditd Collects File  audit enabled Passed
Deletion Events by User -
unlink
CCE-81153-9 Add nosuid Option to /home  n/a enabled Passed
CCE-82020-9 Set Password Strength auth enabled Passed
Minimum Different
Characters
CCE-82024-1 Disable DCCP Support n/a n/a Passed
CCE-82030-8 Limit Password Reuse n/a enabled Passed
CCE-82035-7 Ensure /var/log/audit audit enabled Exception
Located On Separate
Partition
CCE-82036-5 Set Password Minimum Age n/a enabled Passed
CCE-82038-1 Set Password Hashing n/a enabled Passed
Algorithm in
/etc/libuser.conf
CCE-82041-5 Limit the Number of auth enabled Passed
Concurrent Login Sessions
Allowed Per User
CCE-82043-1 Set PAM's Password n/a enabled Passed
Hashing Algorithm
CCE-82045-6 Set Password Strength audit enabled Passed
Minimum Different
Categories
CCE-82050-6 Set Password Hashing n/a enabled Passed
Algorithm in /etc/login.defs
CCE-82053-0 Ensure /tmp Located On n/a n/a Exception
Separate Partition
CCE-82054-8 Verify Only Root Has UID 0 n/a enabled Passed
CCE-82353-4 Ensure /var Located On n/a n/a Exception

Separate Partition
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Exceptions to STIG Compliance

This topic contains:
o Rule exceptions that are the responsibility of the customer to resolve.

o Rule exceptions that are "Not a Finding" which means that they do not apply to NetWitness Platform.
RSA has verified that the system meets these requirements.

¢ Rules to be supported in future release.

Key to Elements in Exception Descriptions

CCE Number

The Common Configuration Enumeration (CCE), assigns unique entries (also called CCE numbers) to
configuration guidance statements and configuration controls to improve workflow by facilitating fast and
accurate correlation of configuration issues present in disparate domains. In this way, it is similar to
other comparable data standards such as the Common Vulnerability and Exposure (CVE®) List
(http://cve.mitre.org/cve), which assigns identifiers to publicly known system vulnerabilities. The
OpenSCAP report lists exceptions by CCE number.

This sections lists the exceptions you can receive when you run the OpenSCAP report. The ID or
Common Configuration Enumeration (CCE) number in the table is the identification number for the
exception from the OpenSCAP report.

Control Group ID

Number that identifies the control group you specify in the manage-stig-controls script to enable or
disable the rule.

Specified
Description
by Default
1 ssh-prevent-root Preyent root login through SSH. no
2 ssh SSH STIG configuration. yes
3 fips-kernel FIPS Kernel configuration no
4 auth Authentication STIG configuration yes
5 audit Audit STIG configuration yes
6 packages RPM Package STIG configuration yes
7 services Services STIG configuration yes
Check

Describes what the rule checks to identify exceptions to DISA STIG compliance.
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Comments

Provides insight on why you would receive this exception. This section includes one of the following
comments that describes the exception:

o Customer Responsibility - You are responsible to make sure the system meets this requirement.

« Not a Finding - Exception does not apply to NetWitness Platform. RSA has verified that the system
meets this requirement.

o Future Feature - NetWitness Platform does not meet this requirement. RSA plans to fix this in a
future release of NetWitness Platform.

Customer Responsibility Exceptions

CCE-26952-2 Configure Periodic Execution of AIDE (Control Group = audit)

At a minimum, configure AIDE to run a weekly scan and at most, daily. To implement a
daily execution of AIDE at 4:05am using cron, add the following line to the
/etc/crontab file:
05 4 * * * root /usr/sbin/aide --check

Check  To implement a weekly execution of AIDE at 4:05am using cron, add the following line
to the /etc/crontab file:
05 4 * * 0 root /usr/sbin/aide --check
AIDE can be executed periodically through other means; this is merely one example.
The usage of cron's special time codes, such as @daily and @weekly is acceptable.

Customer Responsibility. NetWitness Platform does not provide AIDE because it has a
Comments negative impact on performance. If you must install it, run as infrequently as possible to
adhere to your security policy.

CCE-27096-7 Install AIDE (Control Group = n/a)

Check  Install the AIDE package with the following command: $ sudo yum install aid

Customer Responsibility. NetWitness Platform does not provide AIDE because it has a
Comments negative impact on performance. If you must install it, run as infrequently possible to
adhere to your security policy.

CCE-27218-7 Remove the X Windows Package Group

The Rule CCE-27218-7 "Remove the X Windows Package Group" is an exception for
Check .
Log Collector and Log Decoder services.

Customer Responsibility.L.og Collector plugin collection framework uses SELinux
Comments sandbox technology that has a direct dependency on the given rpm. Removing of the rpm
will lead to loss of plugin collection functionality in Log Collector service.
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CCE-27295-5 Use Only FIPS 140-2 Validated Ciphers (Control Group = n/a)

Limit the ciphers to those algorithms which are FIPS-approved. Counter (CTR) mode is
also preferred over cipher-block chaining (CBC) mode. The following line in
/etc/ssh/sshd _config demonstrates use of FIPS 140-2 validated ciphers:

Ciphers aesl28-ctr,aesl92-ctr,aes256-ctr

Check The following ciphers are FIPS 140-2 certified on RHEL 7:

- aesl28-ctr - aesl92-ctr - aes256-ctr - aesl28-cbc - aesl92-cbc
- aes256-cbc - 3des-cbc - rijndael-cbc@lysator.liu.se

Any combination of the above ciphers will pass this check. Official FIPS 140-2
paperwork for RHEL7 can be found at
http://csrc.nist.gov/groups/STM/cmvp/documents/140-1/140sp/140sp2630.pdf.

Testing approach results in failed test, but the ciphers defined meet the STIG Rule

Comments definition. You can check cipher under this file:
/etc/ssh/sshd_config

CCE-27326-8 Ensure No Device Files are Unlabeled by SELinux

Check To check for unlabeled device files, run the following command:
§$ sudo find /dev -context :device t: ( -type ¢ -o -type b ) -printf "%p %Z\n".

It should produce no output in a well-configured system."

Comments The addition of External Storage may result in unlabeled SELinux driver files such as:
o /dev/megaraid sas_ioctl node

o /dev/wmi/dell-smbios

CCE-27334-2 Ensure SELinux State is Enforcing

Check Ensure SELinux State is Enforcing.

SELinux state is default it is set to 'permissive’ by default for all the NetWitness

S Platform hosts instead of 'Enforcing' due to performance impact.

CCE-27445-6 Disable SSH Root Login (Control Group = ssh-prevent-root)
Check The root user should never be allowed to login to a system directly over a network.
Customer Responsibility. Disable root login through SSH by adding or editing the

Comments following line in the /etc/ssh/sshd config file:
PermitRootLoginNetWitness.
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CCE-80127-4 Install McAfee Virus Scanning Software (Control Group = n/a)

Install McAfee VirusScan Enterprise for Linux antivirus software which is provided for

Clieds DoD systems and uses signatures to search for the presence of viruses on the filesystem.

Customer Responsibility. Install virus scanning software. RSA does not provide this

Comments
software.

CCE-80129-0 Virus Scanning Software Definitions Are Updated (Control Group =

n/a)

Check  Make sure that virus definition files are no older than 7 days or their last release.

Comments Customer Responsibility. RSA does not provide this software.

CCE-80207-4 Enable Smart Card Login (Control Group = n/a)

For guidance on enabling SSH to authenticate against a Common Access Card (CAC),
consult documentation at: https://access.redhat.com/documentation/en-US/Red Hat
Enterprise Linux/7/html/System-Level Authentication
Guide/smartcards.html#authconfig-smartcards https://access.redhat.com/solutions/82273

Check

Customer Responsibility. The NetWitness Platform supports username/certificate for
Comments authentication to shell. If you want to configure a smart card log in, you must do this
outside of RSA NetWitness.

CCE-80359-3 Enable FIPS Mode in GRUB2 (Control Group = fips-kernel)

To ensure FIPS mode is enabled, install the dracut-fips package and rebuild
initramfs by running the following commands:

$ sudo yum install dracut-fips dracut -f
After the dracut command has been run, add the fips=1 argument to the default

GRUB 2 command line for the Linux operating system inthe /etc/default/grub
file as shown in the following example:

Check GRUB_CMDLINE LINUX='crashkernel=auto rd.lvm.lv=VolGroup/LogVol06
rd.lvm.lv=VolGroup/lv_swap rhgb quiet rd.shell=0 fips=1"

Finally, rebuild the grub. cfg file by using the grub2-mkconfig -o command as
follows ( On BIOS-based machines, issue the following command as root):

~]1# grub2-mkconfig -o /boot/grub2/grub.cfg

On UEFI-based machines, issue the following command as root:
~]1# grub2-mkconfig -o /boot/efi/EFI/redhat/grub.cfg

Customer Responsibility. NetWitness Platform does not enabled by default. You can

DRI enable FIPS by following the procedures in the Configure FIPS Support,
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CCE-80374-2 Configure Notification of Post-AIDE Scan Details (Control Group =

n/a)

AIDE should notify appropriate personnel of the details of a scan after the scan has been
run. If AIDE has already been configured for periodic execution in the /etc/crontab
file, append the following line to the existing AIDE line:

Check | /bin{mail =S '$(ho§tn§me) - AIDE Integrity Check' root@localhost
Otherwise, add the following line to the /etc/crontab file:
05 4 * * * root /usr/sbin/aide --check | /bin/mail -s
'S (hostname) - AIDE Integrity Check' root@localhost

AIDE can be executed periodically through other means. This is just one example.

Customer Responsibility. NetWitness Platform does not provide AIDE because it has a
Comments negative impact on performance. If you must install it, run as infrequently possible to
adhere to your security policy.

CCE-80375-9 Configure AIDE to Verify Access Control Lists (Control Group = n/a)

By default, the ac1 option is added to the FIPSR ruleset in AIDE. If using a custom

ruleset or the ac1 option is missing, add ac1 to the appropriate ruleset. For example,
Check add ac1 to the following line in the /etc/aide. conf file:

FIPSR = p+i+n+tutgts+m+ctacl+selinux+xattrs+sha256

AIDE rules can be configured in multiple ways; this is merely one example that is

already configured by default.

Customer Responsibility. NetWitness Platform does not provide AIDE because it has a
Comments negative impact on performance. If you must install it, run as infrequently possible to
adhere to your security policy.

CCE-80376-7 Configure AIDE to Verify Extended Attributes (Control Group = n/a)

By default, the xattrs option is added to the FIPSR ruleset in AIDE. If using a custom

ruleset or the xattrs option is missing, add xattrs to the appropriate ruleset. For
Check example, add xattrs to the following line in the /etc/aide.conf file:

FIPSR = pt+itnt+utgts+mt+ctacl+selinuxt+xattrs+sha256

AIDE rules can be configured in multiple ways. This is just one example that is already

configured by default.

Customer Responsibility. NetWitness Platform does not provide AIDE because it has a
Comments negative impact on performance. If you must install it, run as infrequently possible to
adhere to your security policy.
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CCE-80377-5 Configure AIDE to Use FIPS 140-2 for Validating Hashes (Control

Group = n/a)

By default, the sha512 option is added to the ORMAL ruleset in AIDE. If using a custom
ruleset orthe sha512 option is missing, add sha512 to the appropriate ruleset. For
example, add sha512 to the following line in the /etc/aide.conf file:ORMAL =
FIPSR+shab12

AIDE rules can be configured in multiple ways; this is merely one example that is
already configured by default.

Check

Customer Responsibility. NetWitness Platform does not provide AIDE because it has a
Comments negative impact on performance. If you must install it, run as infrequently possible to
adhere to your security policy.

CCE-80519-2 Install Smart Card Packages For Multi-Factor Authentication (Control

Group = n/a)

Configure the operating system to implement multifactor authentication by installing the

Check  required packages with the following command:
$ sudo yum install esc pam pkcsll authconfig-gtk

Customer Responsibility. The NetWitness Platform supports username/certificate for
Comments authentication to shell. If you want to configure a smart card log in, you must do this
outside of RSA NetWitness.

Exceptions That Are Not a Finding

The following exceptions do not apply to NetWitness Platform. RSA has verified that the system meets
these requirements.

CCE-26404-4 Ensure /var Located On Separate Partition (Control Group = n/a)

The /var directory is used by daemons and other system services to store frequently-
Check  changing data. Ensure that /var has its own partition or logical volume at installation
time, or migrate it using LVM.

Not a Finding.NetWitness software is installed in /var/netwitness by default and

Comments .. ,
has a separate partition on /var/netwitness.

CCE-26828-4 Set GNOME Login Inactivity timeout (Control Group = n/a)

Verify that the GNOME Login Inactivity Timeout is set on the host (The graphical

S desktop environment must set the idle timeout to no more than 15 minutes.).

Not a Finding. NetWitness Platform does not use Gnome Graphical User Interface

Comments (GUI) Desktop.

DISA STIG 189



System Maintenance Guide

CCE-26884-7 Set Lockout Time For Failed Password Attempts (Control Group =

auth)

Check

To configure the system to lock out accounts after a number of incorrect login attempts
and require an administrator to unlock the account using pam faillock.so, modify
the content of both /etc/pam.d/system-auth and /etc/pam.d/password-auth
by adding the following line immediately before the pam unix.so statement in the
AUTH section:

auth required pam faillock.so preauth silent deny= unlock time=
fail interval=

Add the following line immediately after the pam unix.so statement in the AUTH
section:

auth [default=die] pam faillock.so authfail deny= unlock time=
fail interval=

Add the following line immediately before the pam unix.so statement in the ACCOUNT
section:

account required pam faillock.s

Comments Not a Finding. root unlock time is setto 600 seconds.

CCE-26971-2 Ensure /var/log/audit Located On Separate Partition (Control Group

= audit)

Check

Comments

Audit logs are stored in the /var/log/audit directory. Ensure that it has its own
partition or logical volume at installation time, or migrate it later using LVM. Make
absolutely certain that it is large enough to store all audit logs that will be created by the
auditing daemon.

Not a Finding.NetWitness Platform has the /var/log directory as a separate
partition.

CCE-27127-0 Enable Randomized Layout of Virtual Address Space (Control Group

=n/a)
To set the runtime status of the kernel.randomize va space kernel parameter, run
the following command:

Check $ sudo sysctl -w kernel.randomize va space=2

If this is not the system default value, add the following line to the
/etc/sysctl.conf file:
kernel.randomize va space = 2

Comments Not a Finding. Value of /proc/sys/kernel/randomize va_space is already 2.
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CCE-27157-7 Verify File Hashes with RPM (Control Group = n/a)

Check

Comments

Without cryptographic integrity protections, system executables and files can be altered
by unauthorized users without detection. The RPM package management system can
check the hashes of installed software packages, including many that are important to
system security. To verify that the cryptographic hash of system files and commands
match vendor values, run the following command to list which files on the system with
hashes that differ from what is expected by the RPM database:

$ rpm -Va | grep '*..5'" A 'c¢'

in the second column indicates that a file is a configuration file, which may
appropriately be expected to change. If the file was not expected to change, investigate
the cause of the change using audit logs or other means. The package can then be
reinstalled to restore the file. Run the following command to determine which package
owns the file:

$ rpm -gf
The package can be reinstalled from a yum repository using the command:

FILENAME $ sudo yum reinstall

Alternatively, the package can be reinstalled from trusted media using the command:
PACKAGENAME $ sudo rpm -Uvh PACKAGENAME

Not a Finding. Only mismatched files not marked as config files in rpms are

Commercial Off the Shelf (COTS) product based that cannot be updated.

Most File Hash/RPM combinations are in sync. Any discrepancies are COTS products
that cannot be updated.

CCE-27339-1 Record Events that Modify the System's Discretionary Access

Controls -chmod

Verify that the host records events that modify the system's discretionary access

Check controls - chown.
Not a Finding. Make sure that you have the correct chown configuration on the host.
The following settings are the correct configuration.
[root@localhost nwadmin]# grep chown /etc/audit/*
/etc/audit/audit.rules:-a exit,always -F arch=b64 -S chown -S
chmod -S fchmod -S fchmodat -S fchown -S fchownat -S fremovexattr
-S fsetxattr -S lchown -S lremovexattr -S lremovexattr -S
Comments lsetxattr -S removexattr -S setxattr -F auid>=500 -F
auid!=4294967295 -k perm mod
/etc/audit/audit.rules:-a exit,always -F arch=b32 -S chown -S
fchmod -S fchmodat -S fchown -S fchownat -S fremovexattr -S
fsetxattr -S lchown -S lremovexattr -S lremovexattr -S lsetxattr
-S removexattr -S setxattr -F auid>=500 -F auid!=4294967295 -k
perm mod
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CCE-27209-6 Verify and Correct File Permissions with RPM (Control Group = n/a)

Comments

Check

The RPM package management system can check file access permissions of installed
software packages, including many that are important to system security. Verify that the
file permissions of system files and commands match vendor values. Check the file
permissions with the following command:

$ sudo rpm -Va | grep '~.M'

Output indicates files that do not match vendor defaults. After locating a file with

incorrect permissions, run the following command to determine which package owns it:
S rpm -gf FILENAME

Next, run the following command to reset its permissions to the correct values:
$ sudo rpm --quiet --setperms PACKAGENAME

Not a Finding. The file permissions do not match the rpm, they are configured to be
stricter during configuration management.

CCE-27303-7 (Control ID = 2) Modify the System Login Banner (Control Group =
ssh)

Check

To configure the system login banner edit the /etc/1issue file. Replace the default
text with a message compliant with the local site policy or a legal disclaimer. The DoD
required text is either:

" You are accessing a U.S. Government (USG) Information System (IS) that is
provided for USG-authorized use only. By using this IS (which includes any device
attached to this IS), you consent to the following conditions:

o The USG routinely intercepts and monitors communications on this IS for purposes
including, but not limited to, penetration testing, COMSEC monitoring, network
operations and defense, personnel misconduct (PM), law enforcement (LE), and
counterintelligence (CI) investigations.

o At any time, the USG may inspect and seize data stored on this IS.

o Communications using, or data stored on, this IS are not private, are subject to
routine monitoring, interception, and search, and may be disclosed or used for any
USG-authorized purpose.

« This IS includes security measures (e.g., authentication and access controls) to
protect USG interests -- not for your personal benefit or privacy. -Notwithstanding
the above, using this IS does not constitute consent to PM, LE or CI investigative
searching or monitoring of the content of privileged communications, or work
product, related to personal representation or services by attorneys, psychotherapists,
or clergy, and their assistants. Such communications and work product are private
and confidential. See User Agreement for details."

or

" I've read & consent to terms in IS user agreem't."

Comments Not a Finding. The login banner is displayed but does not hyphenate "agreem't"
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CCE-27311-0 Very Permissions on SHH Server *.pub Key Files (Control Group =

na)
Check

Not a Finding. All public keys are set to with permissions 640 in the /etc/ssh/

Comments .
directory.

CCE-27314-4 Enable SSH Warning Banner (Control Group = na)
Check

Comments Not a Finding. The required configuration exists in the etc/ssh/sshd_conf file.

CCE-27349-0 Set Default firewal1d Zone for Incoming Packets (Control Group =
n/a)

To set the default zone to drop for the built-in default zone which processes incoming
Check IPv4 and IPv6 packets, modify the following line in the

/etc/firewalld/firewalld.conf file to be:
DefaultZone=drop

Not a Finding. NetWitness Platform £irewalldservice is disabled because it uses IP

Comments Tables, not FirewallD.

CCE-27386-2 Ensure Default SNMP Password Is Not Used (Control Group = n/a)

Edit /etc/snmp/snmpd.conf file by removing or changing the default community
Check strings of public and private. After the default community strings have been changed,

restart the SNMP service:
$ sudo service snmpd restart

Not a Finding. NetWitness Platform does not use snmp, and the snmpd service not

Comments enabled.

CCE-27455-5 Use Only FIPS 140-2 Validated MACs (Control Group = na)
Check

Not a Finding. The following configuration exists in /etc/ssh/sshd_config file:

Comments .- | ac-shal, hmac-sha2-256, hmac-sha2-512
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CCE-27471-2 Disable SSH Access via Empty Passwords (Control Group = n/a)

Check Explicitly disallow SSH login from accounts with empty passwords, add or correct the
following line in the /etc/ssh/sshd config file.

Not a Finding. NetWitness Platform sets the permitemptypasswords parameter to no

SRS by default. This should pass the DISA STIG rule check.

CCE-27485-2 Very Permissions on SHH Server Private *.key Key Files (Control
Group = na)

Check

Not a Finding. All private keys are set to with permissions 640 in the /etc/ssh/

Comments ..
directory.

CCE-80156-3 Disable Kernel Parameter for Sending ICMP Redirects for All

Interfaces (Control Group = n/a)

To set the runtime status of the t.ipv4.conf.all.send redirects kernel
parameter, run the following command:

Check S sgdp sysctl -w net.ipv4.conf.all.sendTreQirects=O
If this is not the system default value, add the following line to the
/etc/sysctl.conf file:
t.ipv4.conf.all.send redirects = 0

Not a Finding. NetWitness Platform does not accept incoming Internet Control

Comments Message Protocol (ICMP) traffic.

CCE-80157-1 Disable Kernel Parameter for IP Forwarding (Control Group = n/a)

To set the runtime status of the t.ipv4.ip forward kernel parameter, run the
following command:

Check $ sgdp sysctl -w net.ipv4.ip forward=0 . .
If this is not the system default value, add the following line to the

/etc/sysctl.conf file:
t.ipvd.ip forward = 0

Not a Finding. This is the default value set in /etc/init.d/network and
Comments /etc/rc.d/init.d/network. Run“sysctl -a | grep ip forward” to
validate.
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CCE-80158-9 Configure Kernel Parameter for Accepting ICMP Redirects for All

Interfaces (Control Group = n/a)

To set the runtime status of the t.ipv4.conf.all.accept redirects kernel
parameter, run the following command:

Check S sgdp sysctl -w net.ipv4.conf.all.accept_;edirects=0
If this is not the system default value, add the following line to the /etc/sysctl.conf
file:

t.ipvd.conf.all.accept redirects = 0

Not a Finding NetWitness Platform does not accept incoming Internet Control Message

Comments Protocol (ICMP) traffic.

CCE-80163-9 Configure Kernel Parameter for Accepting ICMP Redirects By
Default (Control Group = n/a)

To set the runtime status of the t.ipv4.conf.default.accept redirects kernel
parameter, run the following command:

Check S sgdp sysctl -w net.ipv4.conf.default.gccgpt_redirects:o
If this is not the system default value, add the following line to the /etc/sysctl.conf
file:

t.ipvé4.conf.default.accept redirects = 0

Not a Finding NetWitness Platform does not accept incoming Internet Control Message

Comments Protocol (ICMP) traffic.

CCE-80165-4 Configure Kernel Parameter to Ignore ICMP Broadcast Echo

Requests (Control Group = n/a)

Rule

Name
To set the runtime status of the t.ipv4.icmp echo ignore broadcasts kernel
parameter, run the following command:

Check $ sudo sysctl -w net.ipv4.icmp echo ignore broadcasts=1

If this is not the system default value, add the following line to the /etc/sysctl.conf
file:
t.ipv4.icmp echo ignore broadcasts = 1
Not a FindingNetWitness Platform does not accept incoming Internet Control Message

Comments

Protocol (ICMP) traffic.

CCE-80225-6 Print Last Log (Control Group = n/a)

When enabled, SSH will display the date and time of the last successful account log in.
Check To enable LastLog in SSH, add or correct the following line in the /etc/ssh/sshd

config file:
PrintLastLog yes
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Comments Vot a Finding. NetWitness Platform sets printlastlog to yes by default.

CCE-80226-4 Enable Encrypted X11 Forwarding (Control Group = n/a)

Enable Encrypted X11 Forwarding - By default, remote X11 connections are not
encrypted when initiated by users. SSH has the capability to encrypt remote X11
Check connections when SSH's X11Forwarding option is enabled. To enable X11

Forwarding, add or correct the following line in the /etc/ssh/sshd_config file:
X11lForwarding yes

Comments Not a Finding.NetWitness Platform does not have X11 installed or running.

CCE-80348-6 Ensure gpgcheck Enabled for Repository Metadata (Control Group =

n/a)

Verify the operating system prevents the installation of patches, service packs, device
drivers, or operating system components of local packages without verification of the

Check  repository metadata. Check that yum verifies the repository metadata prior to install with
the following command. This should be configured by setting repo gpgcheckto 1l in
/etc/yum.conf.

Not a Finding. .NetWitness Platform rpm signing procedures do not support signing the

mment
COInENY repo metadata

CCE-80383-3 Record Attempts to ALter Logon Events - failock (Control Group =

na)
Check

Not a Finding. The required rules are configured in the /etc/audit/rules.d/nw-

Comments stig.rules file.

CCE-80399-9 Ensure auditd Collects Information on the Use of Privileged

Commands - userhelper (Control Group = na)
Check

Not a Finding. The required rules are configured in the /etc/audit/rules.d/nw-

Comments stig.rules file.

CCE-80437-7 Configure PAM in SSSD Services (Control Group = n/a)

SSSD should be configured to run SSSD pam services. To configure SSSD to known
Check SSH hosts, add pam to services under the [sssd] sectionin /etc/sssd/sssd.conf
file. For example: [sssd] services = sudo, autofs, pam
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Not a Finding. NetWitness Platform does not currently support Multi-Factor

mmen .. .. . .
oe ik authentication. As a result, SSSD service is not installed on a NetWitness Host.

CCE-80438-5 Configure Multiple DNS Servers in /etc/resolv.conf (Control Group =
n/a)

Multiple Domain Name System (DNS) Servers should be configured in the
/etc/resolv.conf file. This provides redundant name resolution services in the
event that a domain server crashes. To configure the system to contain as least 2 DNS
Check servers, add a corresponding nameserver entry in ip_address /etc/resolv.conf
file for each DNS server where ip address is the IP address of a valid DNS server.

For example:
search example.com nameserver 192.168.0.1 nameserver 192.168.0.2

Not a Finding. NetWitness Platform orchestrates and configures an internal DNS
Comments server that all NetWitness hosts use for name resolution. You can configure external
DNS servers, but it is dependent on your environment.

CCE-80439-3 Configure Time Service Maxpoll Interval (Control Group = na)

Check

Comments Not a Finding. The required maxpoll 10 value is set in the /etc/ntp.conf file.

CCE-80447-6 Configure the Firewalld Ports (Control Group = n/a)

Configure the firewalld ports to allow approved services to have access to the
system. To configure firewalld to open ports, run the following command:

$ sudo firewall-cmd --permanent --add-port= or port number/tcp $
sudo firewall-cmd --permanent --add-port=
Check . .
Run the command list above for each of the ports listed below: <ports>
To configure service nam firewalld to allow access, run the following command
(s):
firewall-cmd --permanent --add-service=ssh
Not a Finding. i fi 11d ice is di i
G g. NetWitness Platform firewa service is disabled because it uses IP

Tables, not FirewallD.

CCE-80515-0 Configure SSSD LDAP Backend Client CA Certificate Location

(Control Group = n/a)

Configure SSSD to implement cryptography to protect the integrity of LDAP remote
access sessions. By setting the 1dap tls cacertdir option in

Check /etc/sssd/sssd.conf to point to the path for the X.509 certificates used for peer
authentication.
ldap tls cacertdir /path/to/tls/cacert
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Comments

Not a Finding. NetWitness Platform does not currently support Multi-Factor
authentication. As a result, SSSD service is not installed on a NetWitness Host.

CCE-80545-7 Verify and Correct Ownership with RPM (Control Group = n/a)

Check

Comments

The RPM package management system can check file ownership permissions of
installed software packages, including many that are important to system security. After
locating a file with incorrect permissions, which can be found with rpm -va | grep
M. \N(UN].G\) "

Run the following command to determine which package owns it:

S rpm -gf

Next, run the following command to reset its permissions to the correct values:
FILENAME $ sudo rpm --setugids PACKAGENAME

Not a Finding.Files/Directories with ownership differing from the rpm are generally
COTS based and have been changed from root ownership to a specified COTS related
account.

CCE-80546-5 Configure SSSD LDAP Backend to Use TLS For All Transactions

(Control Group = n/a)

Check

Comments

This check verifies that RHEL7 implements cryptography to protect the integrity of
remote LDAP authentication sessions. To determine if LDAP is being used for

authentication, use the following command:
$ sudo grep -i useldapauth /etc/sysconfig/authconfig If
USELDAPAUTH=yes

To check if LDAP is configured to use TLS, use the following command:
$ sudo grep -i ldap id use start tls /etc/sssd/sssd.conf

Not a Finding.NetWitness Platform does not currently support Multi-Factor
authentication. As a result, the SSSD service is not installed on a NetWitness Host.
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CCE-80998-8 Verify firewall Enabled

Check Verify the operating system enabled an application firewall. Check to see if "firewalld"
is installed with the following command:
yum list installed firewalld
firewalld-0.3.9-11.el7.noarch.rpm

If the "firewalld" package is not installed, ask the System Administrator if another
firewall application (such as iptables) is installed.

If an application firewall is not installed, this is a finding.

Check to see if the firewall is loaded and active with the following command:
systemctl status firewalld

firewalld.service - firewalld - dynamic firewall daemon
Loaded: loaded (/ust/lib/systemd/system/firewalld.service; enabled)

Active: active (running) since Tue 2014-06-17 11:14:49 CEST; 5 days ago

If "firewalld" does not show a status of "loaded" and "active", this is a finding.
Check the state of the firewall:

firewall-cmd --state

running
If "firewalld" does not show a state of "running", this is a finding.

Comments Not a Finding. NetWitness Platform firewalldservice is disabled because it uses IP
Tables, not FirewallD.

CCE-82035-7 Ensure /var/log/audit Located On Separate Partition

Check Determine if the operating system is configured to have the "/var/log/audit" path is on a
separate file system.

grep /var/log/audit /etc/fstab

If no result is returned, or the operating system is not configured to have "/var/log/audit"
on a separate file system, this is a finding.

Verify that "/var/log/audit" is mounted on a separate file system:
mount | grep "/var/log/audit"

If no result is returned, or "/var/log/audit" is not on a separate file system, this is a
finding.

Comments Not a Finding, NetWitness Platform has the /var/log directory as a separate partition.
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CCE-82053-0 Ensure /tmp Located On Separate Partition

Check Verify that a separate file system/partition has been created for "/tmp". Check that a file
system/partition has been created for "/tmp" with the following command:

systemctl is-enabled tmp.mount

enabled

If the "tmp.mount" service is not enabled, check to see if "/tmp" is defined in the fstab
with a device and mount point:

grep -1 /tmp /etc/fstab

UUID=a411dc99-f2a1-4¢c87-9¢05-184977be8539 /tmp ext4
rw,relatime,discard,data=ordered,nosuid,noexec, 0 0

If "tmp.mount" service is not enabled or the "/tmp" directory is not defined in the fstab
with a device and mount point, this is a finding.

Comments Future Feature - NetWitness Platform does not meet this requirement. RSA plans to fix
this in a future release of NetWitness Platform.

CCE-82353-4 Ensure /var Located On Separate Partition

Check Verify that a separate file system/partition has been created for "/var". Check that a file
system/partition has been created for "/var" with the following command:

grep /var /etc/fstab
UUID=c274f65f /var ext4 noatime,nobarrier 1 2

If a separate entry for "/var" is not in use, this is a finding.

Comments Not a Finding. Hardware is dedicated for NetWitness, and NetWitness software is
installed in /var/netwitness by default and a separate partition is on /var/netwitness.

Rules Supported in a Future Release

The following checks for non-compliance to STIG rules are not supported in NetWitness Platform and
will be added in a future release.

CCE-27277-3 Disable Modprobe Loading of USB Storage Driver (Control Group =

services)

To prevent USB storage devices from being used, configure the kernel module loading

system to prevent automatic loading of the USB storage driver. To configure the system

to prevent the usb-storage kernel module from being loaded, add the following line to a
Check file in the /etc/modprobe.d directory :

install usb-storage /bin/true

This will prevent the modprobe program from loading the usb-storage module, but will

not prevent an administrator (or another program) from using the insmod program to

load the module manually.

Comments Future Feature.
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CCE-27309-4 Set Boot Loader Password in grub2 (Control Group = fips-kernel)

Check

Comments

The grub2 boot loader should have a superuser account and password protection enabled
to protect boot-time settings. To do so, select a superuser account name and password
and and modify the /etc/grub.d/01 users configuration file with the new account
name. Because plain text passwords are a security risk, generate a hash for the password
by running the following command:

$ grub2-setpassword

When prompted, enter the password that was selected.

NOTE: It is recommended not to use common administrator account names like root,
admin, or administrator for the grub2 superuser account. Change the superuser to a
different username (The default is 'root').

$ sed -i s/root/bootuser/g /etc/grub.d/01 users

To meet FISMA Moderate, the bootloader superuser account and password MUST
differ from the root account and password. Once the superuser account and password
have been added, update the grub. cfg file by running:

grub2-mkconfig -o /boot/grub2/grub.cfg
NOTE: Do NOT manually add the superuser account and password to the grub.cfg file
as the grub2-mkconfig command overwrites this file.

Future Feature.

CCE-80179-5 Configure Kernel Parameter for Accepting IPv6 Source-Routed

Packets for All Interfaces

Check

Comments

To set the runtime status of the t.ipv6.conf.all.accept source route kernel
parameter, run the following command:

$ sudo sysctl -w net.ipvé6.conf.all.accept source route=0

If this is not the system default value, add the following line to the /etc/sysctl.conf
file:

t.ipv6.conf.all.accept source route = 0

Future Feature.

CCE-80660-4 Record Any Attempts to Run setfiles (Control Group = audit)

At a minimum, the audit system should collect any execution attempt of the setfiles
command for all users and root. If the auditd daemon is configured to use the augenrules
program to read audit rules during daemon startup (the default), add the following lines to

a file with .rules in /etc/audit/rules.d: -a always,exit -F
path=/usr/sbin/setfiles -F perm=x -F auid>=1000 -F

heck
Ll auid!=42949672%as a suffix 5 -F key=privileged-priv_change. If the

auditd daemon is configured to use the auditctl utility to read audit rules during
daemon startup, add the following lines to /etc/audit/audit.rules file:
-a always,exit -F path=/usr/sbin/setfiles -F perm=x -F auid>=1000
-F auid!=4294967295 -F key=privileged-priv_chang

Comments Future Feature.
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CCE-80661-2 Ensure auditd Collects Information on Kernel Module Loading -

create_module (Control Group = audit)

To capture kernel module loading events, use following line, setting ARCH to either b32
for 32-bit system, or having two lines for both b32 and b64 in case your system is 64-bit:
-a always,exit -F arch=
The place where you add the line depends on the way ARCH -S create module -F
key=modules auditd daemon is configured. If it is configured to use the augenrules
program (the default), add the line to a file with the . rules suffix in the
/etc/audit/rules.d directory. If the auditd daemon is configured to use the
auditctl utility, add the line to the /etc/audit/audit.rulesfile.

Check

Comments Future Feature.
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For information about troubleshooting NetWitness Platform, see the following topics:

o Debugging Information

o Error Notification

o Miscellaneous Tips

o NwlLogPlayer: see the Log Parser Customization Guide for details.

o Troubleshoot Feeds

Debugging Information

NetWitness Platform Log Files

The following files contain NetWitness Platform log information.

I

rabbitmg /var/log/rabbitmg/nw@localhost.log
/var/log/rabbitmg/nwl@localhost-sasl.log

collectd /var/log/messages

nwlogcollector /var/log/messages

nwlogdecoder /var/log/messages

sms /opt/rsa/sms/wrapper.log

B /opt/rsa/sms/logs/sms.log

sms /opt/rsa/sms/logs/audit/audit. log

NetWitness Platform /var/lib/netwitness/uax/logs/nw.log

NetWitness Platform /var/lib/netwitness/uax/logs/audit/audit.log

NetWitness Platform /opt/rsa/jetty9/logs

Files of Interest

The following files are used in key NetWitness Platform components, and can be useful when trying to
track down miscellaneous issues.
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N N

RabbitMQ configuration file. This
configuration file partially drives the

rabbit /etc/rabbitmg/rabbitmg.config behavior of RabbitMQ,
particularly around network/SSL
settings.
RabbitMQ environment configuration
rabbit /etc/rabbitmg/rabbitmg-env. file. This file specifies the RabbitMQ
conf node name and location of the enabled

plugins file.

This file specifies the list of enabled
plugins in RabbitMQ. This file is
managed by the RabbitMQ server, with
the rabbitmg-plugins command.
This file overrides the
/etc/rabbitmg/enabled plugins
path to work around issues with
upgrading the Log Collector from early
versions.

/etc/rabbitmg/rsa_enabled

rabbit g
plugins

The RabbitMQ trust store. This file
contains a sequence of PEM-encoded
X.509 certificates, represented trust

rabbit /etc/rabbitmg/ssl/truststore.pem (CAs. Any clients that connect to
RabbitMQ and present a certificate that
is signed by a CA in this list is
considered a trusted client.
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T N N

The RabbitMQ Mnesia directory.
Mnesia is the Erlang/OTP database
technology, for storing Erlang objects
persistently. RabbitMQ uses this
technology for storing information such
as the current set of policies, persistent
exchanges and queues, and so forth.

Importantly, the msg_store_
persistent and msg store
transient directories are where
/var/log/rabbitmg/mnesia/ RabbitMQ stores messages that have
nw@localhost been spooled to disk, for example, if
messages are published as persistent
messages, or have paged off to disk due
to memory limitations. Keep a close eye
on this directory if disk or memory
alarms have tripped in RabbitMQ.

rabbit

Caution: Do not delete these files
manually. Use RabbitMQ tools to
purge or delete queues. Modifying
these files manually may render your
RabbitMQ instance inoperable.

Error Notification

NetWitness Platform has a set of error message types associated with different components and
operations. NetWitness Platform displays feedback in the form of a simple error notification and a log
entry.

When an error notification dialog is displayed, you have two options: simply acknowledge the message
or view the system log for more information.

Trial License Expired

If you want to view the system log for more information when an error notification is displayed, click

Q
View log. The log opens in the (Admin) > System view with a list of messages. Timestamp and
message level are also listed.

205 Troubleshoot NetWitness Platform



System Maintenance Guide
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Miscellaneous Tips

Audit Log Messages

It can be useful to see which user actions result in which log message types in the
/var/log/messages file.

The event categories spreadsheet included in the log parser package in the NetWitness Platform Parser
v2.0.zip archive lists the event categories and the event parser lines to help with building reports, alerts,
and queries.

NwConsole for Health & Wellness

RSA has added the command option logParse in NwConsole. This command option supports log
parsing, a convenient way to check a log parser without setting up the full system to perform log parsing.
For more information about the 1ogParse command, at the command line, type help logParse.

Thick Client Error: remote content device entry not found

The remote content device entry was not found error can be generated for a correlation rule applied to a
Concentrator. In NetWitness Platform Investigate, if you click the correlation-rule-name meta
value in the Alert meta key, you do not get session information.

Instead of using correlation rules on Decoders and Concentrators, use ESA rules. The ESA rules do
record the correlation sessions that match the ESA rule.
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View Example Parsers
Since Flex and Lua parsers are encrypted when they are delivered by Live, you cannot easily view their
contents.

However, some plain text examples are available here: https://community.emc.com/docs/DOC-41108.

Configure WinRM Event Sources
The following Inside Dell article has a video that walks through the process of setting up Windows RM
(Remote Management) collection: https://inside.dell.com/docs/DOC-122732.

Additionally, it contains two scripts that are shortcuts for procedures described in the "Windows Event
Source Configuration Guide."

Troubleshoot Feeds

Overview
The purpose of the feed generator is to generate a mapping of an event source to the list of groups to
which it belongs.

If you have an event source from which you are collecting messages, and it is not displayed in the
correct event source groups, this topic provides background and information to help you track down the
problem.

Details
The ESM Feed maps multiple keys to single value. It maps the DeviceAddress, Forwarder,
and DeviceType attributes to groupName.

The purpose of the ESM feed is to enrich event source meta with the groupName collected on the Log
Decoder.

How it Works

The feed generator is scheduled to update every minute. However, it is triggered only if there are any
changes (create, update, or delete) in event sources or groups.

It generates a single feed file with event-source-to-group mapping, and pushes the same feed to all of the
Log Decoders that are connected to NetWitness Platform.

Once the feed file is uploaded on the Log Decoders, for any new events, it enriches events meta data
with groupName, and appends this groupName to logstats.

Once the groupName is in logstats, the ESM Aggregator groups information and sends it to ESM. At this
point, you should see the Group Name column under the Event Source Monitoring tab.

The entire process can take some time. Therefore, you may need to wait for several seconds after you
add a new group or event source, before the Group name is displayed.
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Note: If the event source type attribute changes when the feed is updated, NetWitness Platform adds a
new logstats entry rather than updating the existing one. Thus, there will be two different logstats
entries in logdecoder. Previously existing messages would have been listed under the previous type,
and all new messages are logged for the new event source type.

Feed File

The format of the feed file is as follows:

DeviceAddress, Forwarder, DeviceType, GroupName

The DeviceAddress is either ipv4, ipv6, or hostname, depending on which of these have been
defined for the event source.

The following is a sample of the feed file:

"12.12.12.12","d6", "NETFLOW", "grpl"

"12.12.12.12","1d4", "netflow", "grpl"
"12.12.12.12","d6", "netfow", "grpl"
"0:E:507:E6:D4DB:E:59C:A","10.25.50.243", "apache", "Apachegrp"
"1.2.3.4","LCC", "apache", "Apachegrp"
"10.100.33.234","LC1", "apache", "Apachegrp"
"10.25.50.248","10.25.50.242", "apache", "Apachegrp"
"10.25.50.251","10.25.50.241", "apache", "Apachegrp"
"10.25.50.252","10.25.50.255", "apache", "Apachegrp"
"10.25.50.253","10.25.50.251", "apache", "Apachegrp"
"10.25.50.254","10.25.50.230", "apache", "Apachegrp"
"10.25.50.255","10.25.50.254", "apache", "Apachegrp"
"13.13.13.13","LC1", "apache", "Apachegrp"
"AB:F255:9:8:6C88:EEC:44CE:7",, "apache", "Apachegrp"
"Appliancel234",, "apache", "Apachegrp"
"CB:F255:9:8:6C88:EEC:44CE:7","10.25.50.253", "apache", "Apachegrp"

Troubleshooting

You can check the following items to narrow down where the problem is occurring.

Feed File Existence

Verify that the feeds ZIP archive exists in the following location:

/opt/rsa/sms/esmfeed.zip

Do not modify this file.
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Group Meta Populated on LD

Verify that the group meta is populated on the Log Decoder. Navigate to the Log Decoder REST and
check logstats:

http://LogDecoderIP:50102/decoder?msg=logStats&force-content-type=text/plain

This is a sample logstats file with group information:

device=apache forwarder=NWAPPLIANCE10304 source=1.2.3.4 count=338
lastSeenTime=2015-Feb-04 22:30:19 lastUpdatedTime=2015-Feb-04 22:30:19
groups=IP1234Group, apacheGroup

device=apachetomcat forwarder=NWAPPLIANCE10304 source=5.6.7.8 count=1301
lastSeenTime=2015-Feb-04 22:30:19 lastUpdatedTime=2015-Feb-04 22:30:19
groups=All10therGroup,ApacheTomcatGroup

In the above text, the group information is bold.

Device Group Meta on Concentrator

Verify that the Device Group meta data exists on the Concentrator, and that events have values for the
device.group field.

Device Group (8 values) L

testgroup (28,878) - localgroup (2.347) - squid (3,346) - allothergroup (780) - apachetomcatgroup (561) - ip1234group (457) - cacheflowelff (219) - apachegroup (91)
sessionid = 22133

time = 2015-02-05T14:35:03.0
size = o

lc.cid = "NWAPPLIANCE10304"
forward.ip = 127.0.01

device.ip = 20.20.20.20 ~

medium = 32

device.type = "unknown" =
device.group = "TestGroup”
kig_thread = "o

SMS Log File

Check the SMS log file in the following location to view informational and error messages:
/opt/rsa/sms/logs/sms.log

The following are examples informational messages:

Feed generator triggered...

Created CSV feed file.
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Created zip feed file.

Pushed ESM Feed to LogDeocder : <logdecoder IP>
The following are examples of error messages:

Error creating CSV File : <reason>Unable to push the ESM Feed: Unable to
create feed zip archive.

Failed to add Group in CSV: GroupName: <groupName> : Error: <error>

Unable to push the ESM Feed: CSV file is empty, make sure you have al-least on
group with al-least one eventsource.

Unable to push the ESM Feed: No LogDecoders found.

Unable to push the ESM Feed: Unable to push feed file on LogDecoder-
<logdecoderIP>Unable to push the ESM Feed:
admin@<logdecoderIP>:50002/decoder/parsers received error: The zip archive
"/etc/netwitness/ng/upload/<esmfeedfileName>.zip" could not be opened

Unable to push the ESM Feed: <reason>

Verify Logstats Data is Getting Read and Published by ESMReader
and ESMAggregator

These are the steps to verify that logstats are collected by collectd and published to Event Source
Management.

ESMReader
1. On LogDecoders add the debug "true" flag in /etc/collectd.d/NwLogDecoder_ESM.conf:

#
# Copyright (c) 2014 RSA The Security Division of EMC
#
<Plugin generic_ cpp> PluginModulePath "/usr/lib64/collectd"
debug "true"
<Module "NgEsmReader" "all"> port "56002"
ssl "yes"
keypath "/var/lib/puppet/ssl/private keys/d4c6dcd4-6737-4838-
a2f7-ba7e9%9alcS5aae.pem"
certpath "/var/lib/puppet/ssl/certs/d4c6dcd4-6737-4838-a2f7-
ba7e9%9al65aae.pem"
interval "600"

query "all"
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<stats></stats></Module><Module "NgEsmReader" "update"> port
"56002" ssl "yes"

keypath "/var/lib/puppet/ssl/private keys/d4c6dcd4-6737-4838-
a2f7-ba7e9%9alcS5aae.pem"

certpath "/var/lib/puppet/ssl/certs/d4c6dcd4-6737-4838-a2f7-
ba7e9%9al65aae.pem"

interval "o60"

query "update"

<stats></stats></Module></Plugin>

2. Run the command:
collectd service restart

3. Run the following command:

tail -f /var/log/messages | grep collectd

Verify that ESMReader is reading logstats and there are no errors. If there are any read issues, you

will see errors similar to the following:
Apr 29 18:47:45 NWAPPLIANCE15788 collectd[14569]: DEBUG: NgEsmReader all:
error getting ESM data for field "groups" from logstat device=checkpointfwl
forwarder=PSRTEST source=1.11.51.212. Reason: <reason>Apr 29 18:58:36
NWAPPLIANCE15788 collectd[14569]: DEBUG: NgEsmReader update: error getting ESM
data for field "forwarder" from logstat device=apachetomcat

source=10.31.204.240. Reason: <reason>

ESMAggregator
1. On NetWitness Platform, uncomment the verbose flag in /etc/collectd.d/ESMA ggregator.conf:

# ESMAggregator module collectd.conf configuration file

#

# Copyright (c) 2014 RSA The Security Divsion of EMC

#

<Plugin generic_ cpp> PluginModulePath "/usr/lib64/collectd"

<Module "ESMAggregator">
verbose 1
interval "o60"

cache save interval "600"
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persistence dir "/var/lib/netwitness/collectd"

</Module> </Plugin>

2. Run the following command:
collectd service restart

3. Run the following command:
run “tail -f /var/log/messages | grep ESMA
Look for for ESMAggregator data and make sure your logstat entry is available in logs.

Sample output:

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: MetaDatal[O0O]
logdecoder[0] = d4c6dcd4-6737-4838-a2f7-ba7e%al6baae

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: MetaDatal[l]
logdecoder utcLastUpdate[0] = 1425174451

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: MetaDatal[Z2]
groups = Cacheflowelff,Mixed

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: MetaDatal[3]
logdecoders = d4c6dcd4-6737-4838-a2f7-ba7e%al65aae

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: MetaDatal[4]
utcLastUpdate = 1425174451

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: Dispatching
ESM stat NWAPPLIANCE15788/esma_ update-cacheflowelff/esm counter-3.3.3.3 with a
value of 1752 for NWAPPLIANCE15788/cacheflowelff/esm counter-3.3.3.3
aggregated from 1 log decoders

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: MetaDatal[O]
logdecoder[0] = 767354a8-5e84-4317-bc6a-52e4f4d8bfff

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: MetaDatal[l]
logdecoder utcLastUpdate[0] = 1425174470

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: MetaDatal[Z2]
groups = Cacheflowelff,Mixed

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: MetaDatal[3]
logdecoders = 767354a8-5e84-4317-bc6a-52e4f4d8bfff

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: MetaDatal[4]
utcLastUpdate = 1425174470

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: Dispatching

RRD stat NWAPPLIANCE15788/esma_ rrd-cacheflowelff/esm counter-3.3.3.3 with a
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value of 1752 for NWAPPLIANCE15788/cacheflowelff/esm counter-3.3.3.3

aggregated from 1 log

Configure JMX Feed Generator Job Interval

Although the feed generation job is scheduled to execute every minute by default, you can change this by
using jconsole.

To change the feed generator job interval:

L.

2
3.
4

Open jconsole for the SMS service.
On the MBeans tab, navigate to com.rsa.netwitness.sms > API > esmConfiguration > Attributes.
Modify the value for the property FeedGeneratorJobIntervallnMinutes.

Go to Operations under the same navigation tree, an click commit(). This persists the new value in
the corresponding json file under /opt/rsa/sms/conf, and uses the value if SMS is restarted.

Setting a new value reschedules the feed generator job for the new interval.
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Troubleshooting Cert-Reissue Command

You must contact Customer Support (https://community.rsa.com/docs/DOC-1294) to troubleshoot
problems. You know there is a problem if any <host-id> does not return a SuccessStatus. Success
indicates that certificates were reissued for a host.

Argument Options Used for Troubleshooting

You use the following argument options with cert-reissue --host-all to troubleshoot problems.

You can run cert-reissue --host-all<arguments> multiple times without an adverse effect.

Note: Use the following Argument Options with caution. They force the cert-reissue command to
execute for all the hosts.

--skip-health- Reissues certificates for all hosts at one time without applying system health
hICeLe checks (force Reissue). This means that the command does not:

« verify that all hosts are online line.

« verify that all services are running.

Use case: You have numerous hosts and you know that a small minority of
them will fail. This updates all the hosts that conform to the checking rules and
you can reissue certificates for the others subsequently with the help of
Customer Support.

—;S kip—ver sion- Do not verify that hosts are running version 11.4.0.0 or later.
cnecks

Use Case: You have numerous hosts and your know that some of them are not
updated to 11.4 or later. This reissues certificates for all the hosts that are at
11.4 or later and you can reissue certificates for the others subsequently with
the help of Customer Support.

--ignore-trigger-  Jgnore any errors that trigger failures. This option forces the cert reissue
errors process to continue disregarding the errors instead of aborting or failing the
cert reissue command quickly.

When a cert reissue for a host succeeds, the reissued certificates on that host
are not provisioned to other dependent hosts (referred to as trusts). In this
case, the:

« host with reissued certificates is reported as “Partial.”

« the hosts with trusts that failed to update are listed separately in the
summary table to tell you that these hosts may require a refresh using the
new --refresh-trusts-only option.

“iefreSh‘trUSts‘ Refreshes trusts exclusively for host identified by <id> (does not reissue
e certificates for that host).
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Problems and How to Troubleshoot Them

This section describes solutions to problems that you may encounter when running the cert-reissue
command to reissue certificates with suggested causes and solutions.

Failed!

2019-02-06 13:34:39.646 INFO 8540 --- [ main]
c.r.n.i.o.client.OrchestrationClient : Checking host connections...

2019-02-06 13:34:57.861 ERROR 8540 --- [ main]
c.r.n.i.o.client.HostValidator : Host '192.168.200.99' (nw-platform-esa-
primary) verification failed!

2019-02-06 13:34:57.862 INFO 8540 --- [ main]
c.r.n.i.o.client.OrchestrationClient : Checking status of services...
2019-02-06 13:35:57.931 ERROR 8540 --- [ main]

c.r.n.i.o.client.HostValidator : Service 'nw-platform-node-zero -
Investigate Server' not available!

e e R e +
| | Host | Status | Message |
s ettt R et o |
|<host-id>»| <IP-address> |Failed! |failed to connect, is host online? |
|<host-id>| <IP-address> |Failed! |service(s) down |
|<host-id>| <IF-address> IN/A | [ Skipped... ] |
|<host=id>| <IP-address> IN/A | [ Skipped... ] |
|<host-id>| <IP-address> IN/A I[ Skipped... ] |
pommmmmeee mm Hommmmme e -

cert-reissue --host-all failed because one or more hosts are offline or one or more
run time services are unreachable. You can force this command to run in spite of this error
by specifying the --skip-health-checks option, that is:

cert-reissue --host-all--skip-health-checks

1. Bring appropriate hosts back online or make sure the NW Server hosts run time
services are running.

2. Run cert-reissue for the hosts affected.
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Failed!

—f——

| Status | Message |

-t== + - e I
| <host-id>| <IP-address> |Failed! |version <version-earlier-than-11.3.0.0> not supported|
| <host-id>| <IP-address> |Failed! |wversion <version-earlier-than-11.3.0.0> not supported|
| <host-id>| <IP-address> IN/B I[ Skipped... ]
| <host-id>»| <IP-address> IN/A I [ Skipped... ]

| <host=id>| <IP-address> IN/A I[ Skipped... ]

+ + . 4 + .

cert-reissue -host-all command string failed because one or more hosts are
running a version earlier than 11.4.0.0

Note: You can force the reissue of certificates for the remaining hosts using the -
skip-version-checks argument.

Update the host to 11.4 or later and run cert-reissue for that host again.
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Partial

2019-02-06 02:27:09.078 ERROR 20647 --- [ main]
c.r.n.i.o.client.OrchestrationClient : Trigger failed for host '<IP-
address>' (nw-platform-decoder)

2019-02-06 02:27:09.079 ERROR 20647 --- [ main]

c.r.n.i.o.client.OrchestrationClient : Trigger failed for host '<IP-
address>' (nw-platform-concentrator)

2019-02-06 02:27:09.118 WARN 20647 --- [ main]
c.r.n.i.o.client.OrchestrationClient : One or more host(s) may require
manual refresh due to failed triggers:

| <hoat-id>| <JP-address> |

| <host-id>| <IP-address> |

t t t

t + + e +
| Host | Status | Message |

————— e ———————— e

| <host-id>»| <IP-address> |Partial |Reissue completed, triggers failed |
| <host-id>| <IP-address> IM/R I[ Skipped. ] |
| <hoat-id>»| <IP-address> IN/A | [ Skipped... ] |
| <host-id»| <IP-address> IN/A | [ Skipped... ] |
| <host-id>| <]P-address> I N/A |[ Skipped... ] |
o ——————— e Fmmmm———— e +

cert-reissue command completed on NW Server host however one or more triggers
failed. This aborted the cert-reissue command for other hosts.

Address all the errors and run the cert-reissue --host-all<arguments> command
string again.
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Partial

2019-02-06 14:18:03.208 ERROR 17800 --- [ main]
c.r.n.i.o.client.OrchestrationClient : Trigger failed for host
'192.168.200.82"' (nw-platform-node-x)

2019-02-06 14:29:05.200 WARN 17800 --- [ main]
c.r.n.i.o.client.OrchestrationClient : One or more host(s) may require
manual refresh due to failed triggers:

e ————— e ———————————————— +

e o ——————————— pmmm————— e e e +
| | Host | Status | Message |
fm—— A e e e e |
|<host-id>| <JP-address> |IFailed! ICert reissue failed! |

|<host-id>| <JP-address> |Partial |Reissue completed, triggers failed |
|<host-id>| <]P-address> |Success | Cert reissue successful |
|<host-id>| <JP-address> |Success | Cert_'._reissue successful |
|<host-id>| <IP-address> |§_1:_1§cess I_ Cerf:'._ reissue successful |
tommm————— fommmm———— e e ————————— pomm————— e e e e — e — e —————— +

One or more hosts did not pass system health checks. In addition, one or more of the
unhealthy hosts are running core services, which will result in the NW Server host cert-
reissue to fail (because of failed triggers explained above). By disabling health checks
and trigger errors, you can continue the process and reissue certificates for the remaining
hosts. The NW Server host Status is reported as Partial because the cert-reissue
command completed for the NW Server but downstream triggers failed for other hosts.

Manually refresh the failed core hosts (to synchronize trust peers).

Submit the following command string to reissue certificates for healthy hosts.
cert-reissue --host-all --skip-health-checks --ignore-trigger-errors
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This section describes the NetWitness Platform user interface views in which you can perform system
maintenance tasks. You use this interface to:

o Monitor and maintain services (settings, statistics, command and message syntax, REST API, RSA
Console utility, and protocols supported in NetWitness Platform).

« Display the current NetWitness Platform version and license status.

o Manage your Local Update Repository from which you apply software version updates to hosts.

The following topics describe each interface in detail:

o Health and Wellness View

o System View - System Info Panel
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Health and Wellness View

The Health and Wellness settings allow you to set and view alarms, monitor events, and view
policies and system statistics. For more details on each of these, see the following topics:

o Health and Wellness View - Alarms View

« Event Source Monitoring View

o Health and Wellness Historical Graphs

o Health and Wellness Settings View - Archiver

o Health and Wellness Settings View - Event Sources

o Health and Wellness Settings View - Warchouse Connector

o Monitoring View

o Policies View

o System Stats Browser View

References
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Health and Wellness View - Alarms View

Y ou can monitor hosts and services to determine when user-defined limitations have been reached
by viewing all the active alarms. Policy rules, that you define or assign to hosts and services, in the
Policies tab trigger these alarms. You can:

o View all the alarms that are currently active for all your systems and services

¢ Select an alarm and view its details

What do you want to do?

Administrator ~ View the alarm status of NetWitness Monitor Alarms
Servers and services.

Administrator ~ View detailed information about a specific ~Monitor Alarms
alarm.

Related Topics

Manage Policies

Quick Look
The required permission to access this view is Manage services. To access the Alarms view, go to

A
(Admin) > Health & Wellness. The Health & Wellness view opens with the Alarms tab
displayed. The Alarms tab contains an alarms list and an Alarm Details panel.
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Respond

admin v

Event Sources  Endpoin rces altl ss Security

Policies  System Stats Browser  Event Source Monitoring

1| nme state Severity | Rule Name Sservice Hostname 1P Address stat value |

Active e

Host Unreachable Host broker

Active Host archiver

Active

S|I1E0) LRy

Log Decoder logdec
Active Host dec
Active De

Active

Active
Active
Active

Active

Active
Active tatus Indicator
Active
Active

Active

Active dec FileSystem/Mounted Filesystem Disk Usage Perc.
Active

Active em/Mounted Filesystem Disk Usage Perc..  66%

Active Sessian

Active s Broker/Session Rate (current)

3

| Page 1 of1 | | C' [ AutoRefresh ltems 1 -22 of 22

RS /\ NETWITNESS PLATFORM 11.5.0.0

Time when the alarm was triggered.
AN Status of the alarm:

o Active - the statistical threshold was crossed triggering the alarm.

¢ Cleared - the clearing threshold was crossed and the alarm is no longer active.
RN Severity assigned to this alarm:

o Critical
¢ Medium

o Low
Name of the rule that triggers the alarm.
Service defined in the rule.
n Host on which the alarm is triggered.
Statistic selected in the rule that triggers the alarm.
“ Value of the statistic that triggered the alarm.
n Identification number of the alarm.

Note: NetWitness Platform sorts the alarms in time order. You can sort the relevant parameters in
ascending or descending order.

This figure shows the Alarms tab with the Alarm Details panel expanded.
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Files

admin v
Endpoint Sources  Health & S5 ystem  Security
Alarms Monitoring Policies System Stats Browser  Event Source Monitoring
= Delete
s Eas Shim] | EhARE S
L]
L]
L]
° dec
L] dec
L] dec
° dec
L]
L]
L]
L] al Log Decoder Capture Rate Zero Log Decoder logdec
® Respond Server in Critical State Respond Server =
° . eck your upstream log
| ure that they are
L]
L] sa
e dec 0
N dec !
° on Ratbitng Message Br s
° on Rat Broker broker o
@+ Broker Session Rate Zero Broker = [2]
= 5]
o o
(°]
o
o
o
o
ﬂ? r_decoder/zauge
| Page 1 of1 | Ic ¥ Auto Refresh Items 1-22 0f 22

Alarm Details Panel

The Alarm Details panel displays information for the alarm selected in the Alarms list. It contains
all the information in the Alarms list plus the following fields.

Alarm Notified time

Suppression start time

Suppression end time

Suppression start (selected time zone)
Suppression end (selected time zone)
n The Policy ID

The Rule ID

IEY The Host ID

BN The Stat ID

Item key
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Event Source Monitoring View

Note: For NetWitness Platform 11.3.1, this view has been deprecated: this functionality is now

a
available in the (Admin) > Event Sources > Discovery view. To manage Event Sources,

see "About Event Source Management" in the NetWitness Platform Event Source Management
Guide.
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Health and Wellness Historical Graphs

Configuring Archiver monitoring enables you to automatically generate notifications when critical
thresholds concerning Archiver aggregation and storage have been met. The Historical Graph view
provides a visualization of historical data.

Note: Historical graphs are not available for non-numeric statistics, and is indicated by a greyed-
out icon.

See the following topics for more details:

o Historical Graph View for Events Collected from an Event Source

« Historical Graph for System Stats

Historical Graph View for Events Collected from an Event Source

Note: For NetWitness Platform 11.4.1, this view has been deprecated. To manage Event Sources,

a4
use the (Admin) > Event Sources view. For details, see "About Event Source Management"
in the RSA NetWitness Platform Event Source Management Guide.

Historical Graph for System Stats
To access the Historical Graph for the System Stats:
1. Goto ADMIN > Health & Wellness.
The Health & Wellness view is displayed with the Alarms tab open.
2. Click the System Stats Browser tab.
The System Stats Browser tab is displayed.

3. In the Historical Graph column, select b

The Historical graph for the selected statistic for a host is displayed.
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The figure displays the system stats view for the Memory Utilization statistics.

Historical Graph

Concentrator: Memory Utilization Time Frame | Current Day v
Zoom 1h 6h  12h 1d Al From | Feb 1, 2019 To | Feb 1, 2019
aoMm §
£
m
35M
30M
08:00 09:00 10:00 11:00 12:00 13:00 14:00 15:00 16:00 17:00 18:00 15:00
— |
|1,_ — T Feb . 0600 12:00 e s
1 m 3
—— average
Click and drag in the plot area to zoom in

Parameters

You can customize the graph view as required. The table lists the various parameters used to
customize the historical graph view.

Time Frame Select the time frame for which you want to view the historical data.
The available options are: Current Day, Current Week Current Month,
and Current Year,

From <date> To Select the date range for which you want to view the historical data,
<date>

You can zoom in for a detailed view of the data in the Historical graph.
Zoom in function 1 and 2:

You can select one of the values to view the historical data for the selected value. The figure below
displays an example for the 6h frame selected for zoom in. The slider bar at the right bottom corner
is also changed to a 6h window.

Alternatively, you can slide the bar in the right hand corner to zoom in to a required frame.
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Historical Graph

Host: Mounted Filesystem Disk Usage Percent Time Frame | Current Momi v
Zoom Tw 2w 3w 1m Al From | Jun 29, 2017 To | Jul 14, 2017

7
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9] 26 1 3. Ju 1El___Lir
L] mn ]
average
Click and drag in the plot area to zoom in

Zoom in function 3:
You can click and drag in the plot area to zoom in for a required frame of time.

The figure below displays an example of how the graph appears while you click and drag.

Historical Graph

Host: Mounted Filesystem Disk Usage Percent Time Frame | Current Momi v
Zoom Tw 2w 3w 1m Al From | Jul 10, 2017 To | Jul 13, 2017
7
Tuesday, Jul 11, 18:00 6.5

average: 600

| s

o
anep,

08:00 16:00 11, Jul 08:00 16:00 12, Jul 08:00 16:00 13. Jul 08:00

19. Jun 26. Jun Ta_ulf

average

Click and drag in the plot area to zoom in
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Health and Wellness Settings View - Archiver

To access the Archiver Monitoring view:

Q
1. Goto (Admin) > Health & Wellness.

2. Select Settings > Archiver.

What do you want to do?

Administrator Monitor service details of Archiver Monitor Service Details

Quick Look

Endp Health N Security

System Stats Browser  Event Source Monitoring  [SeRES

| —

Archiver Monitoring

- norifications to be generated when critical Archiver and

and Warehouse Connector, see Health Policy

Aggregation Status

Notify After < ~

For [l Failed [ Offiine

Aggregation Connection

Notify After Failing For C|Minutes v

Storage Connection

Notify After Failing For S| Minutes  ~

Storage Capacity
Storage Threshold 8y @ Space O Time

When Storage Size Is </ %Ful When Warm Storage Size Is KL

Notification Type

Clemai [ Sysiog Notficaion [ SNIMP Trap Nerfication

Bl Displays Archiver Monitoring Panel

Pl Configures Archiver Monitoring Panel to automatically receive notification

Features

The following table lists the parameters required to configure Archiver to automatically generate
notification when critical thresholds are reached.
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Notify After

Aggregation
Status

Aggregation
Connection

Storage
Connection

Storage
Capacity

Notification
Type

For

Notify After
Failing for

Notify After
Failing for

Storage Threshold
By

When Storage Size
Is

When Warm
Storage Size Is

Configure email or
distribution list

Configure Syslog
and SNMP Trap
servers

NW Console,
Email,

Syslog Notification,
SNMP Trap
Notification

Number of minutes or hours after which you are notified of
aggregation status

Failed - If enabled, you are notified when the

Archiver aggregation status is failed for the defined number
of minutes or hours.

Offline - If enabled, you are notified when the

Archiver aggregation status is offline for the defined number
of minutes or hours.

Number of minutes or hours after which you receive
notification if the Archiver aggregation connection fails.

Number of minutes or hours after which you receive
notification if the Archiver storage connection fails.

Select Space if you want to receive a notification when the
Archiver storage capacity exceeds the percentage defined in
the When Storage Size Is field.

Select Time if you want to receive a notification when the
files stored in the Archiver exceeds the defined number of
days in the When Oldest Storage File Is field.

Enter the percentage of used storage to trigger a notification.

Enter the percentage of used storage on the warm server to
trigger a notification.

Click to configure email so that you can receive notifications
in NetWitness Platform.

Click to configure audit logs.

Enable NW Console to get notifications on the NetWitness
Platform UI notification toolbar.

Enable Email to get email notifications.
Enable Syslog Notification to generate syslog events.

Enable SNMP Trap Notification to get audit events as
SNMP traps.
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Health and Wellness Settings View - Event Sources

Note: For NetWitness Platform 11.4.1, this view has been deprecated. To manage Event Sources,

4
use the (Admin) > Event Sources view. For details, see "About Event Source Management"
in the RSA NetWitness Platform Event Source Management Guide.
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Health and Wellness Settings View - Warehouse Connector

Configuring the Warehouse Connector monitoring enables you to automatically generate notification
when critical thresholds concerning Warehouse Connector and storage have been met.

Access the Warehouse Connector Monitoring view

QA
1. Goto (Admin) > Health & Wellness.

2. Select Settings > Warehouse Connector.

What do you want to do?

Administrator View the details of Warehouse connector ~ Warehouse Connector Details View

Related topics

Monitor Service Details

Quick Look

The Warehouse Connector Monitoring view is displayed.

Ho Files  Dashboard  Reports

Endg rces Health & Wellnes: System Security

System Stats Browser  Event Source Monitoring

Notify Offline For < Minutes

Stream Status
Notify Stopped For
Disk Is

[ Sysiog Notification (] SNMP Trap Notification

RS /\ NETWITNESS® PLATFORM

Displays the Warehouse Connector Monitoring view panel.
Allows you to configure Warehouse Connector Monitoring parameters.
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Warehouse Connector Monitoring parameters

The following table lists the parameters required to configure the Warehouse Connector to
automatically generate notification when critical thresholds are reached.

Source or
Destination
Status

Notify Offline For

Stream Status Notify Stopped For

Disk Is

Source Is Behind

Rejected Folder Size
Is

Number Of Files in
Permanent Failure
Folder

Number of minutes or hours after which you receive a
notification if the source or destination connection fails.

Number of minutes or hours after which you receive a
notification when the Stream goes offline.

The limit on the percentage of disk usage after which
you would like to receive a notification.

Number of sessions after which a notification is raised if
the source goes behind the defined number of sessions.

Limit on the percentage of folder usage after which you
receive a notification.

Limit on the number of files in the permanent failure
folder after which you receive a notification.

Notification = Configure email or Click to configure email so that you can receive
Type distribution list notifications in NetWitness Platform.
Configure Syslog and  Click to configure audit logs.
SNMP Trap servers
NW Console, Enable NW Console to get notifications on the
Email, NetWitness Platform Ul notification toolbar.
Syslog Notification, Enable Email to get email notifications.
SNMP Trap Enable Syslog Notification to generate syslog events.
Notification Enable SNMP Trap Notification to get audit events as
SNMP traps.
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Monitoring View

NetWitness Platform provides detailed statistics and other information about the host and the
individual NetWitness Platform services in Details views. You can view the current health of all the
hosts and the services running on the hosts in the Monitoring view.

What do you want to do?

Administrator View and Perform Procedures Monitor Hosts and Services

Quick Look

To access this view:

Q
1. Goto (Admin) > Health & Wellness.
2. Click the Monitoring tab.

The Monitoring view is displayed.

R admin v

3

Health & Wellness em  Security

Monitoring Poliies System Stats Browser  Event Source Monitoring Settings

Groups Hosts Filter
Name Count
Stopped Services Stopped Processing Physical Drive Problems Logical Drive Problems Full Filesystems
Sal
@ 0 7 2 host(s) 0 host(s) 0 host(s)
S growp [-]
ARCH Status CPU:03% Memory: 5.37 GB/125.64 GB
& SubscriptionGroups = - Hemen —
Service Health Status  Rate Name Service Type cpu Memory Usage Uptime
Ready 0 archive Archiver 2.5% 613.52M8 3 hours 20 minutes 33 =

Ready 0 archi Warkbench 0.3% 28.14 MB 3 hours 20 minutes 42 seconds

B BROK Status: CPU: 0.43% Memory: 2.56 GB/125.64 GB
Service Health Status ~ Rate Name Service Type cPU Memaory Usage Uptime

Ready 0 BROK - Broke: Broker 0.6% 113.80MB 3 hours 20 minutes 45 seconds
B CONC Status: CPU: 0.39% Memory: 8.90 GB/34.21 GB
Serviee Health Status  Rate Name Service Type cpu Memory Usage Uptime

Ready 0 CONC - Cancentrata Concentrator 45% 93857 M5 2 hours 20 minutes 12 seconds
B decode Status: CPU:0.23% Memory: 5.84 GB/109.89 GB
Service Health Status ~ Rate Name Service Type cPU Memaory Usage Uptime

Ready [ ] 0 Decoder 0.8% 2.15GB 52 minutes 2 seconds
B ELHYB Status: CPU: 1.83% Memory: 35.86 GB/125.64 GB

»
| Page 1 of2 [ )P I C Displaying 1- 10 0f 16

RS /\ NETWITNESS' PLATFORM 11.5.0.0

The Monitoring tab shows health statistics for the NetWitness Platform hosts and services.
The Group panel enables you to view statistics for a selected group.
The Hosts panel displays operational statistics.
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Groups Panel

The Groups panel lists all of the groups of hosts available. When you select a group, the associated
content is displayed in the Hosts panel.

Note: If the total host count in the Groups panel is lower than the actual number of hosts displayed
in the Hosts panel, refer to the Troubleshooting Health & Wellness topic for possible causes of
this issue and recommended solutions.

Hosts Panel

The Hosts panel displays operational statistics for hosts and the services running on each host.

Filter Type a host name or a service name in the Filter field to display the corresponding
hosts and services in the Host panel.

Stopped Click Stopped Services to display a list of all stopped services. It also displays
Services the host on which the service is installed.

Stopped Click Stopped Processing to display a list of all the hosts that have services
Processing installed on them that are in the stopped processing status.

Physical Click to view the hosts that have physical drive problems.

drive

Problems

<#> host(s)

Logical Drive Click to view the hosts that have logical drive problems.

Problems

<#> host(s)

Full Click to view the hosts that have full file systems.

Filesystems

<#> host(s)

Note: The summary information in the boxes at the top displays the System Statistics for all of the
hosts configured in NetWitness Platform and does not change with the application of filters on the

groups.

Below the boxes at the top of the Hosts panel is a list of hosts, the services installed on them, and
information regarding the hosts and services.

Host Name  Displays the host name.
If a host has services installed that are not in view, you will see a E prefixed to the
host name.
Click B to view all the services installed on the host.
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Status Displays the status of the Host.
@ - The host is active and running.

® _ The host is stopped or yet to start processing.

CPU Displays the current CPU usage of the host.
Memory Displays the Memory used by the host.

When you click E2 prefixed to the host name, a list of all the services installed on the host is
displayed. The table below describes parameters displayed for a service and their description.

Service Displays the status of the service.
@ Ready - The service is active and running.
® Stopped - The service is stopped or yet to start processing.

Health Displays the processing status of the service.
Status (" - The process is running and the data is being processed at a rate greater than
Zero.

® _ The processing is stopped.
" - The processing is turned on but the data is not being processed.

Rate Shows the rate at which data is being processed.

Name Name of the service in the format <host> - <service>, Click the link in the
Name field to get additional service details.

Service Name of the type of service.

Type

CPU Shows the current CPU usage of the service.

Memory Displays the Memory used by the service.

Usage

Uptime Displays the time for which the service has been running.
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Archiver Details View

The Archiver Details view provides information about the Archiver. The following figure shows the
Archiver details.

RSA e nd Users osts Files E R admin v

Hosts  Se s vent Sources  Endpoint Sources  Health & Wellness ) n  Security

Alarms Monitoring Policies System Stats Browser  Event Source Monitoring Settings

HOST AND SERVICES 9 -
Archiver Details
Host
Service
I Archiver
cPU 3% Used Memor. 319.57 MB
Workbench v
Running Since 2018-Mar-04 20:50:06 Max Process Memory 125.64 GB
Build Date 2019-Feb-26 15:10:02 Version Information 11.3.00
Details
Aggregation State stared Time Begin 2019-Feb-28 14:16:00
Session Free Pages 157 Time End 2019-Mar-06 16:45:23
Meta Free Pages 37500 Session Rate Max 31564
Database Status Session Rate 0
Datzbase Session Rate Database Session Free Space
Database Session Rate Max Database Session Volume Bytes
RS /\ NETWITNESS PLATFORM 11.5.00

For the related procedure, see Monitor Service Details

This section displays the current generic statistics for the service.

Description

Aggregation State of data aggregation.
State

Time Begin Time (UTC) when the first session was tracked by the index.

Session Free Session pages available for aggregation.
Pages

Time End Time (UTC) when the last session was tracked by the index.

Meta Free Pages available for aggregation.
Pages

Session Maximum sessions per second rate.
Rate Max
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e Jowamen

Database
Status

Session
Rate

Database
Session
Rate

Database
Session Free
Space

Database
Session
Rate Max

Database
Session
Volume
Bytes

Status of databases. Valid values are:

e closed - not available for QUERY and UPDATE (databases are being
initialized). This value is seldom seen.

« opened - available for QUERY and UPDATE.

e failure - failed to open. This can happen for any number of reasons. You can
check this if CAPTURE fails to start or if queries fail to return data. This is
normally caused by database corruption.

Sessions per second rate.

Per second rate at which the service is writing sessions to the database.

Amount of session free space available for aggregation.

Maximum per second rate at which the service is writing sessions to the database.

Number of session bytes in the database.
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Broker Details View

The Broker Details view provides information about the Broker. The following figure shows the
Broker details.

RS/\ | e nd Hosts Files Dz 2 S admin v

Hosts Services Event Sources Endpoint Sources Health & Wellness ystem  Security

Alarms  Monitoring  Polides  System Stats Browser  Event Source Monitoring  Settings

HOST AND SERVICES

Broker Details

Host
Service
| Broker
Reporting Engine cPu 0.5% Used Memory 0.52 M8
Running Since 2019-Feb-2514:59:44 Max Process Memary 31.42GB
Orchestration Server
Build Date 201943008 17:46:13 Version Information
Security Server
Admin Server Details
Config Server
. Agzregation State stopped Weta Rate o
Investigate Server Session Rate 0 Meta Rate Max 0
Integration Server Session Rate Max

Content Server

Source Server

RS/\ NETWITNESS' PLATFORM

For the related procedure, see Monitor Service Details.

This section displays the current generic statistics for the service.

Description

Aggregation State  State of data aggregation.

Meta Rate Metadata objects per second rate.

Session Rate Sessions per second rate.

Meta Rate Max Maximum metadata objects per second rate.

Session Rate Max Maximum sessions per second rate.
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Concentrator Details View

The Concentrator Details view provides information about the Concentrator. The following figure
shows the Concentrator details.

Hosts Files Da: rd admin v

Event Sources Endpoint Sources Health & Wellnes. tem  Security

Monitoring Policies System Stats Browser ~ Event Source Monitoring Settings adminserver concentrator @

FesTap SRR Concentrator Details
Host

Service

I Concentrator
cPy 1.4% Used Memory 170.57 MB
Running Since 2019-Feb-01 04:47:17 Max Process Memory 7.80GB
Build Date 20194an-28 18:52:20 Version Information 11.3.00
Details
Aggregation State started Time Begin 2016-Jun-24 06:19:03
Meta Rate 0 Time End 2019-Feb-01 20:21:02
Meta Rate Max 238
Session Rate 0
Session Rate Max 9

RS /\ NETWITNESS® PLATFORM 11.5.00

For the related procedure, see Monitor Service Details

The section displays the current generic statistics for the service.

Description

Aggregation State State of data aggregation.

Time Begin Time (UTC) when the first session was tracked by the index.
Meta Rate Metadata objects per second rate.
Time End Time (UTC) when the last session was tracked by the index.

Meta Rate Max Maximum metadata objects per second rate.
Session Rate Sessions per second rate.

Session Rate Max Maximum sessions per second rate.
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Decoder Details View

The Decoder Details view provides information about the Decoder. The following figure shows the
Decoder details.

RSA I - i . Files D R admin v
Hosts Services Event Sources Endpoint Sources Health & Wellness i
Alarms Monitoring Policies System Stats Browser  Event Source Monitoring Settings
HOST AND SERVICES .
Decoder Details
Host
Service
I Decoder
cpPU 38.8% Used Memory 265GB
Running Since 2018-Mar-05 17:46:21 Max Process Memory 94.21 GB
Build Date 2019-Feb-26 15:05:58 Version Information 11.3.00
Details
Capture Status started Meta Bytes 2000 KB
Capture Kept 0 bytes Meta Tota @39
Capture Dropped ] Packet Bytes 192.00 KB
Capture Dropped Percent 0% Packet Total 789
Capture Rate o Session Bytes 4.00K8
Captura Rate Max o Session Tota 30
Time Begin Pool Packet Write o
Time End Pool Packet Assembler o
Assembler Packet Pages o Pool Packet Capture 500000
S v 500
RS\ NETWITNESS' PLATFORM 11.5.0.0

For the related procedure, see Monitor Service Details.

This section displays the current generic statistics for the service.

Description

Capture Status of data capture. Valid values are:

Sl e starting - Starting data capture (not capturing data yet).
e started - Capturing data.
e stopping - Stopping data capture (received request to stop data capture, but not
have not stopped capturing data yet).
e stopped - Not capturing data.
e disabled - Not configured as a Decoder service.
Meta Number of meta bytes in the database.
Bytes
Capture Number of packets kept during capture.
Kept
Meta Amount of metadata in the database.
Total
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T

Capture Number of packets reported by the network card as dropped. After the service stops
Dropped  capturing data, the rate is reset to zero.

Packet Number of packet bytes in the database.

Bytes

Capture Packets reported by the network card as dropped as a percentage.

Dropped

Percent

Packet Number of packet objects held in the packet database. The total decreases when the
Total database rolls files off due to size constraints. After the service stops capturing data,

the number is not reset.

Capture Megabits per second rate at which the service is capturing data. Rate is a rolling
Rate average sample over a short time period (10 seconds). After the service stops
capturing data, rate is reset to zero.

Session Number of session bytes in the database.
Bytes
Capture Maximum megabits per second rate at which the service is capturing data. Rate is a

Rate Max rolling average sample over a short time period (10 seconds). After the service stops
capturing data, displays the maximum rate during data capture.

Session Number of sessions held in the session database. This value shrinks when the
Total database rolls files off due to size constraints. After the service stops capturing data,
the number is not reset.

Time Time when first packet was captured (time when the first packet was stored in the

Begin packet database). This time increases as packets are rolled out of the packet
database.

Pool Number of packet pages currently in the PCS pipeline that need to be written to the

Packet database.

Write

Time End Time when the last packet was captured (time when packet was written to the
database). The time increases as new packets are captured.

Pool Number of pool packet pages waiting to be assembled.
Packet
Assembler

Assembler Number of packet pages waiting to be assembled.
Packet
Pages

Pool Number of packet pages available for capture.
Packet
Capture
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ESA Correlation Details View

The ESA Correlation Details view provides information for the ESA Correlation service. The
following figure shows the ESA Correlation service details.

ond Users Hosts a rd Reports admin s

vices Event Sources Endpoint Sources Health & Welln stem  Security

Monitoring Policies System Stats Browser  Event Source Monitoring Settings ESAPrimary @

HOST AND SERVICE! A D ) cA At Lile
ESAPrimary - ESA Correlation Details

Host
Service

Contexthub Server

. cpu 0.2% Used Memory 402GB

Entity Behavior Analytics ’
Running Since 2019-Mar-15 09:10:07 Max Process Memaory 1530 GB

| sa corretation Build Date 2019-Mar-09 01:45:29 Version Informatian 11300

Health Stats VM
Configuration Update Status Healthy process Modules Healtny
Process JVM Memory Healthy Security PKI Certificate Healthy
Data Connection Healthy

RS /\ NETWITNESS' PLATFORM 11.5.0.0

For the related procedure, see Monitor Service Details.

Many services, including the ESA Correlation service, have Health Stats and Java Virtual Machine
(JVM) tabs. The Health Stats tab provides information about the health status of the service. The
JVM tab shows the total memory used by the selected service and the total memory capacity of the
host.

For more information on the ESA Correlation service and ESA Rule memory usage, see the Alerting
with ESA Correlation Rules User Guide.

Health Stats Tab

The Health Stats tab provides information about the health status of the selected service.

Health Stats VM

Configuration Update Status Healthy Process Modules Healthy
Process JVM Memary Healthy Security PKI Certificate Healthy
Data Connection Healthy

The services on this tab can show one of three states:
e Healthy: The service is healthy.

e Unhealthy: The service is mostly functional, but it needs attention to mitigate potential down
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time.

e Fatal: Action needs to be taken to restore the service.

m

Configuration Indicates whether the service requires a restart for configuration changes to take
Update effect. If the Configuration Update Status shows as Unhealthy, restart the service.
Status

Process JVM  Indicates the memory usage status. An Unhealthy status occurs when heap

Memory memory usage is greater than or equal to 80%. A Fatal status occurs when heap
memory usage is greater than or equal to 95%. If the service is using too much
memory, you can add more memory or move services to other hosts. For more
details on memory usage, go to the JVM tab.

Data Indicates the health of the database connection of the service to MongoDB.
Connection

Process Indicates the health of the service. If a service is starting up, it shows as
Modules Unhealthy since its health is not yet determined. A service is Healthy if it is up

and running properly. A service shows as Fatal if it is running in upgrade mode or
if the service is running in safe or degraded mode.

Security PKI  Indicates the service certificate health. It shows as Healthy if a given X509
Certificate certificate is self-signed.

JVM Tab

The JVM tab shows the total memory used by the selected service and the total memory capacity of
the host.

Health Stats Jvm

JVM Total Memory Max 64.00 GB VM Total Memory Used 2310GB

m

JVM Total Memory Max Shows the total memory capacity for the entire host.

JVM Total Memory Shows the total memory used by all services and processes on the
Used host.

ESA Analytics Details View

The ESA Analytics Details view provides health status information about the selected ESA
Analytics service. ESA Analytics services process the data for automated threat detection. It is
important that you address any item that shows a status other than healthy, so that data processing is
not interrupted and critical events are not missed.

The following figure shows the ESA Analytics Details view.
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Respond Users Hosts Files Dashboard Reports admin v

HEALTH & WELLNESS SECURITY

Policies System Stats Browser  Event Source Monitoring Settings NWAPPLIANCE10604 @

Event Stream Analytics Server Details
Service

Event Stream Analysis
CcPU 0.1% Used Memory 653.36 MB

Contexthub Server ’
Running Since 2017-Jul-13 02:04:02 Max Process Memory 31.42GB

Entity Be . P . - "

I nuty Build Date 2017-Jul-05 18:39:18 Version Information
Health Stats VM
Configuration Update Status Healthy Process Modules Healthy
Process JVM Memory Healthy Security PKI Certificate Healthy
Data Connection Healthy
RS /\ NETWITNESS  PLATFORM 11.5.0.0

For the related procedure, see Monitor Service Details.

Many services, including the ESA Analytics service, have Health Stats and Java Virtual Machine
(JVM) tabs. The Health Stats tab provides information about the health status of the service. The
JVM tab shows the total memory used by the selected service and the total memory capacity of the
host. For more information, see Health Stats Tab and JVM Tab.

For more information on ESA Analytics, see the Automated Threat Detection Guide and the ESA
Configuration Guide.

Host Details View

The Host Details view provides information about a host, as shown in the following figure.
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RSA e Respond  Users  Hosts  Files D d  Reports admin v

Hosts Services Event Sources Endpoint Sources Health & Wellness tem  Security

Alarms Monitoring Policies System Stats Browser ~ Event Source Monitoring Settings adminserver @

HOST AND SERVICES .

Host Details

| Host

System Info
Broker

Host sdminserver Memory Utilization 69.51%
Reporting Engine . - 279

cpPU 16 Used Memory 3279GB
Orehestration Server Running Since 2010-Fe 02 22:50:45 Total Memary ariree
Security Server Current Time 2019-Feb-02 0! Cached Memory 478 GB

4 wa 0%

Admin Server Uptime 4 hours 48 minutes 39 seconds Swap Utilization

System Info Used Swap Obytes
Config Server Linux 3.10.0-862.14.4.617.xB6_64 x86_64 TotslSwa concs
Investigate Server
Respond Server Physical Drive || Logical Drive || File System Adapter Message Bus
Integration Server State Enclosure Slot Failure Count Raw Size Inquiry Data
Content Server
Source Server

R'S/\ NETWITNESS' PLATFORM 11.5.0.0

The options panel on the left displays the host and the services installed on the host. You can click
on a host or service to view the statistics and other pertinent information for that host or service.

The Details panel displays information that is specific to the host and provides additional information
regarding the hardware of the host.

For the related procedure, see Monitor Service Details

The top section displays the current performance, capacity, and historical statistics for the host.

Parameter Description

Host Hostname.

CPU Current CPU usage of the host.

Running Since Time when the host was started.
Current Time Current time on the host

Uptime Time for which the host has been active.
System Info OS version installed on the host.

Memory Utilization Percentage of memory utilized by the host.
Used Memory Memory used in GB.

Total Memory Capacity of the memory installed on the system.
Cached Memory Memory that is cached to disk in GB.

Swap Ultilization Percentage of system swap in use.
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Used Swap Swap used in GB.
Total Swap Capacity of the swap installed on the system.

The lower section displays the current generic statistics for the host in the tabs described in the
following table.

Physical Type of physical drive, its usage and additional information of the physical drive on the
Drive host.

Logical Logical drive on the host.
Drive

File File system information, the size, current usage, and available capacity on the host.
System

Adapter Adapter used on the host.

Message Publish In Rate - rate at which incoming messages are published to the message bus
Bus queue.
Total Messages Queued - number of messages in the message queue.
Memory Used - amount of memory used by the message bus (in bytes).
Disk Free - free disk space available for the message bus (in bytes).
Memory Limit - system memory limit. If the memory usage exceeds this value, this
trips the Memory Alarm and NetWitness Platform stops accepting messages.
Disk Free Limit - limit of free disk space available for the message bus. If the
available disk space falls below this value, this trips the Disk Free Alarm and
NetWitness Platform stops accepting messages.
Memory Limit Available - Amount of memory available to this message broker (in
bytes) before the Memory Used Alarm is tripped.
Disk Limit Available - Amount of free disk space available to this message broker (in
bytes) before the Disk Free Limit alarm is tripped.
Disk Free Alarm - True or False. True indicates that the available disk space is below
the value set in Disk Free Limit and NetWitness Platform has stopped accepting
messages.
Memory Alarm - True or False. True indicates that the available memory is below the
value set in Memory Limit and NetWitness Platform has stopped accepting messages.
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Log Collector Details View

The Log Collector Details view provides information for the Log Collector. The following figure
depicts the Log Collector Details.

admin v

Alarms Monitoring Policies System Stats Browser  Event Source Monitoring Settings

HOTANEEEICE Log Collector Details
Host

Service
Concentrator
i cpu 38% Used Memory 1.04 GB
| Log coltector
Running Since 2019-Mar-04 21:18:44 Max Process Memery 125.64 GB
SCEEEdey Build Date 2019-Feb-26 19:08:37 Version Information 11300

Endpoint Server
Collection | Event Processing

Transport Protocol Status EPS Total Events Errors Warnings

checkpoint stopped 0 0 0 0
netflow stopped 0 0 0 0
file stopped 0 0 0 0
sdee stopped 0 0 0 0
odbe stopped 0 0 0 0
vmware stopped 0 0 0 0
syslog stopped 0 0 0 0

windows stopped 0 0 0 0 .

RS /\ NETWITNESS' PLATFORM 11.5.0.0

For the related procedure, see Monitor Service Details.

The lower section consists of the Collection and Event Processing tabs that display generic statistics
for the service.

Collection Tab

Displays the event collection statistics for each Log Collection protocol you have implemented in
NetWitness Platform (see "Log Collection Getting Started Guide" in the Log Collection Guides).

Event Processing Tab

Displays statistics for the NetWitness Platform internal event processing protocol (that is, the Log
Decoder) for Log Collection.

Parameter | Description

Transport NetWitness Platform protocol use for Log Collections (that is, the Log Decoder).
Protocol
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Parameter | Description

Status Status of the Log Decoder. Valid values are:
e starting - Starting data capture (not capturing data yet).
e started - Capturing data.

e stopping - Stopping data capture (received request to stop data capture, but not
have not stopped capturing data yet).

e stopped - Not capturing data.

e disabled - Not configured as a Decoder service.

EPS Rate (events per second) at which this the Log Decoder is processing events from
the Log Collector.

Total Events Total events processed by the Log Decoder.
Errors Number of errors encountered.
Warnings Number of warnings encountered.

Byte Rate Current throughput in bytes per second.

Log Decoder Details View

The Log Decoder Details view provides information for the Log Decoder. The following figure
shows the Log Decoder Details.

RS/\ Investigate Respond Users Hosts Files Dashboard Reports admin v

Hosts Services Event Sources Endpoint Sources Health & Wellness  System  Security

Alarms Monitoring Policies System Stats Browser  Event Source Monitoring Settings

HOST AND SERVICES e
Log Decoder Details

Host
Service

Concentrator
cpPyU 97% Used Memon 8.10GE

Log Collector v
Running Since 2019-Mar-05 08:44:53 Max Process Memary 125.64GB

Log Decoder - L )

I o2 Build Date 2019-F2b-26 15:06:05 Version Information 113.00

Endpoint Server
Details
Capture Status started Packet Rate Max 1
Events Per Second 7 Pool Packet Capture 749998
Meta Rate 26 Pool Packet Assembler 0
Meta Rate Max 88 Assembler Packet Pages 0
Capture Dropped 0 Pool Packet Write 0
Capture Dropped Parcent 0% Time Begin 2019-Mar-05 08:45:28
Time End 2019-Mar-06 20:30:52

R'S /\ NETWITNESS PLATFORM 11.5.0.0

For the related procedure, see Monitor Service Details.

This section displays the current generic statistics for the service.
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e o

Capture
Status

Packet
Rate Max

Events Per
Second

Pool
Packet
Capture

Meta Rate

Pool
Packet
Assembler

Meta Rate
Max

Assembler
Packet
Pages

Capture
Dropped

Pool
Packet
Write

Capture
Dropped
Percent

Status of data capture. Valid values are:
e starting - Starting data capture (not capturing data yet).

e started - Capturing data.

e stopping - Stopping data capture (received request to stop data capture, but not
have not stopped capturing data yet).

o stopped - Not capturing data.

e disabled - Not configured as a Log Decoder service.

Maximum per second rate at which the service is writing packets to the
database. Rate is a rolling average sample over a short time period (10 seconds).
After the service stops capturing data, displays the maximum rate during data
capture.

Rate (events per second) at which the Log Decoder is processing events from the Log
Collector.

Number of packet pages available for capture.

Per second rate at which the service is writing metadata objects to the database. Rate
is a rolling average sample over a short time period (10 seconds). After the service
stops capturing data, rate is reset to zero.

Number of packet pages waiting to be assembled.

Maximum per second rate at which the service is writing metadata objects to the
database. Rate is a rolling average sample over a short time period (10 seconds).
After the service stops capturing data, displays the maximum rate reached during data
capture.

Number of packet pages waiting to be assembled.

Number of packets reported by the network card as dropped. After the service stops
capturing data, rate is reset to zero.

Number of packet pages in the PCS pipeline that need to be written to the database.

Packets reported by the network card as dropped as a percentage.

249

References



System Maintenance Guide

Description
Time Time when first packet was captured (time when the first packet was stored in the
Begin packet database). This time increases as packets are rolled out of the packet
database.

Time End Time when the last packet was captured (time when packet was written to the
database). The time increases as new packets are captured.
Malware Details View

The Malware Details view provides information for Malware Analysis. The following figure shows
the Malware Details.

RSA | gate Respond Hosts Files Da

Hosts Se s Event Sources Endpoint Sources Health & Wellness n Security

admin v

Alarms Monitoring Policies System Stats Browser  Event Source Monitoring Settings adminserver malware @

HOST AND SERVICES .
Malware Details

Host
Service

Broker
CcPU 0.2% Used Memon 437GB

I Malware Analysis v
Running Since 2018-Feb-01 00:25:10 Max Pracess Memory 15.67 GB
Build Date Wersion Information 11.3.00
Events VM

Number Of Events For Past 24 Hours Average Processing Time 0 milliseconds
Number Of Files For Past 24 Hours Events In Queue 0
Number Of Events For Past 7 Days Events Processed 0
Number Of Files For Past 7 Days Events Per Second Throughput 0

Number Of Events For Past Month Session Time Of Last Event
Number Of Files For Past Month

Number Of Events For Past 3 Months

[ I N NER F R ER

Number Of Files For Past 3 Months

RS /\ NETWITNESS® PLATFORM 11.5.0.0

For the related procedure, see Monitor Service Details.

Displays the following event-related statistical information for the Malware Analysis service.
o Number of events for the past 24 hours

o Average processing time

o Number of files for the past 24 hours

« Events in queue

o Number of events for the past 7 days

« Events processed

o Number of events for the past 7 days
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« Events per second throughput

« Number of events for the past month

« Session time of the last event

o Number of files for the past month

o Number of events for the past 3 months

o Number of files for the past 3 months

Warehouse Connector Details View

The Warehouse Connector Details tab provides information for the Warehouse Connector, such as
the date it was built, CPU, and version information. The following figure shows the Warehouse
Connector Details.

RSA & ate  Respond  Users Hosts  Files  Dashboard  Reports admin v

Hosts Services Event Sources Endpoint Sources Health & Wellness  System  Security

LE Monitoring Policies System Stats Browser  Event Source Monitoring Settings 113GoldLH &

Warehouse Connector Detalls

Host
Service

Concentrator

N CPU 0.5% Used Memory

Log Collector
Running Since 2019-Mar-14 15:34:04 Max Process Memory

Log Decoder

g Build Date 2019-Mar-11 07:22:43 Version Information
I Warehouse Connector

Details
Streams Complete 0 Streams Running 0
Streams Incomplate 0 Streams Stopped 0

Streams Total

R'S A\ NETWITNESS PLATFORM 115.00

For the related procedure, see Monitor Service Details.
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Policies View

The required permission to access this view is Manage services.

What do you want to do?

Administrator ~ View the policies NetWitness Server and Services Manage Policies

Administrator Add, Edit, Duplicate, and Delete Policies Manage Policies

Quick Look

The figure depicts the Policies view.
RSA

admin v

» [JHost

» [Jintegration Server
» [Jinvestigate Server
» [ Log Collector

» [ Log Decoder

Policy Suppression

Define the tme periods to supsress palidies

Days

Time Range

Hosts
Alarms  Monitoing [EECIEENN  System Stats Browser  Event Source Monitoring  Settings
v
Policies Admin Server: Admin Server Monitoring Policy Save
+ = ® 3 Rules and suppressien schedules of Out-of-the-box policies cannot be directly modified. Duplicate the policy if you wish to so modify them
[ £nzble Last Modiified: 2017-02-20 12:00:00 AM
4 &5 Admin Server (1]
Admin Server Monitoring Pelicy Services
» [ avcriver o Choose the hosts, services, and groups that your health policy applies to.
» [ Braker o +
» [ Cloud Gateway Server o Name ~ Group Type
» [ Concentrator o Al 19 Graup
» [ Config Server
£ [ Rules
» [ Content Server (1] Define the conditians under which you want to trigger an alarm for the Netwitness Platform health problems (definition includes severity, statistic the alarm applies to, threshold, and threshald at which the alarm clears).
After you define the alarm rule, enable or disable the alarm.
» [ Contexthub Server [+
» []Decoder [+
severny category statistic Threshold
» [ ESA Correlation Q
. Critical Frocessinfo Querall F g Status Indicator Alarm = ERROR for 2 MINUTES
» [ Entity Behavior Analytics o High Processinfo Alarm = PARTIALLY_WORKING for 2 MINUTES
» [ Event Stream Analysis [ ] O Admin Critical Pracessinfo Alarm I= started for 0 MINUTES

Palicy suppression is not allowed

Policies Panel

Policy Detail Panel

Q
1. Goto (Admin) > Health & Wellness.
2. Click the Policies tab.

Policies Panel

In the Policies panel, you can add or delete policies for hosts and services in this panel.
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o o

+ - Displays available service types to create a new policy. Select one so that you can
define a policy or policies for it.

- Deletes the selected policy from the Policies panel. You can only delete one policy at

a time.

L7 Allows you to change the name of the policy.

T:=j Creates a copy of the selected policy. For example, if you select First Policy and
click Tfj, NetWitness Platform creates a copy of this policy and names it First Policy
(.

pie Expands the list of policies under the services and hosts in the Policies panel.

HH Contracts the list of policies under the services and hosts in the Policies panel.
List of:

« Services and hosts for which you have defined policies.

o RSA standard policies that you can apply to hosts and services.

Policy Detail Panel

The Policy Detail panel displays the policy selected from the Policies panel.

e

Save Saves any changes you made in this panel.
Policy Type Displays the type of policy you selected.

Modified Displays the last date this policy was modified.
Date

[] Enable  Enables or disables the policy.

Services

+ & Displays menu in which you select:

« Groups to display the Groups dialog from which you select service groups to this
policy.

« Service/Host to display the Services/Hosts dialog from which you select
services to add to this policy. If the policy type is Host, the menu displays Host
(and not Service). You can select services based on policy type.

- Deletes the selected service or group from this policy.
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o Jowamin

Rules

+ Displays the Add Rule dialog in which you define a rule for this policy.
- Deletes the selected rule from this policy.

L7 Displays the Edit Rule dialog for the selected rule.

Policy Suppression

4= Adds a policy suppression timeframe row.
- Deletes the selected policy suppression timeframe row.

Time Zone Selects the time zone for the Policy from the drop-down list. This time zone applies
to both Policy Suppression and Rule Suppression.

| Selects the checkbox to select a policy suppression timeframe row.

Days Days of the week that you want to suppress the policy according to the time range
specified. Click on the day of the week that you want to suppress the policy. You
can select any combination of days including all days.

Time Time range during which the policy is suppressed for the days selected.
Range
Notification
4= Adds an EMAIL notification row.
- Deletes the selected policy suppression timeframe row.

Notification Opens the Notification Servers view in which you can define the Email notification
Settings settings.

| Selects a policy suppression time frame row.

Output The type of notification defined on the Global Notifications page. Can be email,
SNMP, Syslog, or Script.

Recipient ~ The name of the person receiving the notification.

Notification Selects the EMAIL notification server. See "Configure Notification Servers" in the
Server System Configuration Guide for the source of the values in this drop-down list.
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Fowrs pescrpion

Template Selects the Template for this EMAIL notification. RSA provides the Health &
Wellness Default SMTP Template and the alarms template. See" Configure
Notification Templates"in the System Configuration Guide for the source of the
other values in this drop-down list.

Note: Refer to Include the Default Email Subject Line if you want to include the
default Email subject line from the Health & Wellness template in your Health &
Wellness Email notifications for specified recipients.

Groups dialog

P peserpn

Groups panel
Name Displays the service groups you have defined. You can select:
« All to display all your services in the Services panel.

« A group to display the services in comprise that group in the Services
panel.

Services panel

Name Displays the name of the service.
Host Displays the host on which the service is running.
Type Displays the type of service.

Rules Dialog

i e

[] Enable Enables or disables the rule for this policy.

Name Describes the name of the rule.

Description Describes the rule. Include the following information in this field.

« Informational description - purpose of the rule and what problem it monitors.

« Remediation - steps to take to resolve the condition that triggers the alarm for this
rule.
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o Jowmn

Severity Defines the severity of the rule. Valid values are:
o Critical
o High
o Medium
o Low
Statistic Defines the statistics you want to check with this rule. You can select:

« Statistical category from the left drop-down list.
« Statistic from the right drop-down list.

Note: For Public Key Infrastructure (PKI) policy, select PKI in the category and
statistics as any one of the following:

- NetWitness Server PKI Certificate Expiration - Displays the time left before the
certificate expires.

- NetWitness Server PKI CRL Expiration - Displays the time left before the
Certificate Revocation List (CRL) expires.

- NetWitness Server PKI CRL Status - Displays the current status of the CRL.

Refer to the System Stats Browser View for examples of the statistics you may want
to check with a rule.

Alarm Defines he threshold of the rule that triggers the policy alarm:

Threshold N

Note: For CRL expiry the supported format is ddddhhmm, for example:
- 10000 represents 1 day

- 2359 represents 23 hours and 59 minutes

- 10023 represents 1 day and 23 minutes

- 3650100 represents 365 days and 1 hour

o Time in minutes

Recovery  Defines when to clear the threshold of the rule:
o Operator

¢ Amount

o Time in minutes
Rule Suppression

+ Adds a rule suppression timeframe row.

- Deletes the selected rule suppression time frame row.
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o Jowmn

| Selects a rule suppression time frame row.

Time Zone: Displays the Policy time zone. You select the time zone for a policy in the Policy
time-zone  Suppression panel.

Days Defines days of the week that you want to suppress the rule according to the time
range specified. Click on the day of the week that you want to suppress the rule.
You can select any combination of days including all days.

Time Defines the time range during which the rule is suppressed for the days selected.
Range

Threshold Operators

The Alarm Threshold and Recovery Threshold fields in the Rules dialog prompt you for either
numeric or string operators based on the statistic criteria you specify.

Numeric operators drop-down menu: String operators drop-down menu:
= - = -

I= I=

< Contains

<= !Contains

= Regex Match

== IRegex Match

InRange

lInRange

RSA Health & Wellness Email Templates

Note: Please refer to Include the Default Email Subject Line if you want to include the default
Email subject line from the Health & Wellness template in your Health & Wellness Email
notifications for specified recipients.
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Health & Wellness Default SMTP Template

RSA NetWitness Suite

Health Alarm Notification

File Collection Service is off on HOST1000

State
Active

Severity
High

Host
HOST1000

Service
Log Collector

Alarmid
103-2248-0001

Policy
Check Point

Rule
File Collection Service is off

Statistic
Collection State

Value

stopped

Time

April 13, 2018 10:48:13 PM UTC
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Alarms Template

RSA NetWitness Suite

Health Alarm Notification

File Collection Service is off onHOST1000

State
Cleared

Severity
High

Host
HOST1000

Service
Log Collector

Alarmid
103-2248-0001

Paolicy
BootCamp Notification

Rule
Check Point Collection is off

Statistic
Collection State

Value
Policy-Disabled

Time
April 14, 2018 2:31:21 AMUTC

NetWitness Platform Out-of-the-Box Policies

The following table lists the NetWitness Platform Out-of-the-Box Policies with the rules defined for
each policy.

You can perform the following tasks on any of these policies:
« Change service and group assignments.

« Disable or enable policies.

You cannot perform the following tasks on any of these policies:
« Delete them.

« Edit Policy names.
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Note: Additional information about the Out-of-the-Box Policies can be found in the User Interface

under
Health & Wellness > Policies.

Policy Name Alarm Triggered

Communication Failure Host is down, Network is down, Message
Between Master NetWitness ~ Broker is Down, or Invalid or missing
Server Host and a Remote security certificates for 10 minutes or more.
Host
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Policy Name Alarm Triggered

NetWitness
Server
Monitoring Policy

Critical Usage on Rabbitmq
Message Broker Filesystem

Filesystem is Full

High Filesystem Usage

High System Swap Utilization

High Usage on
Rabbitmq Message Broker
Filesystem

Host Unreachable

LogCollector Event Processor
Exchange Bindings Status

LogCollector Event Processor
Queue with No Bindings

LogCollector Event Processor
Queue with No Consumers

Power Supply Failure

RAID Logical Drive
Degraded

RAID Logical Drive Failed

RAID Logical Drive
Rebuilding

RAID Physical Drive Failed

RAID Physical Drive Failure
Predicted

RAID Physical Drive
Rebuilding

RAID Physical Drive
Unconfigured

SD Card Failure

For var/1lib/rabbitmg, Mounted
Filesystem Disk Usage goes over 75%.

Overall Mounted Filesystem Disk Usage
reaches 100%.

Overall Mounted Filesystem Disk Usage
goes over 95%.

Swap Utilization goes under 5 % for 5
minutes or more.

Mounted Filesystem Disk Usage for
var/lib/rabbitmg goes over 60%.

Host down.

Issue with Log Collection Message Broker
Queues for 10 minutes or more.

Issue with Log Collection Message Broker
Queues for 10 minutes or more.

Issue with Log Collection Message Broker
Queues for 10 minutes or more.

Host not receiving power.

For Raid Logical Drive, Drive State equals
Degraded or Partially Degraded.

For Raid Logical Drive, Logical Drive State
equals Offline, Failed, or Unknown.

For Raid Logical Drive, Logical Drive State
equals Rebuild.

For Raid Physical Drive, Physical Drive
State does not equal Online, Online Spun
Up, or Hotspare.

For Raid Physical Drive, Physical Drive
Predictive Failure Count is greater than 1.

For Raid Physical Drive, Physical
Drive State equals Rebuild.

For Raid Physical Drive, Physical
Drive State contains Unconfigured (good).

SD Card Status does not equal ok.
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Policy Name Alarm Triggered

Archiver Aggregation
Stopped

Archiver Database(s) Not

Archiver Status does not equal started.

Database Status does not equal opened.

NetWitness Open
Platform
Archiver Archiver Not Consuming Devices Status does not equal consuming.
Monitoring From Service
Policy
Archiver Service in Bad State  Service State does not equal started or
ready.
Archiver Service Stopped Server Status does not equal started.
NetWitness Broker >5 Pending Queries Queries Pending greater than or equal to 5
Platform Broker for 10 minutes or more.
Monitoring Policy
Broker Aggregation Stopped  Broker Status does not equal started.
Broker Not Consuming From  Devices Status does not equal consuming.
Service
Broker Service in Bad State Service State does not equal started or
ready.
Broker Service Stopped Server Status does not equal started.
Broker Session Rate Zero Session Rate (current) equals 0 for 2 minutes
or more.
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Policy Name Alarm Triggered

NetWitness
Platform
Concentrator
Monitoring Policy

NetWitness
Platform Decoder
Monitoring
Policy

Concentrator >5 Pending
Queries

Concentrator Aggregation
Behind >100K Sessions

Concentrator Aggregation
Behind >1M Sessions

Concentrator Aggregation
Behind >50M Sessions

Concentrator Aggregation
Stopped

Concentrator Database(s) Not
Open

Concentrator Meta Rate Zero

Concentrator Not Consuming
From Service

Concentrator Service in Bad
State

Concentrator Service Stopped
Decoder Capture Not Started

Decoder Capture Rate Zero

Decoder Database Not Open

Decoder Dropping >1% of
Packets

Decoder Dropping >10% of
Packets

Decoder Dropping >5% of
Packets

Decoder Packet Capture Pool
Depleted

Decoder Service in Bad State

Decoder Service Stopped

Queries Pending greater than or equal to 5
for 10 minutes or more.

Devices Sessions Behind is greater than or
equal to 100000 for 1 minute or more.

Devices Sessions Behind is greater than or
equal to 1000000 for 1 minute or more.

Devices Sessions Behind is greater than or
equal to 50000000 for 1 minute or more.

Broker Status does not equal started.

Database Status does not equal opened.

Concentrator Meta Rate (current) equals 0
for 2 minutes or more.

Devices Status does not equal consuming.

Service State does not equal started or
ready.

Server Status does not equal started.
Capture Status does not equal started.

Capture Rate (current) equals 0 for 2
minutes or more.

Database Status does not equal opened.

Capture Packets Percent Dropped (current)
is greater than or equal to 1%.

Capture Packets Percent Dropped (current)
is greater than or equal to 10%.

Capture Packets Percent Dropped (current)
is greater than or equal to 5%.

Packet Capture Queue equals 0 for 2
minutes or more.

Service State does not equal started or
ready.

Server Status does not equal started.
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Policy Name Alarm Triggered

NetWitness ESA Overall Memory Total ESA Memory Usage % is greater than
Platform Event  Utilization > 85% or equal to 85 %.
Steam Analysis
Monitoring ESA Overall Memory Total ESA Memory Usage % is greater than
Policy Utilization > 95% or equal to 95 %.

ESA Service Stopped Server Status does not equal started.

ESA Trial Rules Disabled Trial Rules Status does not equal enabled.

NetWitness IPDB Extractor Service in Service State does not equal started or
Platform IPDB Bad State ready.

Extractor

Monitoring IPDB Extractor Service Server Status does not equal started.
Policy Stopped

NetWitness Incident Management Service Server Status does not equal started.
Platform Incident Stopped

Management

Monitoring

Policy

NetWitness Log Collector Service Server Status does not equal started.
Platform Log Stopped

Collector

Monitoring Log Decoder Event Queue >  Number of events currently in the queue is
Policy 50% Full using 50% or more of the queue.

Log Decoder Event Queue >  Number of events currently in the queue is
80% Full using 80% or more of the queue.

Log Collector Service in Bad  Service State does not equal started or
State ready.
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Policy Name Alarm Triggered

NetWitness Decoder Dropping>10% of Capture Packets Percent Dropped (current)
Platform Log Packets is greater than or equal to 10%
Decoder
Monitoring Log Capture Not Started Capture Status does not equal started.
Poli
orey Log Decoder Capture Rate Capture Rate (current) equals 0 for 2
Zero minutes or more.
Log Decoder Database Not Database Status does not equal opened.
Open
Log Decoder Dropping >1%  Capture Packets Percent Dropped (current)
of Logs is greater than or equal to 1%.
Log Decoder Dropping >5%  Capture Packets Percent Dropped (current)
of Logs is greater than or equal to 5%.
Log Decoder Packet Capture  Packet Capture Queue equals 0 for 2
Pool Depleted minutes or more.
Log Decoder Service Stopped Server Status does not equal started.
Log Decoder Service in Bad  Service State does not equal started or
State ready.
NetWitness Malware Analysis Service Server Status does not equal started.
Platform Stopped
Malware Analysis
Monitoring
Policy
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Policy Name Alarm Triggered

NetWitness
Platform
Reporting Engine
Monitoring
Policy

NetWitness
Platform
Warehouse
Connector
Monitoring
Policy

NetWitness
Platform
Workbench

Reporting Engine Alerts
Critical Utilization

Reporting Engine Available
Disk <10%

Reporting Engine Available
Disk <5%

Reporting Engine Charts
Critical Utilization

Reporting Engine Rules
Critical Utilization

Reporting Engine Schedule
Task Pool Critical Utilization

Reporting Engine Service
Stopped

Reporting Engine
Shared Task
Critical Utilization

Warehouse Connector
Service in Bad State

Warehouse
Connector Service Stopped

Warehouse
Connector Stream Behind

Warehouse
Connector Stream Disk
Utilization > 75%

Warehouse Connector
Stream in Bad State

Warehouse Connector Stream
Permanently Rejected Files >
300

Warehouse Connector Stream
Permanently Rejected Folder
> 75% Full

Workbench Service in Bad
State

Monitoring Policy Workbench Service Stopped

Alerts Utilization is greater than or equal to
10 for 5 minutes or more.

Available disk space is less than 10%.

Available disk space is less than or equal
to 5%.

Charts Utilization is greater than or equal to
10 for 5 minutes or more.

Rules Utilization is greater than or equal to
10 for 5 minutes or more.

Schedule Task Pool Utilization is greater
than or equal to 10 for 15 minutes or more.

Server Status does not equal started.

Shared Task Pool Utilization is greater than
or equal to 10 for 5 minutes or more.

Service State does not equal started or
ready.

Server Status does not equal started.

Stream Behind is greater than or equal to
2000000.

Stream Disk Usage (Pending Destination
Load) is greater than or equal to 75.

Stream Status does not equal consuming or
online for 10 minutes r more.

Number of files in the permanently rejected
files is greater than or equal to 300.

Rejected folder usage is greater than or
equal to 75%.

Service State does not equal started or
ready.

Server Status does not equal started.
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System Stats Browser View

NetWitness Platform provides a way to monitor the status and operations of hosts and services. The
System Stats Browser tab displays key statistics, service system information, and host system
information for a host or service.

You can customize the stats view depending on the parameter you select to filter the data.

To access the System Stats Browser view:

QA
1. Goto (Admin) > Health & Wellness.
The Health & Wellness view is displayed with the Alarms tab open.
2. Click the System Stats Browser tab.

What do you want to do?

Administrator ~ View the System Stat Historical Graph Historical Graph for System Stats

Related Topics

Monitor Service Statistics

Filter System Statistics

Quick Look

The System Stats Browser view is displayed.
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RSA u admin v
Hosts ~ Service nt Sources
Alarms  Monitoring  Policies  [[SYERSUISCIYNERE  Event Source Monitoring  Settings
Host Component Category Statistic Order By
Any | [any - Any - Il clear 2 w
[Regex [Regex ® Ascending (O Descending =
o
Host Ccomponent category statistic subitem value Last update Historical Graph el
o
Host FileSystem Error Status o 20190306 10:46:25P.. ol =
L
Host FileSystem Meunted Filesystem Disk Usage 20190306 10:46:25P... ol
Host FileSystem Wiounted Filesystem Disk Usage 2019.03-06 10:46:25P.. ol
Host FileSystem Meunted Filesystem Disk Usage 20190306 10:46:25P... ol
/
Host FileSystem Wiounted Filesystem Disk Usage 2019.03-06 10:46:25P.. ol
Host FileSystem Meunted Filesystem Disk Usage 20190306 10:46:25P... ol
Host FileSystem Wiounted Filesystem Disk Usage 2019.03-06 10:46:25P.. ol
Host FileSystem Meunted Filesystem Disk Usage 20190306 10:46:25P... ol
Host FileSystem Wiounted Filesystem Disk Usage 2019.03-06 10:46:25P.. ol
Host FileSystem Meunted Filesystem Disk Usage 20190306 10:46:25P... ol
| Page 1 of24 | )} B I C Items 1 - 50 of 1170
R'S/\ NETWITNESS PLATFORM 11.5.0.0

Displays System Stats Browser View
Toolbar used to filter and customize the System Stats Browser View

Note: Historical graphs are enabled, and can be displayed, for statistics with numeric values.
However, historical graphs are disabled for statistics with string values, for example, Health
checks (Healthy), and are displayed as gray in the UI.

Filters

This table lists the various parameters you can use to filter and customize the System Stats view.

Parameter | Description

Host Select a host from the drop-down menu to display the stats of the selected host.
Select Any to list all the available hosts.

Component  Select a component from the drop-down menu to display the stats for the selected
component.
Select Any to list out all the components on a selected host.

Category Type the category to display the stats for the required category.
Select Regex to enable Regex filter. It performs a regular expression search
against text and lists out the specified category. If Regex is not selected it
supports globbing pattern matching.
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Statistic Type the statistic to display the required statistic on all the hosts or components.
Select Regex to enable Regex filter. This performs a regular expression search
against text and lists out the specified category. If Regex is not selected it
supports globbing pattern matching.

Order By Select the order in which the list needs to be filtered.
Select Ascending to filter the list it in an ascending order.

Commands
Apply Click to apply the filters chosen and display the list accordingly.
Clear Click to clear the chosen filters.

System Stats View Display

Displays statistics, service system information, and host system information for a host or service.
Access Stats Details

Select one of the stats and click Stats Details on the right hand side of the panel.

The Stats details panel opens with details of the selected stats.
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Stat Detalls
Aostname

e e et 15
LR ponent L

T e
LR ponent

Type

Type Instance
Description
Category

Last Updated Time
alue

111Conc

messagebus

MessageBus

Mode Sockets Used
rabbit@hbe1%194b-6ba2-4508-55c4-4eb33df02eed

messagebus_localhost

ZauUge
rabbit@b&19194b-5ha2-4508-2504-
Aap53dfi2eed _sockets_used

Mumber sockets used by this meszage broker.
MessageBus

2019-02-01 07:31:55 PM

5]

6.0

b519194b-6ba2-4508-%5c4d-
4ap53df02eed/meszagebus_localhost/zauge-
rabbit@hb61%19%4b-6ba2-4508-55c4-
4ehs53df0Zeed_sockets_used

b519194b-6ba2-4508-95c4-
deh33df0Zeed/meszagebus_localhost/gauge-
rabbit@bs19194b-6ba2-4508-85c4-
4eh53df02eed_sockets_used

11.3.0.0

false
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New Health & Wellness Tab

In New Health & Wellness tab, you can filter alerts (monitors) and add the notifications which sends a
notification message when an alert is triggered, suppress the notification for a time period and pivot to
New Health and Wellness dashboards.

To access this view:

Q
1. Goto (Admin) > Health & Wellness.

2. Click the New Health & Wellness tab.
The figure depicts the New Health & Wellness view.

What do you want to do?

Administrator Manage Notification Manage Notification and Suppression

Administrator Manage Suppression Manage Notification and Suppression

Related Topics

Monitoring through Dashboards

Monitoring through Alerts

Managing Notifications

Quick Look

RSA Investigate Respond Users Hosts Files Dashboard Reports admin v

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY

Alarms Monitoring Policies System Stats Browser  Event Source Monitoring Settings New Health & Wellness g
 ——————————————— ———————————————————————— —
Y Filters Pivot to Dashboard View Notifications Settings

SUPPRESSION APPLIED MONITOR NAME TRIGGER NAME SEVERITY SUPPRESSION

O Show Only Suppression Applied
Archiver Aggregation Stopped Aggregation Stopped Critical

MONITOR NAME Archiver Service in Bad State Bad State Critical

[m]
[m]
[m]
Equals
[0  Broker >5 Pending Queries More than 5 Pending Queries Medium
TRIGGER NAME [0 Broker Aggregation Stopped Aggregation Stopped Critical
Equals
O Broker Servicein Bad State Bad State Critical
SEVERITY O Broker Session Rate Zero Session Rate is O Critical
[0  Concentrator >5 Pending Queries More than 5 Pending Queries Medium
O Concentrator Aggregation Stopped Aggregation Stopped Critical

O  Concentrator Database(s) Not Open Database(s) Not Opened Critical

Reset [0 Concentrator Invalid Rule(s) Detected Rule Error Count >0 Medium

[R'S /\ NETWITNESS® PLATFORM

BN Notification Panel: You can view the list of alerts (monitors) along with the trigger name,
severity and suppression.
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suppression policy is applied.

Filters Alerts. You can filter alerts on Suppression Applied, Monitor Name, Trigger Name, and
Severity. To reset filters, click Reset,

Pivot to Dashboard. You can view New Health and Wellness Dashboards. For more
information, see Accessing New Health and Wellness Dashboards.

View Notification Settings. You can define notification settings which sends a notification
message when an alert is triggered. For more information, see Adding Alert Notifications.

=l View Suppression Policy. You can suppress notifications for a time period by specifying a
suppression policy. For more information, see Suppressing Notifications,

Monitor Name - Name of the monitor.

Trigger Name - Name of the trigger.

Severity - Severity assigned to the alert. The options are Critical, High, Medium, and Low.

Suppression - Indicates whether suppression policy is applied or not. Green tick indicates
4
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System View - System Info Panel

This topic describes the System Information panel, which displays information about the system
version and license status.

The required role to access this view is Manage System Settings.

To access this view, do one of the following:
e Goto K&l (Admin) > System.
The System Information panel is displayed by default.

« When you receive a notification that a new version of NetWitness Platform is available in the
Notifications tray, click View.

RSA te  Respond Users  Hosts ashboar AemETE i

Hosts  Services Event Sources Endpoint Sources Health 5] m  Security

| infe
Updates
Licensing

Email

Global Notifications
Legacy Notifications
System Logging
Global Auditing
Jobs

Live Services

URL Integration
Context Menu Actions
nvestigation

E5A Analytics

Cloud Gateway
Whois

HTTP Proxy Settings

NTP Settings

RS/\ NETWITNESS PLATFORM 11.5.0.0

The Version Information section displays version information about the version of NetWitness
Platform that is currently installed. The following table describes the features of the Version
Information section.
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e o

Displays the version of NetWitness Platform that is currently running. The format of the
version is major-relase.minor-release.stability-id. build-number. Possible values for the
stability-id are:

¢ 1 - Development

Current

Version ° 2 - Alpha
¢ 3-Beta
¢ 4-RC
. 5 - GOld

Current  Identifies the current build revision for use in troubleshooting situations.
Build

Each client host is shipped with the Local Licensing Server (LLS) installed to manage
host licenses. This field indicates whether the LLS is installed for this instance of

lLigsnse NetWitness Platform.
Server
ID o When the LLS is installed, the Licensing Server ID is displayed.
o Unknown indicates that the LLS is not installed.
Indicates whether or not the license is enabled. If the license is:
) « Enabled, Enabled is displayed in this field and there is a Disable button to the right
Lt so you can disable it.
Status

« Disabled, Disabled is displayed in this field and there is an Enable button to the
right so you can enable it.
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System Updates Panel - Settings Tab

System Updates Settings tab describes the interface you use to set up a connection to Live Update
Repository. These settings ensure that the NetWitness Platform can reach the Live Update
Repository and synchronize it with your Local Update Repository.

The required permission to access this view is Apply System Updates.

To access this view:

Q
1. Goto (Admin) > System.
2. Select Updates.

What do you want to do?

Administrator Automatically download Enable automatic synchronization with the RSA update
updates repository.

Related Topics

Manage NetWitness Platform Updates

Quick Look
The System Updates Settings panel is displayed.

Info

System Updates Settings

I Updates . H Configure Live account (required) l E

Configure proxy settings

Licensing
[# Automatically download information about new updates every day
Email
e Appl
Global Notifications
Legacy Notifications

System Logging

VR B W L

Displays System Update Setting Tab
Configure Account and Setting for Automatic Updates

Features

This table describes the features in the System Updates Settings panel.
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Configure Live account

Configure proxy settings

Automatically download
information about new
updates every day

Apply

Q
Displays the (Admin) > System > Live Services panel in which you
can configure your Live Account credentials if they are not configured.

<4
Displays the (Admin) > System > HTTP Proxy Settings panel in
which you can configure an HTTP proxy if it is not configured.

Select to enable automatic synchronization with the RSA update repository.
If there are new u§dates available, information will automatically be

displayed in the (Admin) > HOSTS panel.

Applies the settings in this tab.
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System Logging - Settings View

The RSA NetWitness Platform Settings view in the System Logging panel configures the size of the
log files, the number of backup log files maintained, as well as the default logging levels for the
packages within NetWitness Platform. The "Configure Log File Settings" topic in the System
Configuration Guide provides detailed procedures.

To access the Settings tab:

Q
1. Goto (Admin) > System.
2. In the options panel, select System Logging.
The System Logging panel opens to the Realtime tab by default.

3. Click the Settings tab.

What do you want to do?

Administrator Configure the size of See the "Configure Log File Settings" topic in the
the Log files System Configuration Guide

Related Topics

System Logging - Historical Tab

System Logging - Realtime Tab
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Quick Look

admin v

Info
System Logging
Updates Resltme | Historical | Settings <—n
Licensin - N
& Log Settings
Email
Max Log Size 4194304
Global Notifications Vi s Fles . —H
Legacy Notifications [¥ Show Errer Stack Trace

| System Logging ._n

Global Audiiting

Lo Package Configuration

Live Services

URL Integration SCeom
Context Menu Actions Comnection
Investization i Datahccess
are
£5A Analytics o0
@[ freemarker
Cloud Gateway
Cjvax
Whois -

HTTP Proxy Settings

[org
NTP Settings a

Package

Log Level -

[ Reset recursively

RS /\ NETWITNESS PLATFORM 11.5.00

Displays System Logging Panel
Displays Settings Tab

Configure Log Settings
Configure Packages

Features

The Settings tab has two sections: Log Settings and Package Configuration.

Log Settings

The Log Settings section configures the size of the NetWitness Platform log files and the number of
backup logs that NetWitness Platform maintains.

Foars [Desrpion

Max Log Configures the maximum size in bytes of each log file. The minimum value for this
Size setting is 4096,

Max # Specifies how many backup log files are maintained. The minimum value for this
Backup  setting is 0. When the maximum number of log files is attained, and a new backup file
Files is made, the oldest backup is discarded.

278



System Maintenance Guide

Fors [Desrpton

Displays ERROR, STACK, and TRACE log messages.

Show
Error
Stack
Trace

Apply Puts the settings into effect immediately for all future logs.

Package Configuration

The Package Configuration section shows the NetWitness Platform packages in a tree structure.

)

Package Contains all the packages used within NetWitness Platform. You can drill down into
tree the tree to view the log levels of each package.

The root logging level represents the default log level for all packages that are not
explicitly set. The root level is set to INFO

Package The name of the selected package when you select a package in the Package tree.

field

Log Level If the selected package has a log level explicitly set, the value is displayed in the Log
Level field.

Reset  Resets the log recursively.

recursively

Apply Puts settings into effect immediately for all future logs.

Reset Resets the selected package to the log level of root.
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System Logging - Realtime Tab

This topic describes the features of the System Logging > Realtime tab and the Services Logs view >
Realtime tab.

The Realtime tab is a view of the NetWitness Platform log or a service log. When it is initially loaded,
the view contains the last 10 log entries. As new entries become available, the view is updated with
those entries.

To access the Realtime tab:

Q
1. Goto (Admin) > System.

2. In the options panel, select System Logging.
The System Logging panel opens to the Realtime tab by default.

What do you want to do?

Administrator See details of Log entry Display System and Service Logs

Related Topics

System Logging - Settings View

System Logging - Historical Tab
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Quick Look

The following is an example of the Realtime tab in the System Logging panel.

pond Users Hosts Files D. r e 3 admin v
Event Sources  Endpoint Sources  Health & Wellness Security
nfo Svste 0gging
ystem Logging

Upt =3 .
Update: Historical Settings
Licensing

ALL MILS Search
Email

Timestamp Message
Global Notfications 3-06T23 onnect timed out org. apache http.conn Cannex utException: Con witness com:443 [ems.
Legacy Notifications 2-06T. NFO 443 [cms.netw 152224174

1 NFO of resources: CH3 authentcatian failure for admin - org.apache hitp annect to cms netwitness com-443 [cms netwitness. ¢

em Log, ugq_n 3-06T:

launch.aj
Global Auditing un

nsport client RequestTimeout timed out at

a2, reserting broker

Live Services Jate, reseting archiver

URL Integration WARN  Conwersion to List failed as connection to ContextHu not established

Context Menu Actions jate, resetting broker

pdate, resewing archiver

nvestigation

ESA Analytics

Cloud Gateway
Whois

HTTP Proxy Settings

NTP Settings

RS\ NETWITNESS' PLATFORM 11.5.00

- Displays System Logging Panel
Displays Realtime Tab

The following is an example of the Realtime tab in the Services Logs view, which is similar.

pond Usel Fi r admin v

Event Source Endpoint Sources  Health & We

-Broker | Logs

Broker ¥ | Search

Message

User admin has a mismat value 5.

ed value 1
1QPriz0

0) has logged in

20104, SA, QU = Netwitness, CI

8062-2020509e7e07

51.95:46832) hes logged in

ONNECTION_AUTHORITY, Respond

Administrator, UEBA_Analysts for use; that are not defined on this service

s been granted QT: 05T: 0 QF: QFri-0

10.4.61.9:

RS/ NETWITNE
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Features

The Realtime tab has a toolbar with input fields to allow filtering of the entries, and below the toolbar is
a grid containing the log entries.

Toolbar

o o

Log Level drop-  Selects the log level for entries to display in the grid. The Log Level drop-down

down shows the available log levels for the system or the service.
ALL B . System logs have seven log levels.
ALL o Service logs have only six log levels because they do not include the TRACE
TRACE

level.

DEBUG
INFO o The default is ALL log entries.
WARN
ERROR
FATAL

Keywords field  Specifies a keyword to use when filtering entries. This field is the same for
system and service log filtering.

Service field Specifies the service type to use when filtering service log entries. Possible
(Service Logs values are the host or the service.
only)

Search button  Click to activate filtering based on the log level, keyword, and service selections.

Log Grid Columns

Timestamp This is the timestamp for the entry.
Level This is the log level for the message.
Message This is the text of the log entry.
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System Logging - Historical Tab

The Historical tab provides a searchable view of a NetWitness Platform log or a service log in a paged
format. When initially loaded, the grid shows the last page of the log entries for the system or the
system.

To access the Historical tab:
Q
1. Goto (Admin) > System.
2. In the options panel, select System Logging.
The System Logging panel opens to the Realtime tab by default.
3. Click the Historical tab.

What do you want to do?

Administrator View the Historical Graph Historical Graph for System Stats

Related Topics

System Logging - Realtime Tab

System Logging - Settings View
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Quick Look

The following is an example of the Historical tab in the System Logging panel. It shows the NetWitness
Platform logs.

admin v

ecurity
nfo
Updates
Realtime | Historica settings
Licensing
v Search 2 Export
retrieving W 0c.launch.api transport client RequestTimeout -
Host hes ot rece ate, ressiing broker
em Logging ate, resetting archiver
Global Auditing WARN Anection to ContexcHub was not estab
WARN ate, resetting broker
_ WARN ste, ressting rchiver
Live Services
& AN ate, resetting broker
URL Integration
ste, reseming arc
Context Menu Actions g t0 sms is already
nvestigation Pushing live config to sms is already
A Analytics figuration changed
figuration changed by
Cloud Gateway
figuration changed by
Whois
ved error Parameter Lsername: Value J, uuid
HTTP Proxy Settings H ate, resetting broker
NTP Settings H ate, resemting arcniver
strieve suthen
java.utilconcurent Rejec rsa.netvitness car mon SharedThreadPoolE TagExclusiv from com.rsa.netwitn:
gMiscConfiguration changed by admin
singMiscConfiguration changed by admin
(e Displaying 9951 - 10000 of 10000

Displays System Logging Tab
Displays Historical Tab

The following is an example of the Historical tab in the Services Logs view. It shows the services logs.

Dashb admin v

Services Event Sourc Endpoint Sources  Health & W 5 ecurity

logdec - Log Collector Logs

Log Collector ¥ || Search P Export

e7eb7 aut

ed and grar

nast '/

ted and grant
fon <0.31822.50> (10.4.61.95

n <0.31848.

0> (10461

NFO ion <0.31865.50> (10.4.61.9
NFO ion <0.31906.50> (10.4.61
NFO

8.

sived a ping command, 2 reply af 51 byte:

16000 INFO fon <0.31922.50> [10.4.61.95:41292

eston, O = RSA, OU = Net!
ol

1338) has logged in

n €0.31979.50> (104,61 9535140 1 659549

e7en7 aut

N

€ | Page 200 of200 | Displaying 9951 - 10000 of 10000

RS\ NETWITNESS' PLATFORM
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Features

The Historical tab has a toolbar with input fields to allow filtering of the entries, a grid containing the log
entries, and paging tools.

o o

Start Date
and End
Date

Log Level

drop-down

ALL ~
ALL

TRAGE
DEBUG
INFO
WARN
ERROR
FATAL

Keyword
field

Service
field
(Service
Logs only)

Search
button

Export

The Start Date and End Date range search options limit the log entries to a point in time.
When used, you must provide both a start and end date. The times are optional. The date
range is validated to assure that the end date is not before the start date.

Selects the log level for entries to display in the grid. The Log Level drop-down shows
the available log levels for the system or the service.

« System logs have seven log levels.
« Service logs have only six log levels because they do not include the TRACE level.

o The default is ALL log entries.

Specifies a keyword to use when filtering entries. This field is the same for system and
service log filtering.

Specifies the service type to use when filtering service log entries. Possible values are
the host or the service.

Click to activate a search based on the start and end date, log level, keyword, and service
selections.

Click to export the currently viewed grid entries to a text file. You can select either
comma-separated or tab-separated format for the entries in the file.

Timestamp This is the timestamp for the entry.
Level This is the log level for the message.
Message This is the text of the log entry.

The paging tools below the grid provide a way to navigate through the pages of log entries.

| Page 1 ofte | » | C

Search Log Entries

To search the results shown in the Historical tab:
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1. (Optional) Select a Start Date and End Date. Optionally, select a Start Time and End Time.
(Optional) For system and service logs, select a Log Level and a Keyword, or both.
(Optional) For service logs, select the Service: host or service.

Click Search.
The view is refreshed with the most recent 10 entries matching your filter. As new matching log
entries become available, the view is updated to show those entries.

> owN

Show Details of a Log Entry
Each row of the Historical tab Log grid provides the summary information of a log entry. To view
complete details:

1. Double-click a log entry.

The Log Message dialog, which contains the Timestamp, Logger Name, Thread, Level and
Message, is displayed.

Timestamp 2017-09-27T09:22:02.505
Logger Mame Index

Thread

Level INFO

Message Indexes are being initialized

Close

2. When finished viewing, click Close.

Page Through the Entries

To view the different pages of the grid, use the paging controls on the bottom of the grid as follows:
o Use the navigation buttons

o Manually enter the page you want to view, and press ENTER.

Export

To export the logs in the current view:

Click Export, and select one of the drop-down options, CSV Format or Tab Delimited.

The file is downloaded with a filename that identifies the log type and the field delimiter. For example, a
NetWitness Platform system log exported with comma-separated values is named UAP log export
CSv.txt, and an appliance log exported with tab-separated values is named APPLIANCE log

export TAB.txt.
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